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Pl Integrator for Business Analytics 2020 R2
SP2

Pl Integrator for Business Analytics transforme les données Pl System en un format adapté a la prise de décision
qui peut étre utilisé par les outils de veille économique tels que Microsoft Power BI, Tableau, Présco Spotfire et
MillisecondView. Grace aux outils Bi, vous pouvez exécuter des analyses rétrospectives sur de grands ensembles
de vos données Systeme time Pl réel. Ces analyses rendent visibles les comportements et les modeéles
opérationnels, de sorte que vous pouvez identifier les dépendances et les corrélations entre les différents
aspects de vos opérations.

L'édition standard de PI Integrator for Business Analytics publie des vues d’actif et d’événement dans de
nombreuses bases de données relationnelles, lacs de données, entrepots de données et cibles fichiers. Pl
Integrator for Business Analytics peut s’intégrer nativement a Microsoft SQL Server, Amazon S3, Azure Data Lake
Storage Gen 2, Google Cloud Storage, Azure SQL et bien d’autres encore. Pour une liste compléte voir Editions de
Pl Integrator for Business Analytics.

2018 Edition Advanced fournit des paquets en temps réel de données Pl System a des plateformes de diffusion
telles qu'Apache Kafka. Les plateformes de diffusion permettent d'utiliser des modéles de Machine Learning et
prennent en charge les architectures Kappa et Lambda de consommation de données. L'édition avancée de PI
Integrator for Business Analytics prend en charge toutes les fonctionnalités de I'édition standard et publie des
vues de diffusion dans des cibles de hub de messages populaires telles que Apache Kafka, Azure loT Hub,
Amazon Kinesis et Google Cloud Pub/Sub. Pour une liste compléte voir Editions de Pl Integrator for Business
Analytics.

Pl Integrator for Business Analytics 2020 R2 SP2 est disponible au téléchargement.
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Qu'est-ce que Pl Integrator for Business
Analytics ?

Pl Integrator for Business Analytics présente des données Pl System qui sont parfaitement adaptées aux outils
Business Intelligence y compris, sans s’y limiter, Tableau, Tibco Spotfire, QlikView et Microsoft Power Bl pour
I'analyse et la génération de rapports. Les outils client Business Intelligence (BI) offrent la possibilité d'exécuter
des analyses rétrospectives sur un ensemble plus important de vos données Pl System en temps réel. Les
outils Business Intelligence vous aident a comprendre les comportements et les modeles opérationnels, et a
identifier les dépendances et les corrélations entre différents facteurs de vos opérations.

Les données de série temporelle natives, les contextes d'actifs et les contextes d'événements sont présentés
dans des vues configurées pour le Web. Les données sont modélisées dimensionnellement, nettoyées et
présentées avec des métadonnées adéquates permettant aux outils Bl de rechercher, d’interroger et de traiter
correctement les données Pl System. Les données peuvent étre directement intégrées et chargées dans des
plateformes d’entrep6t de données. Pl Integrator for Business Analytics élimine les besoins en programmation
ou en expertise SQL et gére le cycle de vie complet des données, y compris I'accés, la mise a jour et la tragabilité
des données.

Pl Integrator for Business Analytics requiert un modeéle Pl Asset Framework (Pl AF) pour sélectionner les données
Pl System et générer des données facilitant la prise de décisions. Les données peuvent étre nettoyées a l'aide de
plusieurs filtres et augmentées d'informations d'actif, d'événement et de temps provenant de Pl System. Les
données obtenues sont immédiatement utilisables dans des outils Bl sans avoir besoin de les modifier.

Avantages de Pl Integrator for Business Analytics

L'utilisation de Pl Integrator for Business Analytics offre les avantages suivants :

e Sélection et importation facile des jeux de données importants. Aucun code pour préparer les données et
aucune connaissance des données sources ne sont requis.

¢ Lataille des jeux de données peut étre augmentée sans avoir a personnaliser les procédures d'importation
des données.

¢ Les données Pl System peuvent étre fusionnées avec d’autres jeux de données pour une analyse au niveau
des agrégats, et exploitées par divers outils de business intelligence, entrepots de données et plateformes de
diffusion.

¢ Les données publiées sont synchronisées avec le Pl System et automatiquement mises a jour pour refléter
les modifications.

¢ Les données sont actualisées selon un calendrier ou en réponse aux changements de valeurs clés.

¢ L'interface utilisateur basée sur le Web est facile a utiliser et ne requiert aucune installation par I'utilisateur
final.

Mises en garde relatives a I'utilisation de Pl Integrator for Business Analytics

Remarques concernant I'utilisation de Pl Integrator for Business Analytics :

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 8
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¢ Pl Integrator for Business Analytics ne prend en charge que les données dont I’horodatage se situe dans le
passé. Les données futures ne sont actuellement pas prises en charge.

¢ publie des données Pl System sur une grande variété de cibles. Cependant, il ne reporte pas les
modifications des cibles dans .

¢ Les vues de diffusion sont congues pour vous aider a concrétiser un modele de machine learning ou une
analyse en alimentant les données en temps quasi réel. Les vues de diffusion ne sont pas destinées a agir
comme une synchronisation en temps réel de systemes Pl complets et peuvent rencontrer des problemes de
performances dus a 'augmentation des frais généraux sur Pl Integrator.

¢ Les vues de diffusion déclenchées par une clé peuvent rencontrer des problemes de performances avec
100 a 200 correspondances dans une seule vue.

¢ Les vues de diffusion continue planifiée peuvent traiter plusieurs milliers de correspondances par vue en
fonction d’autres facteurs de performance. Il existe une limite maximale de 25 000 correspondances au
total de la forme de la recherche par vue.

¢ Le service Pl Integrator Sync exige qu’un seul membre du collectif PI Data Archive ait un niveau de priorité 1
a tout moment. Pl Integrator Sync ne prend pas en charge plusieurs membres ayant le niveau de priorité 1.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 9
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Editions de PI Integrator for Business
Analytics

Deux éditions de Pl Integrator for Business Analytics sont disponibles :

Standard

L'édition Standard est une solution pour les entreprises qui souhaitent publier leurs données Pl System sur
un entrep6t de données externe. Une fois exportées vers ces entrepdts de données, les données Pl System
peuvent étre fusionnées avec les données d'autres systémes.

Avancée

Outre la publication de données sur des entrep6ts de données externes, I'édition Advanced prend en charge
les données de diffusion sur des cibles de diffusion prises en charge. Une fois publiées, ces données peuvent
étre utilisées pour simuler des applications de Machine Learning afin de découvrir des tendances et prédire
les comportements futurs.

Cibles de publication prises en charge

Le tableau suivant indique les différentes cibles de publication prises en charge par chaque édition et les types
de vues prises en charge par chaque cible. Pour plus d’informations sur les vues, voir Vues de PI Integrator for
Business Analytics.

Type de Destination Format Vues brises en charge Edition Edition
destination | cible P & Standard Advanced
Vues d'actif | Vues Vues de
d'événeme | diffusion
nt
Général Fichier ligne- / / / /
texte colonne
Base de Microsoft | ligne- J / / J
données SQL Server | colonne
relationnell
€ Base de / / / /
données
Oracle
paure St v v v v
Database

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved.
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Type de
destination

Destination
cible

Format

Vues prises en charge

Edition
Standard

Edition
Advanced

SAP HANA
(ODBC)

v

v

Data Wareh
ouse

Apache
Hive

Pool SQL
dédié Azure

Amazon
Redshift

Google Big
Query

ligne-
colonne

Data Lake

Hadoop
HDFS

Amazon S3

Google Clou
d Storage

Azure Data
Lake Storag
eGen?2

ligne-
colonne

AN NN NER NI NI NI NERN
ANAANANENE NERNERNEANE

AN NN NER NI NI NI NERN

Plateforme
de
messagerie

Apache
Kafka

Azure loT
Hub

Azure Event
Hubs

Flux de
données
Amazon
Kinesis

flux

NSNS

ANAANENE NERNENENENENEENE NN ERN
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Type de Destination Format Vues prises en charee Edition Edition
destination | cible P & Standard Advanced

Google Clou / J
d Pub/Sub
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Pl Integrator for Business Analytics
Architecture du systéme

Le diagramme suivant illustre une architecture typique d’un systéme Pl Integrator for Business Analytics.

Architecture du systeme PI Integrator for Business Analytics

Hadaop

Arurg

MS S0

Destination Targets

L

- Represents separate processes
B  Represents required services

Vous trouverez ci-dessous une description des composants requis pour les cibles d'entrep6t de données. Les
processus Pl Integrator Framework, nceuds Travailleur Pl Integrator et Sync Pl Integrator se trouvent tous sur le

méme ordinateur.

¢ Pl Integrator Framework

Le Pl Integrator Framework remplit les fonctions suivantes :

Fournit I'application Web dans laquelle les vues sont créées, publiées et gérées.

Planifie les taches a publier.

Répartit les taches entre les nceuds Travailleur Pl Integrator afin d'équilibrer la publication des vues entre
les nceuds. Dans ce diagramme, un seul nceud Travailleur est présent.

Suit et gere les flux de sortie utilisés dans les vues.

Enregistre les statistiques de la vue, notamment I'heure a laquelle publier la vue, le nombre de lignes

écrites, le nombre de lignes filtrées et le nombre d'erreurs.

¢ Sync Pl Integrator

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved.
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Pl Integrator Sync surveille les données suivantes :

¢ Changements de forme et de données de vue pour les vues d'actif planifiées et les vues de diffusion
continue planifiée

¢ Changements de forme de vue pour les vues de diffusion déclenchées par une valeur clé
¢ Noceud Travailleur Pl Integrator

Le nceud Travailleur Pl Integrator publie des taches sur ses cibles de destination. D'autres noeuds Travailleur
peuvent étre installés pour améliorer les performances.

¢ Pl Asset Framework (Pl AF)

Pl Integrator for Business Analytics récupere et met a jour les définitions de vues stockées dans une base de
données de configuration Pl AF.

e SQL Server

Les tables de métadonnées, les journaux et les statistiques sont stockés dans SQL Server.
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Configuration systeme requise

Configuration du systéme requise pour Pl Integrator for Business Analytics

Cette section décrit la configuration systéme requise pour installer Pl Integrator for Business Analytics et pour
chacune des cibles de publication prises en charge.

La configuration systéeme requise pour Pl Integrator for Business Analytics est la suivante :

¢ Pl Server 2018 ou version ultérieure
* Pl Asset Framework
e Data Archive

e PIAF SDK 2024

Remarque : PI AF SDK 2024 est inclus dans le client Pl AF 2024. Le client Pl AF 2024 est fourni avec PI
Integrator for Business Analytics 2020 R2 SP2. Pour utiliser les fonctionnalités linguistiques et locales, la
fonctionnalité Modules linguistiques pour le client PI AF 2024 doit étre installée.

¢ 16 Go de mémoire et deux coeurs modernes

Remarque : Cette mémaoire suffit pour le processus de nceud Travailleur minimum installé. Pour chaque
processus de nceud supplémentaire installé sur la méme machine, ajoutez 4 Go de mémoire et deux coeurs
de CPU modernes.

e Microsoft Windows Server 2016 ou 2022

Remarque : Le serveur Microsoft Windows doit faire partie d’'un domaine et ne peut pas étre installé sur une
machine qui n‘est pas associée a un Windows Active Directory. (Les machines jointes a un GROUPE DE
TRAVAIL ne sont pas prises en charge pour le déploiement de ce produit.)

¢ Microsoft SQL Server 2016, 2017, 2019, 2022. Microsoft SQL Server 2008 R2 SP2 (installé localement, dans le
méme domaine que I'utilisateur de I'installation ou dans un domaine qui approuve le domaine de
I'utilisateur de I'installation.) L'utilisateur de I'installation doit étre en mesure de s’authentifier a I'aide de
I'authentification Windows auprées du serveur SQL Server principal, méme si I'authentification SQL est
spécifiée. Par conséquent, le serveur SQL Server principal ne peut pas étre installé dans un groupe de travail
ou un domaine qui n‘approuve pas le domaine de I'utilisateur de I'installation.

Remarque : Pour tirer parti des performances optimales, il est conseillé d’utiliser la version compléete du
serveur SQL Server.

¢ Le composant de recherche en texte intégral de Microsoft SQL Server est obligatoire pour Pl Integrator for
Business Analytics. La recherche en texte intégral permet au service Pl Integrator Framework d’indexer et de
gérer un grand nombre de Pl tags et d’assurer le suivi des modifications apportées aux formes de vue. Notez
que la recherche en texte intégral est un composant facultatif du moteur de base de données SQL Server qui
peut étre ajouté pendant I'installation de Microsoft SQL Server, ou plus tard en exécutant le programme
d’installation de SQL Server. Procédez a I'installation avant de mettre a niveau Pl Integrator for Business
Analytics.

Configuration du systéme requise pour le navigateur Web

Utilisez I'un des navigateurs suivants :
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¢ Version récente de Google Chrome

¢ \ersion récente de Microsoft Edge

Configuration du systéme requise pour la cible de publication base de données Oracle
Configuration du systéme requise pour la cible de publication base de données Oracle
¢ Client Oracle pour les outils Microsoft 19¢ (64 bits)
Pl Integrator for Business Analytics prend en charge les versions suivantes de la base de données Oracle :

¢ Base de données Oracle version 23c pour Microsoft Windows (x64)

Configuration requise de la cible ODBC SAP HANA

Configuration requise de la cible ODBC SAP HANA

¢ Client SAP HANA
Pl Integrator for Business Analytics a été testé avec les versions suivantes du client SAP HANA :
¢ Client SAP HANA Version 2.3.144 Windows x64
e SAP HANA
Les versions suivantes de SAP HANA sont prises en charge :
e SAP HANA Version 2.0 SPS 03

Cibles de services Web Amazon
Les services Web Amazon requierent la version actuelle des services Web Amazon suivants :

¢ Flux de données Amazon Kinesis
e Amazon Redshift

e Amazon S3

Pilote ODBC Amazon Redshift
Pl Integrator for Business Analytics a été testé avec les versions suivantes du pilote ODBC Amazon Redshift :

¢ Pilote ODBC Amazon Redshift (x64) version 1.5.9.1011

Versions testées avec Apache Hadoop

Pl Integrator for Business Analytics a été testé avec les logiciels suivants :

e HortonWorks —HDP 3.1.0.0
¢ Apache Hive - 3.1.0
e HDFS-3.1.1
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Remarque : Pl Integrator for Business Analytics n’a pas été testé avec Apache Hive sous CDH (Cloudera
Distribution Hadoop).

Versions testées avec Apache Kafka

Pl Integrator for Business Analytics a été testé avec les versions suivantes d’Apache Kafka : 3.9x, 3.8x et 3.7x.

Versions testées avec Apache Thrift

Pl Integrator for Business Analytics a été testé avec Apache Thrift 0.9.3.0. Pl Integrator for Business Analytics
devrait également pouvoir fonctionner avec d'autres versions.

Configuration systéeme requise pour Google Cloud
Version actuelle d'un ou plusieurs des services Google Cloud Platform suivants :

¢ Google Cloud Storage
e Google BigQuery
¢ Google Cloud Pub/Sub

Configuration du systéme requise pour Microsoft Azure
Version actuelle d'un ou plusieurs des services Microsoft Azure suivants :

e Azure Event Hubs

e Azure loT Hub

e Azure SQL Database

¢ Pool SQL dédié Azure

e Azure Data Lake Storage Gen 2

Version testée de Schema Registry

Pl Integrator for Business Analytics a été testé avec Confluent Schema Registry 4.0.0, mais devrait également
fonctionner avec les autres versions.
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Comment installer Pl Integrator for
Business Analytics

Pl Integrator for Business Analytics requiert les phases d'installation suivantes :

 Etape 1: Préparation de l'installation

Cette étape permet de garantir que vous bénéficiez des autorisations et de |'accés aux composants qui
interagissent avec Pl Integrator for Business Analytics : serveur Pl AF, Pl Data Archive, et Microsoft SQL
Server. Ces prérequis sont nécessaires avant de lancer l'installation du service Windows PI Integrator for
Business Analytics.

¢ Phase 2 : Installation de Pl Integrator for Business Analytics

Installation de PI Integrator for Business Analytics et configuration du serveur Pl AF et de Microsoft SQL
Server. Les nouvelles bases de données Pl Integrator sont créées sur Microsoft SQL Server pour PI Integrator
for Business Analytics.

e Etape 3 : Vérification de I'installation

Cette étape permet de vérifier que les services Pl Integrator for Business Analytics ont démarré et qu'ils sont
en cours d'exécution.

Les chapitres suivants décrivent en détail les différentes étapes de chaque phase de la procédure d'installation :

e Phase 1: Préparation de l'installation de Pl Integrator for Business Analytics
e Phase 2 : Installation de Pl Integrator for Business Analytics

e FEtape 3 : Vérification de I'installation

Phase 1 : Préparation de l'installation de Pl Integrator for Business
Analytics

Les composants suivants sont requis pour finaliser I'installation de PI Integrator for Business Analytics :

Serveur Pl (comprenant le serveur Pl Asset Framework et Pl Data Archive) et Microsoft SQL Server (comprenant
les bases de données pour stocker les métadonnées de vues continues et les bases de données pour les journaux
et statistiques de Pl Integrator for Business Analytics).

1. Assurez-vous que les conditions requises sont respectées et que les logiciels nécessaires soient installés,
comme indiqué dans la . Voir la configuration systéme requise.

2. Réfléchissez a un emplacement ol vous installerez les composants de votre installation Pl Integrator for
Business Analytics.

3. Le produit Pl Integrator peut étre installé a I'aide de comptes virtuels Windows ou de comptes d’utilisateur
de domaine Windows. Les mots de passe des comptes virtuels et des comptes de services administrés sont
gérés par le systeme d’exploitation Windows. Par défaut, I'installation se fait via des comptes virtuels qui ne
nécessitent pas la spécification d’'un nom d’utilisateur ou d’'un mot de passe. Si vous utilisez des comptes
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d’utilisateur de domaine Windows, obtenez un nom d’utilisateur de compte de service Windows. Si vous
n’utilisez pas un compte de service géré (MSA) ou un compte de service géré de groupe (gMSA), vous aurez
besoin d’'un mot de passe pour votre domaine. Vous devrez peut-étre contacter votre administrateur
informatique pour qu'il en crée un pour vous.

Remarque : Pour un déploiement hautement sécurisé, nous recommandons l'utilisation d’un compte de
service administré (MSA) d’'un compte de service administré de groupe (gMSA) ou de comptes virtuels.
Toutefois, un compte d’utilisateur de domaine standard dédié a I'exécution du service est également pris en
charge.

4. Le compte d’utilisateur utilisé pour installer Pl Integrator for Business Analytics doit étre un utilisateur du
domaine avec des privileges d’administrateur local, situé sur le serveur Microsoft Windows sur lequel vous
installerez Pl Integrator for Business Analytics.

5. Vérifiez que le compte d’utilisateur utilisé pour installer le logiciel dispose des privileges sysadmin sur le SQL
Server ou vous allez installer les bases de données Pl Integrator. Ceci est obligatoire pour créer les bases de
données SQL dorsales de Pl Integrator.

Remarque : Si le compte d’utilisateur ne dispose pas des privileges requis, les bases de données SQL devront
étre créées manuellement par un utilisateur, généralement un administrateur de base de données, qui
dispose de privileges sysadmin. Dans ce cas, les bases de données SQL doivent étre créées en premier, avant
d’installer PI Integrator for Business Analytics.

Remarque : Rendez-vous sur OSlsoft Customer Portal pour télécharger I'utilitaire SQL Pl Integrator for
Business Analytics contenant le script qui permet de créer les bases de données. Aprés avoir installé les
bases de données SQL, ajoutez le compte d'utilisateur qui installera en tant que connexion a SQL Server.

L'utilisateur qui installe doit disposer des autorisations suivantes :

Réle de base de données db_accessadmin sur les bases de données PlintegratorDB, PlintegratorStats et
PlintegratorLogs

Réle de base de données db_datareader sur la base de données PlintegratorStats

6. Le compte d’utilisateur utilisé pour installer Pl Integrator for Business Analytics doit étre mappé a l'identité
Administrateurs dans PI AF.

7. Vérifiez que les ports suivants sont disponibles. Le tableau ci-dessous décrit comment ces ports sont utilisés
dans l'architecture de Pl Integrator for Business Analytics.

Application 3 L .
Usage .pp \cation Protocole Port Direction Configuré sur
distance
Connexion PI PI AF TCP 5457 Entrée Serveur Pl AF
Integrator for
Business
Analytics a PI AF
Connexion PI Serveur Data TCP 5450 Entrée Serveur Serveur
Integrator for Archive Data Archive
Business
Analytics a
Serveur Data
Archive
Connexion PI Pl Integrator for | TCP 14331 Entrée SQL Server
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Usage A.p plication a Protocole Port Direction Configuré sur
distance

Integrator for Business

Business Analytics

Analytics a la

base de

données SQL

Connexions Navigateur Web | TCP 443 2 Entrée Editions de

clienta client Pl Integrator for

I'interface Business

utilisateur PI Analytics

Integrator for

Business

Analytics

Données Microsoft Azur | TCP 5671 3 Sortie Editions de

sortantes e loT Hub ou Pl Integrator for

(nécessaire Microsoft Azur Business

uniquement e Event Hubs Analytics

pour Microsoft

Azure loT Hub

ou Microsoft

Azure Event

Hub)

1 Cette connexion peut étre configurée pour |'utilisation d’un port dynamique.

2 Le port par défaut pour HTTPS est 443, mais un autre port peut étre spécifié pendant I'installation de PI Integrator for Business

Analytics. Le port 80 ne peut pas étre utilisé en raison de la convention Internet.

3 Microsoft peut modifier ces ports au fil du temps. Reportez-vous a la documentation Microsoft pour obtenir les informations les

plus récentes.

(Facultatif) Contactez votre administrateur informatique pour demander a une autorité de certification un
certificat destiné au serveur exécutant Pl Integrator for Business Analytics. L'objet du certificat doit inclure le
nom de domaine complet (FQDN) du serveur, et I'autre nom d'objet doit inclure le FQDN et le nom d'hote de

ce serveur.

Le certificat doit également répondre aux critéres suivants :

¢ Le certificat doit étre installé dans le magasin personnel de la machine locale. Pour référence, le certificat
Pl Web API est soumis aux mémes exigences. Ces dernieres sont répertoriées dans la section Problémes

communs d’installation du guide de I'utilisateur de ce produit.

¢ Le certificat ne doit pas avoir expiré.

¢ Le certificat doit comporter une clé privée.
¢ Le certificat doit étre un certificat SHA-2.

¢ Le certificat doit comporter une chaine de confiance valide.

9. (Facultatif) Contactez votre administrateur informatique si vous installez Pl Integrator for Business Analytics
dans un environnement ou se trouvent plusieurs contréleurs de domaine ou un contréleur de domaine en
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lecture seule. Il peut y avoir des exigences de port supplémentaires pour ces environnements. Pour plus
d'informations, reportez-vous a la documentation Microsoft suivante : Active Directory and Active Directory
Domain Services Port Requirements (Exigences de port pour Active Directory et Active Directory Domain
Services).

Si le compte qui exécutera le service Pl Integrator Framework est un compte de service géré de groupe
(gMSA), le module Active Directory pour Windows PowerShell doit étre installé sur I'ordinateur ou PI
Integrator for Business Analytics est installé ; voir Installer le module Active Directory PowerShell.

Si une ou plusieurs instances de Pl Integrator 1.x sont installées sur le serveur Pl AF sur lequel vous avez
installé cette instance, vous devez d'abord mettre a niveau toutes les instances 1.x vers la version 2.x. Cela
permet de vous assurer que vos vues Pl Integrator 1.x continueront d'étre publiées aprés l'installation de
I'instance 2.x.

Si vous préférez définir les conditions de configuration et d’autorisation requises sur vos cibles de publication
avant d’installer Pl Integrator for Business Analytics, consultez la section Configurer vos cibles de publication
pour obtenir plus d’informations.

Déploiement de Pl Integrator

Vous trouverez ci-dessous une description des différentes méthodes de déploiement de Pl Integrator for
Business Analytics. Le diagramme ci-dessous indique plusieurs déploiements indépendants de Pl Integrator for
Business Analytics. Chaque instance de Pl Integrator pointe vers sa propre instance de serveur Pl AF et de
serveur SQL.

2y B ==
l *—l¢l
2 D =
l "—l®-
ey 8 ==
l l@i

Fl AF Flintegrator for S0 Server

Business Analytics

Il est également possible d'installer plusieurs instances de PI Integrator for Business Analytics sur le méme
serveur Pl AF, comme indiqué ci-dessous. Un nouvel élément d'instance Pl AF unique est créé dans la méme base
de données Pl AF pour chaque instance installée.
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25 8
: ‘l@i
E:w

Pl Integracor for S0L Server
Business Analytics

Plusieurs instances de peuvent pointer vers le méme serveur SQL, comme indiqué ci-dessous. Lorsque chaque
instance est installée, elle partage les mémes bases de données SQL que les autres instances, mais un ensemble
de tableaux spécifiques a I'instance est créé dans ces bases de données SQL Server pour chaque instance PI
Integrator for Business Analytics.

B~ B
B
B~ Biw-

Pl AF Pl Integrator for QL Server
Business Analytics

Remarque : Le serveur SQL peut également étre installé sur un nceud entiérement distinct de chacune des
instances de Pl Integrator for Business Analytics.

Dans tous les cas, vous pouvez installer une seule instance de Pl Integrator sur un nceud.

Phase 2 : Installation de PI Integrator for Business Analytics

La phase 2 comprend l'installation de Pl Integrator for Business Analytics et la configuration du serveur Pl AF et
de Microsoft SQL Server.

Avant d’installer Pl Integrator for Business Analytics :

¢ Assurez-vous de remplir les conditions requises énumérées dans : Phase 1 : Préparation de l'installation de
Pl Integrator for Business Analytics.

Remarque : Chaque instance de produit Pl Integrator développé sur le Pl Integrator Framework doit étre
installée sur une machine distincte.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 22



'AV EVA\TM Pl Integrator for Business Analytics

Comment installer Pl Integrator for Business Analytics

Connectez-vous a l'ordinateur sur lequel vous souhaitez installer Pl Integrator for Business Analytics.

2. Téléchargez la derniere version du kit d’installation de Pl Integrator for Business Analytics depuis le Customer
Portal.

3. Cliquez avec le bouton droit sur I'exécutable de configuration, puis cliquez sur Exécuter en tant
gu'administrateur pour lancer I'assistant d'installation.

La fenétre Self-Extracting Executable s’ouvre.
4. Choisissez le chemin d'extraction pour |'assistant d'installation et cliquez sur OK.

La fenétre Bienvenue dans I'assistant de configuration de Pl Integrator for Business Analytics apparait et
affiche les différents modules compris dans I'installation. L'assistant d'installation installe chaque module ou
vérifie s'ils sont déja installés sur votre systéme.

Cliquez sur OK.

6. Siaucun produit AVEVA n’a été installé sur cet ordinateur, effectuez les étapes suivantes. Sinon, passez a
|'étape suivante.

a. Dans la fenétre Serveurs par défaut, indiquez le serveur Pl Data Archive et, éventuellement, le serveur
Pl AF, puis cliquez sur Suivant.

b. Dans la fenétre Répertoire d’installation, indiquez 'emplacement d’installation des produits AVEVA. Vous
pouvez accepter I'emplacement par défaut ou en spécifier un autre.

Remarque : Pl Integrator for Business Analytics est installé dans le répertoire %PIHOME64%.

c. Cliquez sur Suivant.

7. Dans la fenétre Bienvenue dans I'assistant d’installation de PI Integrator for Business Analytics, cliquez sur
Suivant.

La fenétre Amélioration de I'expérience client s'affiche.

8. Dans la fenétre Informations de connexion, sélectionnez Comptes virtuels ou Comptes d’utilisateur de
domaine. Si vous utilisez des comptes d’utilisateur de domaine, indiquez le nom d’utilisateur (y compris le
domaine) et le mot de passe pour le compte de service Windows qui exécutera les services Pl Integrator
Framework, Pl Integrator Sync et Pl Integrator Worker Node(s).

Remarque : Si le compte de service Windows est un compte de service administré de groupe (gMSA),
indiquez votre nom d’utilisateur au format suivant : nom d’utilisateur$, et omettez le mot de passe.

9. Cliquez sur Suivant.
La fenétre Connexion au serveur AF apparait.

10. Indiquez le serveur Pl AF sur lequel Pl Integrator for Business Analytics stockera les définitions de vue et
autres métadonnées.

Dans le champ Serveur AF, saisissez le nom ou 'emplacement (adresse IP) du serveur Pl AF.

Remarque : En cas d’erreur, assurez-vous que le compte d’utilisateur utilisé pour installer PI Integrator for
Business Analytics est mappé a I'identité AF Administrateurs sur le serveur Pl AF.

11. Cliquez sur Suivant.
La fenétre SQL Server s’ouvre.

12. Spécifiez le serveur Microsoft SQL Server sur lequel Pl Integrator for Business Analytics stockera les
métadonnées de vue, les données statistiques et les journaux Pl Integrator for Business Analytics.

Ne spécifiez le nom d'hote (ou le nom de domaine complet) que si vous utilisez I'instance par défaut. Si vous
utilisez une instance nommeée, spécifiez le nom d'héte (ou le nom de domaine complet) et l'instance. Par
exemple : mySQLserverBA1\PIViewInstance.
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13. Indiguez comment PI Integrator for Business Analytics sera authentifié avec la base de données
Microsoft SQL Server indiquée. Sélectionnez une des options suivantes :

¢ Authentification Windows (par défaut)

Le nom de l'utilisateur du compte de service Windows est utilisé comme identifiant de connexion pour
se connecter a Microsoft SQL Server.

Remarque : Si vous utilisez un compte de service administré de groupe (gMSA) ou des comptes virtuels,
vous devez utiliser I'authentification Windows.

e Authentication SQL Server

Remarque : L'authentification SQL Server n’est pas recommandée. Créez un identifiant spécifique pour le
service Pl Integrator Framework.

Cliquez sur Authentification SQL Server si vous souhaitez utiliser le service d'authentification de SQL
Server pour vous connecter a la base de données Microsoft SQL Server indiquée.

Saisissez le nom et le mot de passe pour I'utilisateur désigné du serveur Microsoft SQL Server disposant
de l'acces requis a Microsoft SQL Server.

14. Cliquez sur Suivant.
La fenétre Configuration du port et du certificat TLS s’ouvre.

15. Saisissez un numéro de port valide disponible dans le champ Entrer un numéro de port et cliquez sur Valider
le port.

Remarque : Ce port est utilisé dans un navigateur Web pour se connecter a Pl Integrator for Business
Analytics.

Le port 80, par convention, est associé au protocole HTTP qui n’est pas sécurisé. Puisque seul HTTPS
(protocole sécurisé chiffré) est pris en charge, I'utilisation du port 80 est restreinte.

Astuce : Si vous utilisez le port 443 par défaut, vous pouvez ignorer le numéro de port si vous indiquez I'URL
de Pl Integrator for Business Analytics.

16. Choisissez un certificat TLS parmi I'une des sources suivantes :

¢ (Recommandé) Certificat TLS obtenu auprés d’une autorité de certification. Sélectionnez Import
certificate (Importer le certificat) et cliquez sur Select Certificate (Sélectionner le certificat) pour choisir
un certificat émis par une autorité de certification et importé sur la machine ou Pl Integrator for Business
Analytics est en train d’étre installé.

¢ Certificat auto-signé généré lors de l'installation. Il s'agit de la valeur par défaut. Sélectionnez Certificat
auto-signé.

Remarque : Si vous choisissez cette option, les utilisateurs qui se connectent depuis une machine a
distance peuvent voir s‘afficher un message d’avertissement lié a la sécurité. Pour éviter |'affichage de
cet avertissement pour les certificats auto-signés, le certificat doit étre explicitement approuvé sur la
machine client. Consultez la solution dans l'article de la Base de connaissances OSlsoft Certificate error
returned when navigating to a Pl Vision or Pl Web APl web site using a self-signed certificate (Renvoi
d'une erreur de certificat lors de 'accés a un site Web de Pl Vision ou PI Web API a l'aide d'un certificat
auto-signé).

17. Cliquez sur Suivant.

Remarque : En cas d’erreur, assurez-vous que le port est disponible et ouvert.

18. Dans la fenétre Pl Integrator Worker Nodes, cliquez sur la fleche et sélectionnez le nombre de nceuds
Travailleur que vous souhaitez installer, puis cliquez sur Suivant.

La fenétre Pl View Deprecated Verification (Verification d’obsolescence des vues PI) s'ouvre.
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Remarque : Chaque nceud Travailleur additionnel exige une capacité supplémentaire de processeur et de
RAM. Pour plus d’informations sur les ressources nécessaires, voir Configuration systeme requise.

19. L'étape de vérification d’obsolescence des vues Pl nécessite confirmation de votre part que la cible de vue PI
est obsoléte. Toutes les vues existantes utilisant la cible de vue Pl ne pourront plus étre publiées apres
I'installation.

¢ (Recommandé) Une analyse est disponible pour détecter toutes les vues de votre systeme qui utilisent la
cible de vue PI. Si I'analyse se termine avec succes, une liste des noms des vues détectées s’affiche, ainsi
gu’un lien vers le fichier de liste exporté dans le répertoire %PIHOME%\dat. Vous pouvez utiliser cette
analyse pour identifier les vues Pl qui peuvent étre supprimées ou migrées vers la cible
Microsoft SQL Server comme alternative. Pour obtenir des instructions sur la migration des vues a 'aide
de la cible de vue Pl vers Microsoft SQL Server, voir Migrer la cible de vue Pl vers la cible Microsoft SQL
Server.

¢ Si une erreur se produit pendant I'analyse, un message d’erreur s’affiche. Cliquez sur OK pour fermer
la boite de dialogue.

¢ Sil'analyse réussit mais que I'exportation de la liste échoue, veuillez noter manuellement les noms
des vues.

Cochez la case de confirmation pour poursuivre I'installation. Cliquez sur Suivant.
La fenétre Ready to Install the Application (Prét a installer I'application) s’ouvre.
20. Cliguez sur Installer.
La fenétre Mise a jour du systéme apparait et indique la progression de I'installation.

21. Une fois I'installation terminée, la fenétre Installation Complete (Installation terminée) s’affiche. Cliquez sur
Fermer.

Etape 3 : Vérification de I'installation

Aprés avoir installé Pl Integrator for Business Analytics, vérifiez que ses services sont exécutés.

Connectez-vous a la machine qui héberge PI Integrator for Business Analytics.
2. Ouvrez Services.
3. Vérifiez que les services PI Integrator for Business Analytics sont répertoriés et exécutés.
Vous devriez voir les services suivants :
¢ Pl Integrator Framework
e Sync Pl Integrator
¢ Nceud Travailleur Pl Integrator 1

¢ Nceud Travailleur Pl Integrator n (vous verrez un service pour chaque nceud Travailleur créé).

Remarque : Les services Pl Integrator Sync et Nceud Travailleur Pl Integrator sont installés avec le type de
démarrage réglé sur Manuel. Le service Pl Integrator Framework redémarre automatiquement les services si
nécessaire. Si un redémarrage manuel du service est requis, arrétez tous les services Pl Integrator et lancez
un démarrage du service Pl Integrator Framework. Ne démarrez pas les autres services manuellement, cela
entrainerait un comportement inattendu.

4. Ouvrez un navigateur.

Saisissez I'URL de Pl Integrator for Business Analytics.
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L'URL meéne a la machine héte et au port du service Windows Pl Integrator for Business Analytics. L'URL est
https://<nom d’héte>:<numéro de port> ou https.//<fqdn>:<numéro de port>, ol FQDN correspond au nom
de domaine pleinement qualifié.

Si vous avez installé Pl Integrator for Business Analytics sur un héte appelé lab5 dans le domaine
prod.onet.com et I'avez configuré pour utiliser le port 7777, vous pouvez saisir I'une ou l'autre des URL
suivantes :

e https://lab5.prod.onet.com:7777
e https://1lab5:7777

Installation silencieuse

Cette section décrit comment installer Pl Integrator for Business Analytics en arriére-plan.

Avant d’installer Pl Integrator for Business Analytics, assurez-vous de satisfaire les configurations requises
énumeérées dans Phase 1 : Préparation de l'installation de PI Integrator for Business Analytics.

Remarque : Installez chaque produit Pl Integrator développé sur le Pl Integrator Framework sur une machine
distincte. Par exemple, Pl Integrator for Business Analytics et Pl Integrator for SAP HANA ne peuvent pas étre
installés sur la méme machine, c'est également le cas pour deux instances de Pl Integrator for Business Analytics.

Pour installer PI Integrator for Business Analytics en arriere-plan :

Connectez-vous a l'ordinateur sur lequel vous souhaitez installer Pl Integrator for Business Analytics.

2. Téléchargez la derniére version du kit d’installation de Pl Integrator for Business Analytics depuis le Customer
Portal.

3. Cliguez avec le bouton droit sur I'exécutable de configuration, puis cliquez sur Exécuter en tant
qgu'administrateur pour lancer I'assistant d'installation.

La fenétre Self-Extracting Executable s'ouvre.
4. Choisissez le chemin d'extraction pour l'assistant d'installation et cliquez sur OK.

Les fichiers sont extraits a I'emplacement spécifié. La fenétre Bienvenue dans 'assistant de configuration de
Pl Integrator for Business Analytics 2020 s’affiche lorsque I'extraction est terminée.

Cliquez sur Annuler.
Localisez le fichier de configuration silent.ini dans le dossier.

Modifiez le fichier de configuration. Spécifiez les paramétres suivants a la ligne du composant Pl Integrator
de la section [COMMAND LINE], en modifiant la valeur par défaut « 7 = /q ALLUSERS=1 REBOOT=Suppress
REINSTALLMODE=dmus SENDTELEMETRY=0 ».

Parametre Description

SERVICEACCOUNT Cette valeur est réglée par défaut sur NT
SERVICE\<Nom du service Pl Integrator>, pour
installer Pl Integrator a l'aide de comptes virtuels.
Vous pouvez également spécifier un compte de
service Windows pour exécuter le service

Pl Integrator Framework.

SERVICEPASSWORD Mot de passe du compte de service.
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Remarque : Si vous utilisez un compte de service
administré de groupe (gMSA) ou des comptes
virtuels, ignorez ce parametre.

AFSERVER

Serveur Pl AF stockant les informations de
configuration de PI Integrator.

SQLSERVER

Serveur SQL que Pl Integrator utilise pour stocker les
métadonnées de vue. Si vous utilisez une instance
nommeée, vous devez également la spécifier.

USERPORT

Port que PI Integrator utilise pour se connecter au
navigateur Web.

SQLHOSTNAME

Nom de la machine qui héberge SQL Server. Si vous
utilisez une instance nommeée, spécifiez-la.

SENDTELEMETRY

(Facultatif) Si ce parameétre est défini sur la valeur 1
par défaut, le client accepte de participer au
programme de commentaires client Pl System (Pl
System Customer Feedback Program). Définissez-le
sur 0 pour choisir de ne pas participer au
programme.

INSTANCEELEMENTNAME

(Facultatif) Elément Pl AF contenant les informations
spécifiques a l'instance de PI Integrator. Utilisez
I'instance disponible suivante. Si ce parameétre n'est
pas spécifié, la valeur par défaut est Instancel.
Recherchez l'instance disponible suivante dans la
base de données de configuration sur le serveur

Pl AF.

CERTIFICATE_SELECTED

Si ce paramétre n'est pas spécifié, le certificat auto-
signé créé par le programme d'installation est
utilisé.

CERTIFICATE_THUMBPRINT

(Facultatif) Empreinte du certificat personnalisé que
Pl Integrator utilisera. Si une empreinte est utilisée,
CERTIFICATE_SELECTED doit étre défini sur 1.

SQLUSERACCOUNT

(Facultatif) Si vous utilisez I'authentification SQL,
définissez le compte SQL que PI Integrator utilise
pour accéder a l'instance SQL Server.

Remarque : Si vous utilisez un compte gMSA ou des
comptes virtuels, vous ne pouvez pas utiliser
I'authentification SQL. Omettez ce parametre.
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SQLUSERPASSWORD (Facultatif) Mot de passe du compte SQL.

Remarque : Si vous utilisez un compte gMSA ou des
comptes virtuels, vous ne pouvez pas utiliser
I'authentification SQL. Omettez ce parametre.

8. Ouvrez une invite de commande en tant qu’administrateur et exécutez la commande suivante : Setup.exe -f
silent.ini

Taches a effectuer apres l'installation

Aprés avoir installé Pl Integrator for Business Analytics, accédez a I’'URL du service Pl Integrator Framework. Pour
plus d’informations, voir Démarrez Pl Integrator for Business Analytics.

Effectuez ensuite les taches suivantes avant de commencer a utiliser Pl Integrator for Business Analytics :

¢ Ajoutez des serveurs et bases de données Pl a partir desquels vous accéderez a vos données Pl System. Voir
Ajouter des serveurs et bases de données Pl AF.

¢ Ajoutez les utilisateurs qui seront autorisés a créer des vues. Voir Ajouter et configurer des identités.

o Effectuez toutes les taches de configuration requises pour votre cible de publication. Voir Configurer vos
cibles de publication.

¢ Les autorisations pour les données sources utilisées par les vues Pl Integrator ne sont pas accordées par Pl
Integrator. Lidentité de I'utilisateur qui crée la vue doit déja avoir un acces en lecture et en lecture aux
données des données sources dans AF. Vérifier que le service Windows Pl Integrator for Business Analytics
est en cours d'exécution.

e Acceés en lecture et en lecture de données au niveau du serveur AF pour tous les serveurs Pl AF auxquels
doit accéder

e Accés en lecture et en lecture aux données sur toutes les bases de données PI AF et tous leurs objets
enfants (éléments, catégories, modeéles, etc.) auxquels Pl Integrator for Business Analytics doit accéder
pour publier des données

e Acces en lecture a la table PIPoint sous Sécurité de la base de données

e Accés en lecture a Pl Data Archive pour la sécurité des points et des données sur tous les points Pl
auxquels Pl Integrator for Business Analytics doit accéder pour publier des données

Remarque : Le compte de service nécessite des autorisations Pl Data Archive car le recherche
directement sur Pl Data Archive les données d'attribut Pl AF qui sont des références de données de point
PI.

Ajouter des serveurs et bases de données PI AF

Vous pouvez indiquer des serveurs et bases de données Pl AF supplémentaires contenant des données qui
peuvent étre utilisées dans vos vues.

1. Cliquez surl'icéne du menu E, puis cliquez sur Administration.
2. Dans la page Administration, cliquez sur I'onglet AF Databases.
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3. Dans la section Ajouter un nouveau AF Server, entrez le nom ou I'emplacement (adresse IP) du serveur Pl AF
dans le champ AF Server.

4. Sivotre serveur Pl AF n'utilise pas le port par défaut (5457), indiquez le port a utiliser dans le champ Port.
Cliquez sur Ajouter un serveur AF.

Ajouter et configurer des identités

Cette procédure décrit comment créer une nouvelle identité, ajouter des utilisateurs a l'identité et configurer
I'acces de l'identité a des cibles de publication et des vues. Ces identités gérent l'acces des utilisateurs a

I'interface utilisateur (IU) de Pl Integrator for Business Analytics, ainsi que les autorisations d’acces et de
configuration des vues et des cibles de publication.

Cliquez sur l'icone du menu E, puis cliquez sur Administration.
2. Ala page Administration, cliquez sur I'onglet Utilisateurs.

La page Autorisations d’acces utilisateur s’ouvre.
3. Cliquez sur Add Identity (Ajouter une identité).

La boite de dialogue Add Identity (Ajouter une identité) s'ouvre.
4. Effectuez I'une des opérations suivantes :

Entrez le nom de la nouvelle identité dans le champ Identity name (Nom de l'identité), puis cliquez sur
Create (Créer).

e Sélectionnez une identité dans la liste et cliquez sur OK.

La liste indique toute les identités associées au serveur Pl AF hébergeant la configuration de PI Integrator for
Business Analytics.

Lidentité est renseignée dans le champ Nom.

Identities
Identity Description
& Pl integrator Service Created by Pl Integrator Setup Kit

E N

4. Human Resources

5. Cliquez sur Add User to Identity (Ajouter un utilisateur a l'identité) pour ajouter des utilisateurs Windows
Active Directory a l'identité.

6. Dans la boite de dialogue Add Users and Groups (Ajouter des utilisateurs et groupes), entrez le domaine et le
nom d'utilisateur dans le champ domain\user (domaine\utilisateur).

Utilisez le format domaine\utilisateur. Vous pouvez également saisir le nom complet de I'utilisateur dans
le champ nom complet.

7. Cliquez sur Rechercher.
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Une liste d'utilisateurs Active Directory correspondant aux critéres indiqués apparait.

Sélectionnez un utilisateur dans la liste et cliquez sur OK.

L'utilisateur apparait dans la liste Utilisateurs et groupes.

Cliquez sur Add Target (Ajouter une cible) pour autoriser l'identité a accéder a des cibles de publication.

Si les cibles souhaitées n'apparaissent pas dans cette liste, créez tout d'abord la cible, puis autorisez l'identité
ay accéder.

Dans la boite de dialogue Add Publish Targets (Ajouter des cibles de publication), sélectionnez les cibles
auxquelles vous souhaitez autoriser I'acces a l'identité, puis cliquez sur OK.

Les cibles apparaissent dans la liste Allowed Publish Targets (Cibles de publication autorisées).

Cliquez sur Add View Permissions (Ajouter des autorisations de vue) pour autoriser l'identité a accéder aux
vues existantes.

Dans la boite de dialogue Add View Permissions (Ajouter des autorisations de vue), sélectionnez les vues
auxquelles vous souhaitez autoriser I'acces a l'identité, puis cliquez sur OK.

Les vues apparaissent dans la liste View Permissions (Autorisations de vue).

Cliquez sur la fleche et choisissez I'une des autorisations suivantes (voir Autorisations de vue pour plus de
détails) :

e Lecteur
¢ Propriétaire

Cochez la case Administrateur pour accorder a I'identité AF sélectionnée |'acces a la page d’administration
de Pl Integrator for Business Analytics.
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Analytics

Vous pouvez mettre a niveau Pl Integrator for Business Analytics 2020 R2 SP2 a partir des versions suivantes :

e 2020 R2SP1

Améliorations intermédiaires

Pour les versions antérieures a 2020 R2 SP1, vous devez d’abord mettre a niveau Pl Integrator for Business
Analytics 2020 R2 SP1.

¢ |l n‘existe aucun chemin de mise a niveau direct de Pl Integrator for Business Analytics 2020 R2 Correctif 2 et
versions antérieures vers Pl Integrator for Business Analytics 2020 R2 SP2.

Pour les versions antérieures a 2020, vous devez d’abord mettre a niveau Pl Integrator for Business Analytics
2020.

¢ |l n’existe aucun chemin de mise a niveau direct de Pl Integrator for Business Analytics 2018 R2 SP2 et
versions antérieures vers Pl Integrator for Business Analytics 2020 R2 SP1 ou versions ultérieures.

e Téléchargez I'utilitaire SQL de Pl Integrator for Business Analytics 2020 contenant le script qui permet
d’effectuer la mise a niveau des bases de données.

Pour les versions antérieures a 2018 R2, vous devez d’abord mettre a niveau Pl Integrator for Business Analytics
2018 R2.

¢ Sivous mettez a niveau Pl Integrator for Business Analytics 2018 R2 en tant que version intermédiaire et que
Pl Integrator for Business Analytics était exécuté avec un serveur Pl AF 2014 ou une version antérieure, vous
devez effectuer une mise a niveau vers Pl AF 2015 ou une version ultérieure avant de continuer. Sinon, vos
utilisateurs existants ne seront pas automatiquement convertis en identités Pl AF. Pour plus d’informations,
voir Autorisations d’acces utilisateur.

¢ Si plusieurs instances 1.x de Pl Integrator sont installées sur le méme serveur Pl AF, les instances peuvent
toutes étre de la version 1.x ou elles doivent toutes étre mises a niveau vers la version 2.x. Si vous mettez a
niveau certaines instances vers la version 2.x mais pas toutes, il se peut que vos vues 1.x ne soient pas
publiées apres la mise a niveau.

¢ Sile compte d’utilisateur utilisé pour la mise a niveau vers Pl Integrator for Business Analytics 2018 R2
dispose du réle de base de données db_accessadmin sur les bases de données PlintegratorDB,
PlintegratorLogs et PlintegratorStats, le compte d’utilisateur doit également disposer des priviléges SELECT,
UPDATE et ALTER sur la base de données PlintegratorStats. Si le compte d’utilisateur ne possede pas les
autorisations requises pour effectuer la mise a niveau, il vous faudra mettre a jour manuellement les bases
de données avant de procéder a la mise a niveau.
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Préparation de la mise a niveau

Avant d’effectuer la mise a niveau :

e Vérifiez que le compte de service Windows spécifié exécute Pl Integrator for Business Analytics au format
Domaine\Utilisateur. Si le compte de service est spécifié au format UPN (User Principal Name — nom
principal de I'utilisateur), c'est-a-dire compte@domaine.com, la mise a niveau échouera. Vous devrez rétablir
manuellement le compte de service dans services.msc au format Domaine\Utilisateur avant de procéder a la
mise a niveau.

o Vérifiez que vous bénéficiez des privileges d’administrateur local sur 'ordinateur ol vous souhaitez installer
Pl Integrator for Business Analytics.

e Vérifiez que le compte d'utilisateur utilisé pour installer le logiciel dispose des privileges sysadmin sur le SQL
Server sur lequel vous installerez les bases de données PI Integrator. Ceci est obligatoire pour créer les bases
de données SQL dorsales de Pl Integrator.

¢ Sile compte d’utilisateur ne dispose pas des privileges requis, un utilisateur disposant des privileges
d’administrateur systéme, généralement un administrateur de base de données, doit mettre
manuellement a niveau les bases de données SQL. Commencez par la mise a niveau des bases de
données SQL avant celle de Pl Integrator for Business Analytics.

e Apres avoir installé les bases de données SQL, ajoutez le compte d’utilisateur qui mettra a niveau PI
Integrator for Business Analytics comme connexion SQL Server. L'utilisateur qui met a niveau PI
Integrator for Business Analytics doit disposer des autorisations suivantes :

1. Role de base de données db_accessadmin sur les bases de données PlintegratorDB, PlintegratorStats et
PlintegratorLogs

2. Autorisations SELECT sur la base de données PlintegratorStats

Remarque : Lors de la mise a niveau, vous ne pourrez pas spécifier un nouveau serveur Pl AF ou un
serveur SQL Server.

¢ Sil'application de sécurité d’'usurpation d’identité est activée lors de I'installation et que Pl Integrator for
Business Analytics est installé dans un environnement de confiance unidirectionnelle entre domaines,
exécutez 'outil de migration des identités dans le méme domaine que les utilisateurs de PI Integrator for
Business Analytics, avant d’effectuer la mise a niveau. Voir Comment exécuter |'outil de migration d’identités
pour plus d’informations.

Procédure de mise a niveau

Guide d’installation et d’administration de Pl Integrator for Business Analytics Si des vues sont en cours
d'exécution lorsque la mise a niveau commence ou si des vues sont programmeées pour étre exécutées pendant
la mise a niveau, arréte ou reporte les taches avant de commencer la mise a niveau des fichiers exécutables. Une
fois la mise a niveau terminée, Pl Integrator redémarre les taches ou reprend les taches en cours.

Si vous préférez, vous pouvez arréter manuellement les taches en cours d’exécution. Cependant, vous devrez
vous rappeler de redémarrer les taches une fois la mise a niveau terminée.

1. Téléchargez le kit d’installation de PI Integrator for Business Analytics depuis le Page AVEVA Customer Portal
Products.

2. Cliquez avec le bouton droit de la souris sur |'exécutable de configuration, puis cliquez sur Exécuter en tant
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gu'administrateur pour lancer I'assistant d'installation.
La fenétre Self-Extracting Executable s'ouvre.
3. Choisissez le chemin d'extraction pour l'assistant d'installation et cliquez sur OK.

La fenétre Bienvenue dans I'assistant de configuration de PI Integrator for Business Analytics apparait et
affiche les différents modules compris dans l'installation. L'assistant d'installation met a niveau chaque
module ou vérifie si la bonne version du module est déja installée sur votre systeme.

4. Cliquez sur OK.

La fenétre Bienvenue dans |'assistant d'installation de PI Integrator for Business Analytics apparait.
5. Cliguez sur Suivant.

La fenétre Logon Information (Informations de connexion) s'ouvre.

6. Indiquez le Mot de passe du compte de service Windows exécutant les services Pl Integrator for Business
Analytics.

7. Cliquez sur Suivant.
La fenétre Configuration du port et du certificat TLS s’ouvre.

8. Entrez un numéro de port valide disponible dans le champ Entrer un numéro de port et cliquez sur Valider le
port.

Linterface utilisateur de PI Integrator for Business Analytics utilise ce port pour se connecter au composant
de service Pl Integrator Framework.

Astuce : Si vous utilisez le port 443, vous pouvez ignorer le numéro de port si vous indiquez I'URL de
Pl Integrator for Business Analytics.

9. Choisissez un certificat TLS parmi I'une des sources suivantes :

¢ (Recommandé) Certificat TLS obtenu auprées d’une autorité de certification. Sélectionnez Import
certificate (Importer le certificat) et cliquez sur Select Certificate (Sélectionner le certificat) pour choisir
un certificat émis par une autorité de certification et importé sur la machine ou Pl Integrator for Business
Analytics est en train d’étre installé.

¢ Certificat auto-signé généré lors de l'installation. C'est la valeur par défaut.

Remarque : Si vous choisissez cette option, les utilisateurs qui se connectent depuis une machine a distance
peuvent voir s’‘afficher un message d’avertissement lié a la sécurité. Pour éviter I'affichage de cet
avertissement pour les certificats auto-signés, le certificat doit étre explicitement approuvé sur la machine
client. Consultez la solution dans I'article de la Base de connaissances OSlsoft Certificate error returned when
navigating to a Pl Vision or Pl Web API web site using a self-signed certificate (Renvoi d'une erreur de
certificat lors de I'accés a un site Web de PI Vision ou Pl Web API a |'aide d'un certificat auto-signé).

10. Dans la fenétre Pl Integrator Worker Nodes (Noeuds Travailleur Pl Integrator), cliquez sur la fleche et
sélectionnez le nombre de noeuds Travailleur que vous souhaitez installer, puis cliquez sur Suivant.

La fenétre Ready to Install the Application s'ouvre.

Remarque : Chaque nceud Travailleur additionnel exige une capacité supplémentaire de processeur et de
RAM.

Remarque : En cas d’erreur, assurez-vous que le port est disponible et ouvert.

11. Cliquez sur Suivant.
Si vous avez une vue, la fenétre Sauvegarder les vues existantes s’ouvre. Sinon, passez a I'étape 13.
12. Cliquez sur Effectuer une sauvegarde.

Cette étape permet d’effectuer une sauvegarde de la configuration de la vue existante dans la base de
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données de configuration AF. Si la sauvegarde se termine correctement, cette boite de dialogue indique I'état
de la sauvegarde, ainsi qu’un lien vers le fichier de sauvegarde dans le répertoire %PIHOME%\dat.

Si une erreur se produit, un message d’erreur apparait. Cliquez sur OK pour fermer la boite de dialogue.
A ce stade, vous pouvez :

e résoudre I'erreur et cliquer sur Effectuer une sauvegarde.

o effectuer une sauvegarde manuellement dans Pl System Explorer. Pour ce faire<:hs>:

e Sur la machine ou PI Integrator for Business Analytics est installé, localisez le fichier %PIHOME®64\
Integrators\BA\CAST.Ul.WindowsService.exe.config.

¢ Ouvrez le fichier de configuration et notez la valeur de la clé InstancePath.

e Dans Pl System Explorer, accédez a I'élément indiqué par I'élément InstancePath.

e Développez I'élément a 'aide de la fleche vers la gauche pour exposer I'élément Vues.
¢ Faites un clic droit sur I'élément Vues et sélectionnez Exporter vers un fichier.

e Sélectionnez les options Objets référencés inclus et Inclure les chaines de caractéres de sécurité.
Notez 'emplacement du fichier de sauvegarde.

¢ Cliquez sur OK.
e Procédez sans effectuer de sauvegarde (non recommandé).

13. Létape de vérification d’obsolescence des vues Pl nécessite confirmation de votre part que la cible de vue PI
est obsoléte. Toutes les vues existantes utilisant la cible de vue PI ne pourront plus étre publiées apres
I'installation.

¢ (Recommandé) Une analyse est disponible pour détecter toutes les vues de votre systeme qui utilisent la
cible de vue PI. Si I'analyse se termine avec succes, une liste des noms des vues détectées s’affiche, ainsi
gu’un lien vers le fichier de liste exporté dans le répertoire %PIHOME%\dat. Vous pouvez utiliser cette
analyse pour identifier les vues Pl qui peuvent étre supprimées ou migrées vers la cible
Microsoft SQL Server comme alternative. Pour obtenir des instructions sur la migration des vues a l'aide
de la cible de vue Pl vers Microsoft SQL Server, voir Migrer la cible de vue Pl vers la cible Microsoft SQL
Server.

¢ Siune erreur se produit pendant I'analyse, un message d’erreur s’affiche. Cliquez sur OK pour fermer
la boite de dialogue.

¢ Sil'analyse réussit mais que I'exportation de la liste échoue, veuillez noter manuellement les noms
des vues.

Cochez la case de confirmation pour poursuivre I'installation. Cliquez sur Suivant.
La fenétre Ready to Install the Application (Prét a installer I'application) s’ouvre.
14. Cliquez sur Installer.
La fenétre Mise a jour du systéme apparait et indique la progression de l'installation.

15. Une fois l'installation terminée, la fenétre Installation Complete (Installation terminée) s’affiche. Cliquez sur
Fermer.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 34



AV=VA"

Pl Integrator for Business Analytics

Configurer vos cibles de publication

Configurer vos cibles de publication

Cette procédure est une vue d'ensemble de toutes les étapes que vous devez suivre pour configurer la cible de
publication, y compris les étapes avant la création et la configuration de la cible de publication.

Remarque : A partir de Pl Integrator for Business Analytics 2020 R2 SP2, |a cible de vue Pl est obsoléte. Pour
migrer des vues utilisant la cible de vue Pl vers une cible Microsoft SQL Server comme alternative, voir Migrer la
cible de vue Pl vers la cible Microsoft SQL Server.

1. Sivous publiez vos données Pl System sur I'une des cibles ci-dessous, suivez les instructions dans la rubrique
référencée pour configurer la cible. Pour toutes les autres cibles, passez a I'étape suivante.

Base de données Oracle — Reportez-vous a la section Configurer la cible de publication de la base de

données Oracle.

Cible Azure SQL Database ou Pool SQL dédié Azure — Reportez-vous a la section Configurer la cible Azure

SQL Database ou Pool SQL dédié Azure.

Amazon Redshift — Installez le pilote ODBC Amazon Redshift sur la machine ou Pl Integrator for Business
Analytics est installé — Reportez-vous a la section Installer et configurer le pilote ODBC Amazon Redshift.

ODBC SAP HANA — Installez le client SAP HANA sur la machine ou PI Integrator for Business Analytics est

installé. Reportez-vous a la section Configurer la cible de publication ODBC SAP® HANA®.

2. Ajoutez la cible de publication a Pl Integrator for Business Analytics. Voir Ajouter une cible de publication.

3. Configurez la cible de publication. Reportez-vous a la rubrique relative a votre cible.

Configurer la cible de flux de données Amazon Kinesis
Configurer la cible Amazon Redshift

Configurer la cible Amazon S3

Configurer la cible Apache Hive

Configurer la cible Apache Kafka

Configurer la cible Azure Data Lake Storage Gen 2
Configurer la cible Azure Event Hubs

Configurer la cible Azure loT Hub

Configurer la cible Azure SQL Database

Configurer la cible Pool SQL dédié Azure

Configurer la cible Google BigQuery

Configurer la cible Google Cloud Storage

Configurer la cible Google Cloud Pub/Sub

Configurer la cible du systeme de fichiers distribués Hadoop (HDFS)
Configurer la cible Microsoft SQL Server

Configurer la cible Oracle

Configurer la cible de publication ODBC SAP® HANA®

Configurer la cible fichier texte

4. Autorisez les utilisateurs a accéder a la cible de publication. Voir Autoriser I'acces aux cibles.
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Ajouter une cible de publication

Ce chapitre vous explique comment ajouter des cibles de publication.

Remarque : Les points de sortie cible disponibles sont déterminés par la version du logiciel.

1. Cliquez sur l'icone du menu E, puis cliquez sur Administration.
2. Cliquez sur I'onglet Targets (Cibles).
La page Configuration de la cible de publication apparait.
3. Cliquez sur Ajouter une cible de publication.
La boite de dialogue Créer une nouvelle cible de publication apparait.

4. Entrez le nom de la cible de publication dans le champ Nom de la cible. Cliquez sur Type de cible et
sélectionnez un type de point de sortie dans la liste.

5. Cliquez sur Créer une nouvelle cible.

Configurer la cible de flux de données Amazon Kinesis

Suivez la procédure ci-dessous pour configurer la cible de flux de données Amazon Kinesis et vérifiez que vous
pouvez écrire dans les flux de données Amazon Kinesis.

¢ Assurez-vous que la clé d’accés AWS que vous saisissez dans la configuration de la cible Pl Integrator for
Business Analytics correspond a un utilisateur AWS disposant des autorisations suivantes sur la cible Amazon
Kinesis Data Streams : actions ListStreams, DescribeStream, PutRecord/PutRecords.

e Créez lacible de flux de données Amazon Kinesis avant de la configurer. Pour plus d’informations, voir
Ajouter une cible de publication.

1. Ala page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez la cible dans la liste Cibles de
publication.

Remarque : Si vous avez déja sélectionné votre cible, passez a |'étape suivante.

2. Reportez-vous au tableau suivant et saisissez les informations requises. Cliquez sur les boutons lorsqu'ils sont

activés.

Parametre Description

ID de clé d'acces AWS Utilisé avec la clé d'accés secret pour authentifier les
requétes sur le flux.

Clé d'accés secret AWS Utilisé avec I'ID de clé d'acces AWS pour authentifier
les requétes sur le flux.

Flux de données Kinesis Nom du flux de données Amazon Kinesis dans lequel
des données sont écrites

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 36



'AV EVA\TM Pl Integrator for Business Analytics

Configurer vos cibles de publication

Parameétre Description

Région Si la région souhaitée ne figure pas dans la liste
déroulante, essayez de la saisir manuellement dans
le champ de saisie.

Vérifiez que le format correspond a un code régional
Amazon valide, et non au nom de la région. Le
format doit correspondre au format des régions
prises en charge ci-dessous :

Par défaut : us-east-1
Régions prises en charge :
af-south-1
ap-east-1
ap-northeast-1
ap-northeast-2
ap-northeast-3
ap-south-1
ap-south-2
ap-southeast-1
ap-southeast-2
ap-southeast-3
ap-southeast-4
ca-central-1
ca-west-1
cn-north-1
cn-northwest-1
eu-central-1
eu-central-2
eu-north-1
eu-south-1
eu-south-2
eu-west-1
eu-west-2
eu-west-3
il-central-1
me-central-1
me-south-1
sa-east-1

us-east-1
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Parameétre

Description

us-east-2
us-west-1

us-west-2

Régions non prises en charge

Zone géographique avec laquelle ce client
communique.

AWS GovCloud (Est des Etats-Unis)
AWS GovCloud (Ouest des Etats-Unis)
US ISOB East End.

ISO Virginie de I'Est des Etats-Unis
ISO Ouest des Etats-Unis

Les zones locales AWS ne sont pas prises en charge

Format de stockage des données

(Facultatif) Format de fichier dans lequel les
données sont stockées. La valeur par défaut est
Parquet. Les autres options sont JSON et
Indentation JSON.

Compression

(Facultatif) Type de compression sur des jeux de
messages. La valeur par défaut est Aucun. Les autres
options sont les suivantes : Gzip et Snappy.

Autoriser les valeurs nulles

(Facultatif) Si sélectionné, des valeurs nulles sont
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Parameétre Description

valides.

Cliquez sur Vérifier le dispositif d'écriture.
4. Cliquez sur Enregistrer les modifications.

Autorisez les utilisateurs a accéder a la cible de flux de données Amazon Kinesis. Pour plus d’informations,
voir Autoriser |'accés aux cibles.

Remarque : Toute région qui ne figure pas spécifiquement dans la liste des régions prises en charge ci-dessus
est considérée comme une région non prise en charge (la prise en charge de cette région n’est pas garantie).
AVEVA prend en charge les régions mentionnées dans cette liste au moment de la publication de cette
version et ne peut garantir la prise en charge de régions nouvellement ajoutées.

Installer et configurer le pilote ODBC Amazon Redshift

Vous devez installer et configurer le pilote ODBC Amazon Redshift sur la machine sur laquelle Pl Integrator for
Business Analytics est installé avant de pouvoir configurer la cible Amazon Redshift.

1. Sur la page Installer et configurer le pilote ODBC Amazon Redshift sur des systemes d'exploitation Microsoft
Windows, téléchargez le fichier d'installation en fonction de I'architecture systéme de votre outil ou
application client(e) SQL :

¢ 64-bit — Amazon Redshift (x64)
2. Exécutez le fichier pour installer le pilote ODBC Amazon Redshift.

Suivez les instructions pour configurer le pilote.

Configurer la cible Amazon Redshift

Suivez la procédure ci-dessous pour configurer la cible Amazon Redshift et vérifiez que vous pouvez écrire dans
la base de données Amazon Redshift.

¢ Assurez-vous que l'utilisateur de la base de données que vous entrez dans la configuration de la cible de
publication de PI Integrator for Business Analytics dispose des autorisations minimum suivantes sur la base
de données Amazon Redshift : SELECT, CREATE, DROP, UPDATE, INSERT et DELETE.

¢ Installez et configurez le pilote ODBC Amazon Redshift. Pour plus d'informations, voir Installer et configurer
le pilote ODBC Amazon Redshift.

e Créez la cible Amazon Redshift avant de la configurer. Pour plus d'informations, voir Ajouter une cible de
publication.

1. A la page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez la cible dans la liste Cibles de
publication.

Remarque : Si vous avez déja sélectionné votre cible, passez a I'étape suivante.

2. Reportez-vous au tableau suivant et saisissez les informations requises. Cliquez sur les boutons lorsqu'ils sont
activés.
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Parameétre

Description

Pilote ODBC

(Facultatif) Pilote ODBC qui se connecte au cluster
Amazon. La valeur par défaut est Amazon Redshift
(x64).

Nom du cluster

Nceud de cluster Amazon auquel des données sont
envoyées.

Port de la base de données du cluster

(Facultatif) Port utilisé pour la connexion a la base
de données du cluster. La valeur par défaut est
5439.

Nom de la base de données du cluster

Base de données du cluster dans laquelle les
données sont écrites.

Nom d'utilisateur de la base de données

Nom d'utilisateur de la base de données utilisé pour
la connexion au cluster.

Password

Mot de passe pour le nom d'utilisateur de la base de
données utilisé pour la connexion au cluster.

Cliquez sur Vérifier le dispositif d'écriture.

4. Cliquez sur Enregistrer les modifications.

Autorisez les utilisateurs a accéder a la cible Amazon Redshift. Pour plus d'informations, voir Autoriser |'acces

aux cibles.

Configurer la cible Amazon S3

Suivez la procédure ci-dessous pour configurer la cible Amazon S3 et vérifiez que vous pouvez écrire dans la base

de données Amazon Redshift.

e Assurez-vous que la clé d’accés AWS que vous saisissez dans la configuration de la cible Pl Integrator for
Business Analytics correspond a un utilisateur AWS disposant des autorisations suivantes sur la cible Amazon
S3 : s3:ListBucket, s3:PutObject, s3:GetObject, s3:DeleteObject, and s3:GetBucketLocation.

¢ Sivous utilisez la base de données Amazon Athena, assurez-vous que la clé d’accés AWS que vous
saisissez dans la configuration cible de PI Integrator for Business Analytics correspond a un utilisateur
AWS disposant des autorisations suivantes sur la base de données : Athena — Lecture et écriture.
L'utilisateur doit disposer de toutes les autorisations liées a la lecture et a I'écriture.

SMTP Actions Ressources Conditions de la
demande
Athena * (toutes les actions) Toute ressource de type | Aucun
= groupe de travail
Colle * (toutes les actions) Toutes les ressources Aucun
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e Athena — Lecture et écriture. L'utilisateur doit disposer de toutes les autorisations liées a la lecture et a
I'écriture. L'utilisateur doit disposer de toutes les autorisations liées a la lecture et a I'écriture.

¢ Glue — Lecture et écriture. L'utilisateur doit disposer de toutes les autorisations liées a la lecture et a

|"écriture.

Remarque : Pour écrire dans une base de données Amazon Athena, celle-ci doit se trouver dans la méme
région que le compartiment Amazon S3. L'écriture dans une base de données Amazon Athena n’est prise en
charge que lors de l'utilisation du type de stockage de données Parquet.

e Créez la cible Amazon S3 avant de la configurer. Pour plus d’informations, voir Ajouter une cible de

publication.

Suivez la procédure ci-dessous pour configurer la cible Amazon S3 et vérifiez que vous pouvez écrire dans le

compartiment Amazon S3.

1. A la page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez la cible dans la liste Cibles de

publication.

Remarque : Si vous avez déja sélectionné votre cible, passez a I'étape suivante.

2. Reportez-vous au tableau suivant et saisissez les informations requises. Cliquez sur les boutons lorsqu'ils sont

activés.

Parameétre

Description

Format de stockage des données

Format de fichier dans lequel les données sont
stockées. La valeur par défaut est Parquet. Les
autres options sont les suivantes : JSON,
Indentation JSON et Texte.

Compression

Type de compression sur des jeux de messages. La
valeur par défaut est Aucun. Les autres options sont
les suivantes : Gzip et Snappy.

Remarque : Choisissez un parameétre de
compression pour obtenir de meilleures
performances.

ID de clé d'acces AWS

Utilisé avec la clé d'acces secret pour authentifier les
requétes sur le conteneur.

Clé d'accés secret AWS

Utilisé avec I'ID de clé d'acces Amazon pour
authentifier les requétes sur le conteneur.

Inclure I'en-téte

Si sélectionné, des noms de colonne sont ajoutés au
début du fichier.

Délimiteur de champ

Caractere(s) séparant les champs de données dans
la ligne. Par défaut, une tabulation (\t) sépare les
champs.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 41



'AV EVA\TM Pl Integrator for Business Analytics

Configurer vos cibles de publication

Région Vous trouverez ci-dessous la liste des zones
géographiques avec lesquelles ce client
communique. Si la région souhaitée ne figure pas
dans la liste déroulante, essayez de la saisir
manuellement dans le champ de saisie.

Vérifiez que le format correspond a un code régional
Amazon valide, et non au nom de la région. Le
format doit correspondre au format des régions
prises en charge ci-dessous :

Par défaut : us-east-2
Régions prises en charge :
af-south-1
ap-east-1
ap-northeast-1
ap-northeast-2
ap-northeast-3
ap-south-1
ap-south-2
ap-southeast-1
ap-southeast-2
ap-southeast-3
ap-southeast-4
ca-central-1
ca-west-1
cn-north-1
cn-northwest-1
eu-central-1
eu-central-2
eu-north-1
eu-south-1
eu-south-2
eu-west-1
eu-west-2
eu-west-3
il-central-1
me-central-1
me-south-1
sa-east-1

us-east-1
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us-east-2
us-west-1

us-west-2

Régions non prises en charge Zone géographique avec laquelle ce client
communique.

AWS GovCloud (Est des Etats-Unis)
AWS GovCloud (Ouest des Etats-Unis)
US ISOB East End.

ISO Virginie de I'Est des Etats-Unis
ISO Ouest des Etats-Unis

Les zones locales AWS ne sont pas prises en charge.

Délimiteur de ligne Caractere(s) séparant les lignes de données. Par
défaut, une nouvelle ligne sépare les lignes de
données. Les caracteres spécifiant une nouvelle
ligne sont spécifiques a la plateforme. La valeur par
défaut fournit automatiquement les caractéeres
appropriés a I'environnement.

Nom du conteneur Conteneur S3 dans lequel des données sont
chargées.
Chemin d'acces au dossier (Facultatif) Indiquez des préfixes de nom de clé et

des barres obliques (/) pour organiser les vues dans
S3. Les préfixes de nom de clé doivent exister dans
S3 pour pouvoir configurer la cible. Pour plus
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d'informations sur la création d'une hiérarchie
logique dans S3, voir Clé de |'objet et métadonnées.

Autoriser les valeurs nulles Si cette option est sélectionnée, les valeurs NULL
sont valides

Lignes/objets maximum (Facultatif) Nombre d'objets maximum dans un
fichier. Par défaut : 100 000 lignes. Voir la Remarque
ci-dessous.

Taille de fichier maximale (Ko) (Facultatif) Taille de fichier maximale en kilo-octets.

Par défaut : 10 000 Ko. Voir la Remarque ci-dessous.

Durée de mise a jour maximale (sec) (Facultatif) Durée maximale de mise a jour, en
secondes, avant |'expiration du dispositif d'écriture.
Par défaut : 86 400 secondes (1 jour). Voir la
Remarque ci-dessous.

Base de données Athena Amazon (Facultatif) Nom de la base de données Amazon
Athena dans laquelle les données sont écrites.

Remarque : Toute région qui ne figure pas spécifiquement dans la liste des régions prises en charge ci-dessus
est considérée comme une région non prise en charge (la prise en charge de cette région n’est pas garantie).
AVEVA prend en charge les régions mentionnées dans cette liste au moment de la publication de cette
version et ne peut garantir la prise en charge de régions nouvellement ajoutées.

Remarque : Spécifiez un des trois paramétres facultatifs suivants : Lignes/objets maximum, Taille de fichier
maximale ou Durée de mise a jour maximale. Si aucun n'est spécifié, les vues seront toujours publiées dans
le méme fichier et un nouveau fichier ne sera jamais créé.

Les trois parametres comportent des valeurs par défaut et toutes les valeurs par défaut sont appliquées.
Lorsqu'un paramétre atteint sa limite, la création d'un nouveau fichier est déclenchée. Pour standardiser la
création d'un nouveau fichier sur un parametre, entrez des valeurs tres importantes et impossibles a
atteindre pour les autres parametres.

Cliquez sur Vérifier le dispositif d'écriture.
4. Cliquez sur Enregistrer les modifications.

Autorisez les utilisateurs a accéder a la cible Amazon S3. Pour plus d’informations, voir Autoriser |'acces aux
cibles.

Configurer la cible Apache Hive

Suivez procédure ci-dessous pour configurer la cible Apache Hive et testez votre connexion a la base de données
Hive.

Créez la cible Apache Hive avant de la configurer. Pour plus d'informations, voir Ajouter une cible de publication.

Remarque : Entrez les informations dans les champs adéquats. Les boutons sont activés une fois que les
informations requises ont été renseignées. Cliquez sur le bouton avant de passer au champ suivant.

1. A la page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez la cible dans la liste Cibles de
publication.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 44


https://docs.aws.amazon.com/AmazonS3/latest/dev/UsingMetadata.html

AV=VA"

Pl Integrator for Business Analytics
Configurer vos cibles de publication

Remarque : Si vous avez déja sélectionné votre cible, passez a I'étape suivante.

2. Reportez-vous au tableau suivant et saisissez les informations requises. Cliquez sur les boutons lorsqu'ils sont

activés.

Parameétre

Description

HDFS URL

URL pour accéder a HDFS directement via WebHDFS
ou via la passerelle Apache Knox ou HttpFS.

Exemples :
HDFS — http://host:50070/webhdfs/v1
HttpFS — http://host:14000/webhdfs/v1

Apache Knox — https://host:8443/gateway/default/
webhdfs/v1

Vérifier le certificat SSL

Cochez la case si vous utilisez un certificat SSL.

Nom d’utilisateur

Nom d'utilisateur utilisé pour la connexion a
HCatalog. L'utilisateur doit étre autorisé a lire et a
écrire sur le systéme de fichiers distribués Hadoop.

Password

(Facultatif) Mot de passe pour authentifier
['utilisateur ou lors de la connexion a HttpFS. Si un
mot de passe est fourni, I'authentification Hadoop
HTTP est utilisée. Si aucun mot de passe n'est fourni,
utilise alors l'authentification Hadoop simple.

Répertoire

Répertoire dans lequel les fichiers de données sont
créés. Cliquez sur Parcourir pour accéder au
répertoire dans lequel vous souhaitez stocker les
fichiers. Le format de I'emplacement du répertoire
est le suivant : /rootfolder/folderl/folder2.

Nom d'hote Hive

Nom d'héte de la machine sur laquelle Thrift est
exécuté. Ce nom peut étre un alias, une adresse
interne, ou une adresse IP. Par défaut, il s'agit du
nom d'hote dans I'URL HDFS.

Port Hive

(Facultatif) Port utilisé pour la connexion a Thrift.

Nom d'utilisateur Hive

(Facultatif) Nom d'utilisateur utilisé pour la
connexion a HCatalog.

Format du tableau Hive

Format d'enregistrement des tableaux dans Apache
Hive. Les formats de fichiers pris en charge
actuellement sont les fichiers de type TEXTFILE et
ORC (optimized row columnar).

Remarque : Les fichiers ORC requiérent Apache Hive
0.11 ou version ultérieure.
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Base de données Hive Nom de la base de données dans Apache Hive dans
laquelle les tableaux ont été créés.

3. Cliquez sur Connecter a Apache Hive.

Pl Integrator for Business Analytics se connecte a Apache Hive, interroge la base de données, et propage les
champs Hive Table Format et Hive Database avec les formats et bases de données de tableau pris en charge.

4. Cliquez sur Vérifier Apache Hive Writer pour vous assurer que Apache Hive Writer peut écrire sur la base de
données Hive.

Remarque : si vous ne parvenez pas a écrire dans la base de données Hive, consultez Conseils pour
configurer Apache Hive.

5. Cliquez sur Enregistrer les modifications.

Conseils pour configurer Apache Hive

Pour que Apache Hive puisse fonctionner correctement avec Pl Integrator for Business Analytics, vous devez
effectuer les taches suivantes :

e Créez l'utilisateur HDFS.

e Créez I'utilisateur HCat.

e Créez le répertoire d'utilisateur et accordez les autorisations.
e Désactivez SASL.

La procédure suivante décrit comment effectuer ces taches.

1. Créez |'utilisateur HDFS.
a. Créez |'utilisateur HDFS sur le nceud sur lequel WebHDFS est installé.

b. Ajoutez I'utilisateur HDFS a un groupe.

Remarque : L'utilisateur HDFS peut étre ajouté a n'importe quel groupe. Toutefois, dans le cadre de cet
exemple, le groupe s'appellera groupe HDFS.

2. Créez |'utilisateur HCat.
(Facultatif) Si HCat est sur un autre nceud, vous devez ajouter |'utilisateur HCat.
a. Créez |'utilisateur HCat sur le nceud sur lequel HCat est installé.
b. Ajoutez I'utilisateur HCat au groupe HDFS.

3. Créez le répertoire d'utilisateur et accordez les autorisations.

Dans la procédure suivante, vous créez un répertoire d'utilisateur et vous vous assurez qu'il est correctement
configuré pour que l'utilisateur HDFS puisse le modifier en écriture.

a. Créez un répertoire d'utilisateur sur le systeme de fichiers distribués Hadoop.
b. Définissez l'utilisateur HDFS comme propriétaire de ce répertoire.

c. Définissez le groupe HDFS comme groupe du répertoire.

o

Accordez les autorisations de lecture et d'écriture au propriétaire du répertoire (donc a I'utilisateur
HDFS).

e. Accordez les autorisations de lecture et d'écriture au groupe du répertoire.
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4. Désactivez SASL.

Remarque : Pl Integrator for Business Analytics prend uniquement en charge les cibles Apache Hive qui sont
configurées avec l'authentification NOSASL. Pour plus d'informations sur les options d'authentification
d'Apache Hive, voir Configuration de HiveServer2.

Configurer la cible Apache Kafka

Suivez procédure ci-dessous pour configurer la cible Apache Kafka et vérifiez que vous pouvez écrire dans la base
de données Apache Kafka.

e Créez la cible Apache Kafka avant de la configurer. Pour plus d'informations, voir Ajouter une cible de
publication.

¢ (Facultatif) Vérifiez qu'OpenTLS est installé sur la machine sur laquelle Pl Integrator for Business Analytics est
installé. Cette étape n'est nécessaire que si vous utilisez TLS pour la connexion a Apache Kafka.

1. Ala page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez la cible dans la liste Cibles de
publication.

Remarque : Si vous avez déja sélectionné votre cible, passez a I'étape suivante.

2. Reportez-vous au tableau suivant et saisissez les informations requises. Cliquez sur les boutons lorsqu'ils sont
activés.

Parametre Description

Brokers Kafka Liste de Brokers Kafka séparée par des virgules.
Spécifiez I'h6te/le port a I'aide du format
Héte:Port,Héte:Port format

Codec Type de compression sur des jeux de messages. La
valeur par défaut est Aucun. Les choix valides
incluent : gzip, Snappy.

Utiliser TLS/SSL Utilisez TLS (Transport Layer Security) lors de la
connexion a des brokers Kafka.

Vérification du nom d’héte TLS/SSL Algorithme de vérification du nom d’héte TLS/SSL
du courtier (propriété Apache Kafka
ssl.endpoint.identification.algorithm) utilisé. HTTPS
ou Aucun (pas de vérification du nom d’hote). La
valeur par défaut est Aucun.

Certificat client Chemin complet au certificat client (fichier pem).
Nécessaire uniquement si TLS/SSL est utilisé et
gu’un mécanisme SASL n’est pas utilisé. Contactez
votre administrateur Apache Kafka pour obtenir un
certificat client OpenSSL pour .

Clé client Chemin complet a la clé client (fichier .key).
Nécessaire uniquement si TLS/SSL est utilisé et
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gu’un mécanisme SASL n’est pas utilisé.

Mot de passe de clé Mot de passe du fichier de clé de certificat TLS.
Nécessaire uniquement si TLS/SSL est utilisé et
gu’un mécanisme SASL n’est pas utilisé.

Certificat racine AC Chemin complet au certificat racine AC utilisé pour
signer le certificat client. Nécessaire uniquement si
TLS est utilisé.

Mécanisme SASL Mécanisme SASL utilisé. La valeur par défaut est
Aucun. Quatre mécanismes d’authentification sont
pris en charge : GSSAPI (également appelé
Kerberos), PLAIN, SCRAM-SHA-256 et SCRAM-
SHA-512. Il est recommandé de combiner PLAIN,
SCRAM-SHA-256 ou SCRAM-SHA-512 avec le
chiffrement TLS afin que les mots de passe chiffrés
soient envoyés sur le réseau.

Nom d’utilisateur Nom d'utilisateur Kafka pour I'authentification SASL.
Non utilisé avec 'authentification GSSAPI.

Password Mot de passe Kafka pour I'authentification SASL.
Non utilisé avec I'authentification GSSAPI.

Cliquez sur Vérifier le dispositif d'écriture Kafka.

4. Cliquez sur Enregistrer les modifications.

e Autorisez les utilisateurs a accéder a la cible Apache Kafka. Pour plus d'informations, voir Autoriser |'acces
aux cibles.

¢ Sivous utilisez TLS/SSL pour la connexion a des brokers Apache Kafka, vous devez convertir les certificats
Windows en certificats OpenTLS. Contactez votre administrateur Apache Kafka si vous avez besoin d'aide sur
la conversion de ces fichiers.

Conseils pour la configuration de I'environnement Azure Data Lake

Avant de pouvoir configurer la cible Azure Data Lake Storage, vous devez configurer votre environnement Azure
Data Lake. Ceci inclut les informations suivantes :

¢ Obtenir I'ID de titulaire pour Azure Active Directory
e Configurer |'application Web pour accéder aux APl Web

Pour la prise en main d’Azure Data Lake Storage Gen 2, reportez-vous au site Microsoft suivant : Introduction to
Azure Data Lake Storage Gen2 (Présentation d’Azure Data Lake Storage Gen 2).

Lorsque vous créez votre environnement Azure Data Lake, vous collectez les informations suivantes :

¢ ID de titulaire — ID qui identifie Active Directory
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¢ ID client — ID qui identifie I'application Azure Data Lake
e Clé client — Utilisée pour authentifier Pl Integrator for Business Analytics

¢ |D d'abonnement — ID qui identifie Azure Data Lake Storage

Remarque : OSIsoft vous recommande de copier ces valeurs dans un fichier texte pour pouvoir vous y référer
ultérieurement. Vous aurez besoin de ces informations lors de la configuration de vos cibles Microsoft Azure
Data Lake Storage. Ces informations sont utilisées par pour se connecter a Azure Data Lake Storage Gen 2.

Obtenir I'ID de titulaire pour Azure Active Directory

Remarque : Plusieurs méthodes permettent d'obtenir I'ID de titulaire. Reportez-vous a la documentation
Microsoft pour les autres alternatives.

1. Dans le portail Microsoft Azure, utilisez le compte pour vous connecter au service Azure Data Lake.
2. Sélectionnez I'Azure Active Directory sur lequel I'application Web est créée.
3. Cliquez sur Propriétés.

> emol

emoninoosisoft (default directory) - Properties

Azure Active Directory

Name

i=| Custom domain names

Default Directory
2 Mobility (MDM and MAM)

Country or regicn

Password reset United States

Company branding Location
United States datacenters
¥ User settings

WoTTnicauon language

Properties English ~
B MNotifications settings Global admin can manage Azure Subscriptions and Management Groups
Yes No
SECURITY D rectory o
Conditional access 73856¢71-7490-401b-2976-01dcd42c490 | E

Remarque : Lors des mises a jour suivantes du portail, I'écran peut étre différent et les parametres peuvent
se trouver a un autre emplacement.

L'ID de titulaire correspond a la valeur dans le champ ID de répertoire.

4. Copiez cette chaine de caracteres dans un fichier texte.

Configurer la cible Azure Data Lake Storage Gen 2

Suivez la procédure ci-dessous pour configurer la cible Azure Data Lake Storage Gen 2.

e Procédez a la configuration de votre environnement Azure Data Lake et a la collecte des informations
obligatoires pour configurer la cible. Pour plus d'informations, voir Conseils pour la configuration de
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I'environnement Azure Data Lake.

e Créez lacible Azure Data Lake Storage Gen 2 avant de la configurer. Pour plus d'informations, voir Ajouter
une cible de publication.

e Accordez a l'utilisateur qui se connectera a Azure Data Lake Storage Gen 2 les autorisations minimales
suivantes : dans Azure Active Directory, inscrivez le nouvel acces a I'application avec la clé secréte client ou
utilisez I'acces a l'application existant. Dans votre compte de stockage, attribuez le réle Propriétaire des
données Blob de stockage pour cet acces a I'application.

1. Dans la page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez la cible Azure Data Lake
Storage Gen 2 dans la liste Cibles de publication.

2. Configurez la cible Azure Azure Data Lake Storage Gen 2 avec les parameétres suivants :

Parametre Description
ID de titulaire Identifiant de votre compte Azure Active Directory.
ID d'application Identifiant de I'application Azure Data Lake Storage

Gen 2 qui authentifie I'application PI Integrator for
Business Analytics aupres de I'Azure Data Lake
Storage Gen 2.

Clé secrete client Clé utilisée pour authentifier le PI Integrator for
Business Analytics aupres de votre application AAD

Nom du compte Azure Storage Nom du compte Azure qui s'authentifie aupres des
services Azure.

Format de stockage des données Format de fichier ol les données sont stockées. La
valeur par défaut est Parquet.

3. Cliquez sur Authentifier pour vérifier que les identifiants de connexion fournis autorisent Pl Integrator for
Business Analytics a se connecter a Azure Data Lake Storage Gen 2.

Si I'authentification réussit, une liste de conteneurs Data Lake apparait dans la liste Conteneur Azure.

4. Continuez la configuration des parametres suivants :

Parameétre Description

Conteneur Azure Conteneur Azure Data Lake Storage Gen 2 ol vos
données sont stockées.

Répertoire ADLS Emplacement sur I’Azure Data Lake Storage Gen 2
dans lequel les données sont écrites.

Ajouter un horodatage Si cette option est sélectionnée, un horodatage
correspondant a I'heure de la publication de la vue
est ajouté au nom du fichier, et un nouveau fichier
est créé chaque fois que la vue est publiée. Un
numéro de séquence ajouté est utilisé a la fin des
noms de fichiers suivants une fois que la limite
maximale de lignes/d’objets a été atteinte. Si cette
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Parameétre

Description

option n’est pas sélectionnée, une séquence
d’identifiants uniques GUID aléatoire est utilisée
dans le nom de fichier et plusieurs événements de
publication peuvent ajouter des données au fichier
existant jusqu’a ce que la limite maximale de lignes/
d’objets ait été atteinte. Une nouvelle séquence
d’identifiants uniques GUID est ensuite générée
pour le fichier suivant.

Inclure I'en-téte

Si cette option est sélectionnée, des noms de
colonne sont ajoutés au début du tableau

Délimiteur de champ

Caractere(s) séparant les valeurs de données dans le
fichier Azure Data Lake Storage Gen 2. Par défaut, il
s'agit d'une espace sous forme de tabulation.

Lignes/objets maximum

Nombre maximum d'objets dans un fichier. Par
défaut : 100 000 lignes. Plage autorisée O - 10 000
000.

Délai de transfert

Délai d'attente de transfert de données en
secondes. Par défaut : 900 (s). Plage autorisée O - 86
400 (1 jour) (facultatif)

Taille initiale du transfert

Taille initiale du transfert de données en octets.
Valeur par défaut : 4 194 304 (4 Mo). Plage
autorisée 0- 1073 741 824 (1 Go). Cette valeur
représente la taille du paquet, pas la taille du fichier
entier. (Facultatif)

Taille maximale du transfert

Taille maximale du transfert de données en octets.
Valeur par défaut : 4 194 304 (4 Mo). Plage
autorisée 0-1 073 741 824 (1 Go). Cette valeur
représente la taille du paquet, pas la taille du fichier
entier. (Facultatif)

Nombre maximal de nouvelles tentatives de
transfert

Taille maximale du transfert de données en octets.
Par défaut : 6. Plage autorisée 0 - 100. (Facultatif)

5. Cliquez sur Vérifier ADL Writer pour vérifier que Pl Integrator for Business Analytics peut écrire dans

I'emplacement Azure Data Lake Storage Gen 2 spécifié.

Remarque : Si vous avez plusieurs conteneurs dans la liste déroulante Conteneur Azure, assurez-vous que la
structure de dossiers dans le répertoire ADLS correspond au conteneur Azure que vous avez sélectionné.

Cliquez sur Enregistrer les modifications.

7. Autorisez les utilisateurs a accéder a la cible Azure Data Lake Storage Gen 2. Pour plus d'informations, voir

Autoriser |'acces aux cibles.
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Ajouter un horodatage dans ADLS Gen 2

Grace a I’'horodatage, chaque événement de publication constitue une opération distincte. Les données ne sont
pas ajoutées aux fichiers, et un nouveau fichier est automatiquement créé et publié avec un autre horodatage.
C’est a 'opposé de I'identifiant unique GUID, ou la publication n’est pas traitée comme une opération distincte,
et ou un nouveau fichier n’est créé sous le méme événement de publication que lorsque vous avez atteint le seuil
du nombre maximal de lignes/d’objets.

Dans la page de configuration d’ADLS Gen 2, si la zone Ajouter un horodatage n’est pas sélectionnée, votre cible
publiée inclura un nom de fichier, un trait de soulignement, puis un identifiant unique GUID aléatoire.
'horodatage peut étre configuré et le nombre de lignes/d’objets par défaut dans un fichier est de 100 000.

Publish Target Configuraticn

Apphcaiion 10 ) " . . Adminisiraons Edrminisimior seourity pooess
il Wy Al ralylics Pl Analysia Serdce ssecurily acins

Hatifcaticns i Moafications Serace sscunty acoees

Fuland

RTE Ergine RTGR Ergine sscurfty scces

Warily ADLE 2 Wiiter [

Configurer la cible Azure Event Hubs

Suivez la procédure ci-dessous pour configurer la cible Azure Event Hubs et vérifier votre connexion a Azure
Event Hubs.

Créez les Azure Event Hubs. Créez ou identifiez la politique d’accés partagé Azure Event Hubs pour PI Integrator
for Business Analytics. Les autorisations minimum requises sont Send.

1. Ala page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez la cible dans la liste Cibles de
publication.

Remarque : Si vous avez déja sélectionné votre cible, passez a |'étape suivante.

2. Récupérez la chaine de connexion Azure Event Hubs. Le format de la chaine de connexion est illustré ci-
dessous :

Endpoint=sb.//<NamespaceName>.servicebus.windows.net/;SharedAccessKkeyName=<KeyName>;SharedAccessKey=<
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Remarque : Cette chaine de connexion provient de I'Event Hub lui-méme, et non du bus de service parent
des Event Hubs (qui possede également sa propre chaine de connexion, inutilisable par Pl Integrator).

3. Configurez les Azure Event Hubs avec les parametres suivants :

Parameétre

Description

Point limite

Point limite de I'Event Hub vers lequel les données
sont publiées ; il s’agit de la valeur de point limite
dans la chaine de connexion Event Hub.

Remarque : Assurez-vous que la chaine entiére
commence par « sh:// » et que la terminaison
« .servicebus.windows.net » est utilisée en entrée.

Nom de la clé d’acces partagée

Utilisé en association avec la clé d’acces partagée
pour se connecter a I'Event Hub. Il s’agit de la valeur
SharedAccessKeyName dans la chaine de connexion
Event Hub.

Clé d’acces partagée

Clé primaire ou secondaire de I'Event Hub utilisée
en association avec le nom de la clé d’acces
partagée pour se connecter a I'Event Hub. Il s’agit de
la valeur SharedAccessKey dans la chaine de
connexion Event Hub.

Chemin d’entité

Lentité Event Hub vers laquelle les données seront
publiées ; il s’agit de la valeur EntityPath dans la
chaine de connexion Event Hub.

Codage de caractéres

Jeu de caractéres dans lequel les données sont
codées Par défaut : UTF-8. Les autres options sont
ASCII, UTF-7, UTF-32 et Unicode.

La capture d'écran suivante montre ol trouver ces parametres dans le portail Microsoft Azure.

Overview
X Diagnose and solve problems
SendOnly

SETTINGS
Shared access policies

{ii Metrics [preview)

Properties

ﬂ Locks

3 Automation script
ENTITIES
£= Consumer groups

SUPPORT + TROUBLESHOOTING

New support request
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Remarque : Une stratégie d’acces partagé Azure existante pour les Event Hubs correspondant aux
autorisations minimum peut étre utilisée, ou une nouvelle stratégie d’acces partagé peut étre créée a cet
effet. Lors des mises a jour suivantes du portail, I'écran peut étre différent et les parameétres peuvent se

trouver a un autre emplacement.

4. Cliquez sur Vérifier le dispositif d'écriture Event Hub pour vérifier si les Event Hubs sont valides.

Cliquez sur Enregistrer les modifications.

6. Autorisez les utilisateurs a accéder a la cible Azure Event Hubs. Pour plus d’informations, voir Autoriser

['acces aux cibles.

Configurer la cible Azure loT Hub

Suivez la procédure ci-dessous pour configurer la cible Azure loT Hub et vérifier votre connexion a Azure loT Hub.

Créez I'Azure loT Hub. Créez ou identifiez la stratégie d’acces partagé Azure loT Hub qui sera utilisée par PI
Integrator for Business Analytics. Si vous créez un appareil sur lequel toutes les vues Pl Integrator for Business
Analytics seront écrites en spécifiant I'ID d’appareil, « Lecture du Registre » est I'autorisation minimum requise.
Si Pl Integrator for Business Analytics crée automatiquement un appareil pour chaque vue, « Ecriture du

Registre » est I'autorisation minimum requise.

Remarque : Dans cette version, la clé symétrique est la seule authentification prise en charge.

1. A la page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez la cible dans la liste Cibles de

publication.

Remarque : Si vous avez déja sélectionné votre cible, passez a I'étape suivante.

2. Récupérez la chaine de connexion loT Hub. Le format de la chaine de connexion est illustré ci-dessous :

HostName=<Nom d’héte>;SharedAccessKeyName=<Nom de la clé>;SharedAccessKey=<Clé SAS>

3. Configurez I'Azure loT Hub avec les parameétres suivants :

Parameétre

Description

Nom d’héte

Nom d’héte de I'loT Hub vers lequel les données
sont publiées. Il s’agit de la valeur HostName dans la
chaine de connexion loT Hub.

Nom de la clé d’accés partagée

Utilisé en association avec la clé d’accés partagée
pour se connecter a I'loT Hub. Il s’agit de la valeur
SharedAccessKeyName dans la chaine de connexion
loT Hub.

Clé d’acces partagée

Clé primaire ou secondaire de I'loT Hub utilisée en
association avec le nom de clé d’acces partagée
pour se connecter a I'loT Hub. Il s’agit de la valeur
SharedAccessKey dans la chaine de connexion loT
Hub.

Codage de caracteéres

Jeu de caracteres dans lequel les données sont
codées Par défaut : UTF-8. Les autres options sont
ASCII, UTF-7, UTF-32 et Unicode.
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Parameétre Description

ID d'appareil (Facultatif) ID d'appareil de I'appareil 10T ou de
I'appareil loT Edge. Il s’agit du nom attribué a
I'appareil. Id d’appareil est requis pour les appareils
loT Edge. Il est facultatif pour les appareils loT. Si
aucun nom n'est spécifié, un appareil loT est créé
pour chaque vue.

Remarque : Une seule vue doit étre créée par cible loT Hub si I'ID de I'appareil est fourni dans la
configuration de la cible. La combinaison de la chaine de caracteres de connexion et de I'ID d’appareil doit
étre unique pour toutes les cibles loT Hub créées. Des erreurs de connexion peuvent se produire lorsque
plusieurs vues utilisent la méme chaine de caracteres de connexion et le méme ID d’appareil.

La capture d'écran suivante montre ou trouver la chaine de connexion d'loT Hub dans le portail Microsoft
Azure. Notez que a besoin de la chaine de connexion des stratégies d'acces partagé d'loT Hub (et non de la
chafne de connexion au niveau de I'appareil). La stratégie sélectionnée sur cette page détermine les
autorisations de la chaine de connexion. Sélectionnez ou créez ainsi une stratégie qui fournit les
autorisations requises, selon que I'ID d’appareil est sélectionné ou non, et indiquez la chaine de connexion
de la stratégie sélectionnée pour la cible Pl Integrator for Business Analytics. Les chaines de connexion au
niveau de I'appareil ne sont pas prises en charge.

Microsoft Azure P Search e, services, and docs
Home > Microsoft.lotHub Overvie - Shared access policies registryReadWrite X
Create a resource ,X‘ &= l=mall - Shared access policies
L TH Mors
Al services € dpace
% FAVORITES
B Dashboard X Overview
J 16T Hub uses permissions to grant access to each loT hub endpoint. Permissions limit the access to an loT hub based on functionality.
i Al resources E—
& Resource groups e
& App Senvices V| Registry write @

% Function Apps Events PoucY PERMISSIONS

% SQL databases Settings iothubowner registry write, service connect, device cont
& Azure Cosmos DB Shared access policies service service connect

9 virtual machines
device device connect

4 Load balancers

registryRead registry read

I storage accounts 3+ 1P Filte m
registryReadWrite registry write - =
Virtual networks A Certificates Secondary ke

4 Azure Active Directory Built

endpoints

& Monitor

% advisor & Locks

@ security Center 3 Automation script

La capture d'écran suivante montre ou trouver les parametres d'ID d'appareil et ol définir le type
d'authentification dans le portail Microsoft |oT pour I'appareil loT Hub.
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jdoe-iothub - loT Devices Add Device
N Overview
‘_. You can use this ool to view, create, update, and delete devices on your IoT Hub.
B Activity log
2 Access control (IAM) Query®
SELECT * FROM devices
R WHERE
optional (eg. tags location="US) 1
Shared access policies
2 Pricing and scale
Operations menitoring 1
3 1P Fitter Conn
- P Fiiter by Device id |
i= Properties
8 Locks V| Plntegrator vie
£l Automation script
B loT Devices

Remarque : Avec les mises a jour ultérieures du portail, I'écran peut avoir un aspect différent et les
parametres peuvent se trouver a un autre endroit.

4. Cliquez sur Vérifier le dispositif d'écriture loT Hub pour vérifier si I'loT Hub est valide.

Si un ID d’appareil est spécifié, Pl Integrator for Business Analytics tente de trouver I'appareil. Si aucun ID
d'appareil n'est spécifié, un appareil est créé et, une fois la vérification terminée, il est supprimé.

Cliquez sur Enregistrer les modifications.

6. Autorisez les utilisateurs a accéder a la cible Azure loT Hub. Pour plus d’informations, voir Autoriser I'acces
aux cibles.

Configurer la cible Azure SQL Database ou Pool SQL dédie Azure

Suivez la procédure pour configurer la cible Azure SQL Database ou Pool SQL dédié Azure.

1. Installez la base de données dans Azure et effectuez les taches suivantes :

a. Configurez une régle de pare-feu dans Azure pour autoriser le serveur (sur lequel Pl Integrator for
Business Analytics est installé) a envoyer des requétes a ces cibles.

Par défaut, les pare-feu Azure empéchent les applications extérieures d’accéder aux serveurs de bases de
données Azure SQL Database et Pool SQL dédié Azure. Vous devez donc autoriser explicitement I'acces au
serveur.

Astuce : Accédez au portail Microsoft Azure sur la machine ou Pl Integrator for Business Analytics est installé.
Le champ d'ID client identifiant les clients ayant accés aux serveurs de bases de données est
automatiquement renseigné avec l'adresse IP de la machine.

a. Accordez a l'utilisateur SQL que vous saisissez dans la configuration de la cible de publication de PI
Integrator for Business Analytics et qui se connectera a Azure SQL Database ou au Pool SQL dédié Azure
les autorisations minimum suivantes dans Azure SQL Database ou Pool SQL dédié Azure : CONNECT,
SELECT, CREATE TABLE, ALTER, INSERT et DELETE.

2. Ajoutez la cible de publication a Pl Integrator for Business Analytics. Voir Ajouter une cible de publication.
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3. Configurez la cible de publication. Cliquez sur I'un des chapitres ci-dessous pour votre cible :

e Configurer la cible Azure SQL Database
e Configurer la cible Pool SQL dédié Azure

4. Autorisez les utilisateurs a accéder a la cible de publication. Voir Autoriser I'acces aux cibles.

Configurer la cible Azure SQL Database

Suivez la procédure ci-dessous pour configurer la cible Pool SQL dédié Azure et tester votre connexion au Pool

SQL dédié Azure.

e Créez le Pool SQL dédié Azure.

¢ Ajoutez le Pool SQL dédié Azure en tant que cible. Pour plus d’informations, voir Ajouter une cible de

publication.

1. Ala page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez Azure SQL Database dans la liste

Cibles de publication.

Remarque : Si vous avez déja sélectionné votre cible, passez a I'étape suivante.

2. Configurez la cible Pool SQL dédié Azure avec les parametres suivants :

Parameétre

Description

Nom d'hote

Nom du serveur hébergeant Azure SQL Database. Le
format est le suivant :
server_name.database.windows.net.

Nom d'utilisateur d'authentification SQL

Nom d’utilisateur utilisé pour se connecter au Pool
SQL dédié Azure.

Mot de passe d'authentification SQL

Mot de passe utilisé pour se connecter au Pool SQL
dédié Azure.

Expiration de la publication

Délai pendant lequel attend la fin de I'opération de
publication avant expiration. La valeur par défaut est
de 30 secondes.

Utiliser la haute disponibilité

(Facultatif) Connectez-vous a un SQL Server prenant
en charge la haute disponibilité et les clusters de
basculement. Loption Utiliser la haute disponibilité
active la propriété de connexion
MultiSubnetFailover dans la chaine de connexion.
Pour plus d'informations sur cette propriété,
reportez-vous au site Web de Microsoft.

Base de données

Nom de la base de données dans le Pool SQL dédié
Azure ou se trouvent les tables.

Schéma

Schéma SQL associé aux tables dans lesquelles les
données sont stockées.
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Cliquez sur Enregistrer les modifications.

o v kW

['acces aux cibles.

Configurer la cible Pool SQL dédiée Azure

Pl Integrator for Business Analytics
Configurer vos cibles de publication

Sélectionnez la base de données dans la liste Base de données.

Autorisez les utilisateurs a accéder a la cible Pool SQL dédié Azure. Pour plus d’informations, voir Autoriser

Suivez la procédure ci-dessous pour configurer la cible Pool SQL dédié Azure et tester votre connexion au Pool

SQL dédié Azure.

e Créezle Pool SQL dédié Azure.

¢ Ajoutez le Pool SQL dédié Azure en tant que cible. Pour plus d’informations, voir Ajouter une cible de

publication.

Remarque : Microsoft a modifié le nom du produit Azure SQL Data Warehouse (Pool SQL dédié). A compter
du printemps 2024, le nom de produit actuel de Microsoft pour ce service dans le portail Azure est

Dedicated SQL Pool.

1. A la page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez la cible dans la liste Cibles de

publication.

Remarque : Si vous avez déja sélectionné votre cible, passez a I'étape suivante.

2. Configurez la cible Pool SQL dédié Azure avec les parametres suivants :

Parameétre

Description

Nom d'héte

Nom du serveur hébergeant Azure SQL Database. Le
format est le suivant :
server_name.database.windows.net.

Nom d'utilisateur d'authentification SQL

Nom d’utilisateur utilisé pour se connecter au Pool
SQL dédié Azure.

Mot de passe d'authentification SQL

Mot de passe utilisé pour se connecter au Pool SQL
dédié Azure.

Expiration de la publication

Temps alloué a la publication des données sur la
cible avant expiration du PI Integrator Framework.
La valeur par défaut est de 30 secondes si le champ
est vide.

Utiliser la haute disponibilité

(Facultatif) Connectez-vous a un SQL Server prenant
en charge la haute disponibilité et les clusters de
basculement. Uoption Utiliser la haute disponibilité
active la propriété de connexion
MultiSubnetFailover dans la chaine de connexion.
Pour plus d'informations sur cette propriété,
reportez-vous au site Web de Microsoft.
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Parameétre Description

Base de données Nom de la base de données dans le Pool SQL dédié

Azure ou se trouvent les tables.

Schéma Schéma SQL associé aux tables dans lesquelles les

données sont stockées.

3. Cliguez sur Connect.

4. Sélectionnez la base de données dans la liste Base de données.

5. Cliquez sur Enregistrer les modifications.

Autorisez les utilisateurs a accéder a la cible Pool SQL dédié Azure. Pour plus d’informations, voir Autoriser
['acces aux cibles.

Configurer la cible Google BigQuery

Suivez la procédure ci-dessous pour configurer la cible Google BigQuery et vérifiez que vous pouvez écrire dans
la ressource Google BigQuery.

1.

Dans la console Google Cloud, sous IAM, accordez au compte de service GCP les autorisations minimum
suivantes sur le projet :

Remarque : Pour plus d’informations sur les roles et autorisations Google 1AM, voir
https://cloud.google.com/iam/docs/understanding-roles et https://cloud.google.com/iam/docs/creating-
custom-roles.

bigquery.datasets.create
bigquery.datasets.get
bigquery.datasets.update
bigquery.tables.create
bigquery.tables.list
bigquery.tables.delete
bigquery.tables.get
bigquery.tables.update
bigquery.tables.updateData
bigquery.jobs.create

Vous pouvez également attribuer au compte de service GCP les roles roles/bigquery.dataOwner et roles/
bigquery.jobUser qui incluent les autorisations minimum.

Créez la cible Google BigQuery avant de la configurer. Pour plus d’informations, voir Ajouter une cible de
publication.

A la page Administration, cliquez sur |'onglet Cibles. Ensuite, sélectionnez la cible dans Ia liste Cibles de
publication.

Remarque : Si vous avez déja sélectionné votre cible, passez a |'étape suivante.
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2. Reportez-vous au tableau suivant et saisissez les informations requises. Cliquez sur les boutons lorsqu'ils sont

activés.

Parametre Description

Fichier de clé de compte de service GCP Fichier JSON contenant les informations
d'identification du compte de service GCP.

ID de projet BigQuery ID unique de votre projet BigQuery dans
Google Cloud Platform (GCP).

Jeu de données BigQuery Conteneur de niveau supérieur organisant et
controlant I'accés aux tableaux et vues. Le jeu de
données est contenu dans un projet et doit étre
créé pour pouvoir diffuser des données en continu
dans BigQuery.

Taille de page de chargement (Facultatif) Nombre de lignes chargées dans une
insertion en bloc. La valeur par défaut de 500 est la
taille recommandée.

3. Cliquez sur Vérifier GCP BigQuery Writer.
4. Cliquez sur Enregistrer les modifications.

5. Autorisez les utilisateurs a accéder a la cible Google BigQuery. Pour plus d’informations, voir Autoriser |'accés
aux cibles.

Remarque : Aucun enregistrement sur une instance Google BigQuery ne peut étre modifié dans les

90 minutes suivant son écriture ou sa mise a jour. Pour que le service Pl Integrator Sync continue a se
comporter comme prévu (sans rencontrer cette limite sur les vues lors de I'écriture dans BigQuery), il est
recommandé que AFMonitorUpdateFrequency soit réglé dans %PIHOME64%\Integrators\BA\
CAST.UL.WindowsService.exe.config sur 120 minutes comme suit : <add
key="AFMonitorDataUpdateFrequency" value="120"/>.

La mémoire tampon de temps supplémentaire (configuration de 120 min. contre limitation de 90 min.) vise a
fournir une fenétre suffisante pour que Google BigQuery puisse vider la mémoire tampon de diffusion en
continu. Sans cette mémoire tampon, vous pourriez accidentellement atteindre la limite en réglant
AFMonitorUpdateFrequency sur la méme valeur de temps que la limite (90 minutes). Si la mémoire tampon est
réglée correctement, le message suivant s’affichera au démarrage de I'application :
UnifiedAppConfig:AFMonitorDataUpdateFrequency: Successfully parsed (analysé avec
succes).
Valeur AFMonitorDataUpdateFrequency de ’finalAppConfigFilePath’.
Utilisation de la valeur AFMonitorDataUpdateFrequency, ’120° (minutes).

Si la mémoire tampon n’est pas réglée correctement et que la limite est atteinte, soit en cliquant sur Mettre a
jour les données dans l'interface utilisateur, soit en étant déclenchée par le service Pl Integrator Sync si
AFMonitorUpdateFrequency n’a pas été réglé correctement, le message d’erreur suivant s’affiche :

L’ opération UpdateData a été arrétée en raison de la restriction PublishTarget (EndTime
maximum*-90min) .

Ce PublishTarget, Gcp MondeQuery Tous les fichiers, ne prend pas en charge la
suppression/mise a jour des lignes de données qui ont été modifiées au cours des 90
derniéres minutes.

Résultat : aucune donnée n’a été modifiée sur PublishTarget.
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Configurer la cible Google Cloud Storage

Suivez la procédure ci-dessous pour configurer la cible Google Cloud Storage et vérifiez que vous pouvez écrire
dans le conteneur Google Cloud Storage.

Remarque : Pour plus d’informations sur les réles et autorisations Google IAM, voir https://cloud.google.com/
iam/docs/understanding-roles et https://cloud.google.com/iam/docs/creating-custom-roles.

¢ Dans la console Google Cloud, sous IAM, accordez au compte de service GCP |'accés au projet
Google Cloud Storage. Les autorisations minimum sont les suivantes :

e storage.buckets.get
e storage.buckets.list
e storage.objects.create
e storage.objects.get
e storage.objects.delete

¢ \ous pouvez également attribuer au compte de service GCP le rdle roles/storage.admin qui inclut les
autorisations minimum.

¢ Si BigQuery est configuré, le compte de service GCP nécessite les autorisations supplémentaires suivantes :
e bigquery.datasets.create
e bigquery.datasets.get
e bigquery.tables.create
e bigquery.tables.list
e bigquery.tables.delete

¢ \ous pouvez également attribuer au compte de service GCP le rdle roles/bigquery.dataOwner qui inclut les
autorisations minimum.

¢ Créez la cible Google Cloud Storage avant de la configurer. Pour plus d’informations, voir Ajouter une cible de
publication.

1. A la page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez la cible dans la liste Cibles de
publication.

Remarque : Si vous avez déja sélectionné votre cible, passez a |'étape suivante.

2. Reportez-vous au tableau suivant et saisissez les informations requises. Cliquez sur les boutons lorsqu'ils sont
activés.

Parametre Description

Format de stockage des données Format de fichier dans lequel les données sont
stockées. Par défaut : Parquet. Les autres options
sont JSON, Indentation JSON et Texte. Si BigQuery
est utilisé, la seule option prise en charge est Alors
Text.

Compression Type de compression sur des jeux de messages. Par
défaut : Aucune. Les autres options sont les
suivantes : Gzip et Snappy.
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Fichier de clé de compte de service GCP

Fichier JSON contenant les informations
d'identification du compte de service
Google Cloud Platform (GCP).

ID de projet BigQuery

(Facultatif) ID unique de votre projet BigQuery dans
GCP.

Inclure I'en-téte

(Facultatif) Si sélectionné, des noms de colonne sont
ajoutés au début du fichier.

Délimiteur de champ

(Facultatif) Caractére(s) séparant les champs de
données dans les lignes. Par défaut tabulation, une
tabulation (\t) sépare les champs

Délimiteur de ligne

(Facultatif) Caractere(s) séparant les lignes de
données. Par défaut, une nouvelle ligne sépare les
lignes de données. Les caracteres spécifiant une
nouvelle ligne sont spécifiques a la plateforme. La
valeur par défaut fournit automatiquement les
caractéres appropriés a I'environnement.

Nom du conteneur

Conteneur Google Cloud Storage dans lequel des
données sont chargées.

Chemin d'acces au dossier

(Facultatif) Chemin d'accés au dossier
Google Cloud Storage. Il s'agit par défaut de la
racine du conteneur spécifié.

Autoriser les valeurs nulles

Si cette option est sélectionnée, les valeurs NULL
sont valides Par défaut : les valeurs nulles sont
autorisées.

Lignes/objets maximum

(Facultatif) Nombre d'objets maximum dans un
fichier. Par défaut : 100 000 lignes.

Taille de fichier maximale (Ko)

(Facultatif) Taille de fichier maximale en kilo-octets.
Par défaut : 10 000 Ko.

Durée de mise a jour maximale (sec)

(Facultatif) Durée maximale de mise a jour, en
secondes, avant |'expiration du dispositif d'écriture.
Par défaut : 86 400 secondes (1 jour).

Jeu de données BigQuery

(Facultatif) Conteneur de niveau supérieur
organisant et controlant I'accés aux tableaux et
vues. Le jeu de données est contenu dans un projet
et doit étre créé pour pouvoir diffuser des données
en continu dans BigQuery.

3. Cliquez sur Vérifier GCP Storage Writer.

4. Cliquez sur Enregistrer les modifications.
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5. Autorisez les utilisateurs a accéder a la cible Google Cloud Storage. Pour plus d’informations, voir Autoriser
I'acces aux cibles.

Configurer la cible Google Cloud Pub/Sub

Suivez la procédure ci-dessous pour configurer la cible Google Cloud Pub/Sub et vérifiez que vous pouvez écrire
dans la ressource Google Cloud Pub/Sub.

Remarque : Pour plus d’informations sur les réles et autorisations Google IAM, voir https://cloud.google.com/
iam/docs/understanding-roles et https://cloud.google.com/iam/docs/creating-custom-roles.

¢ Dans la console Google Cloud, sous IAM, accordez au compte de service GCP |'accés au projet Pub/Sub. Les
autorisations minimum sur le projet sont les suivantes :

e pubsub.topics.list
e pubsub.topics.publish
e pubsub.topics.get
e pubsub.topics.create

¢ \ous pouvez également attribuer au compte de service GCP le rdle roles/pubsub.editor qui inclut les
autorisations minimum.

e Créez la cible Google Cloud Pub/Sub avant de la configurer. Pour plus d'informations, voir Ajouter une cible
de publication.

1. A la page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez la cible dans la liste Cibles de
publication.

Remarque : Si vous avez déja sélectionné votre cible, passez a |'étape suivante.

2. Reportez-vous au tableau suivant et saisissez les informations requises. Cliquez sur les boutons lorsqu'ils sont

activés.

Parameétre Description

Fichier de clé de compte de service GCP Fichier JSON contenant les informations
d'identification du compte de service GCP.

ID de projet ID unique du projet Pub/Sub dans la console GCP.

Codage de caractéres Jeu de caractéres dans lequel les données sont
codées Par défaut : UTF-8. Les autres options sont
les suivantes : ASCII, UTF-7, UTF-32 et Unicode.

Compression (Facultatif) Type de compression sur des jeux de
messages. Par défaut : Aucune. Les autres options
sont les suivantes : Gzip et Snappy.

Cliquez sur Vérifier le dispositif d'écriture.
4. Cliquez sur Enregistrer les modifications.

Autorisez les utilisateurs a accéder a la cible Google Cloud Pub/Sub. Pour plus d'informations, voir Autoriser
['accés aux cibles.
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Configurer la cible du systeme de fichiers distribués Hadoop (HDFS)

Suivez la procédure ci-dessous pour configurer la cible du systéme de fichiers distribués Hadoop et vérifiez que le

dispositif d'écriture HDFS fonctionne correctement.

Créez la cible du systéme de fichiers distribués Hadoop avant de la configurer. Pour plus d'informations, voir

Ajouter une cible de publication.

1. A la page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez la cible dans la liste Cibles de

publication.

Remarque : Si vous avez déja sélectionné votre cible, passez a |'étape suivante.

2. Configurez la cible du systeme de fichiers distribués Hadoop avec les parametres suivants :

Parameétre

Description

HDFS URL

URL pour accéder a HDFS directement via WebHDFS
ou via la passerelle Apache Knox ou HttpFS.

Exemples :
HDFS — http://host:50070/webhdfs/v1
HttpFS — http://host:14000/webhdfs/v1

Apache Knox — https://host:8443/gateway/default/
webhdfs/v1

Vérifier le certificat SSL/TLS

Cochez la case si vous utilisez un certificat SSL.
Décochez la case si vous utilisez un certificat auto-
signé.

Nom d’utilisateur

Nom d'utilisateur utilisé pour la connexion au
systeme de fichiers distribués Hadoop. L'utilisateur
doit étre autorisé a lire et a écrire sur le systeme de
fichiers distribués Hadoop.

Mot de passe

(Facultatif) Mot de passe pour authentifier
['utilisateur. Il est utilisé lors de la connexion a
Apache Knox ou a HttpFS si la sécurité est activée. Si
un mot de passe est fourni, I'authentification
Hadoop HTTP est utilisée. Si aucun mot de passe
n'est fourni, utilise alors I'authentification Hadoop
simple.

Répertoire

Répertoire dans lequel les fichiers de données sont
créés. Cliquez sur Parcourir pour accéder au
répertoire dans lequel vous souhaitez stocker les
fichiers.

Ajouter un horodatage

Si sélectionné, un horodatage de la publication de la
vue est ajouté au nom du fichier, et un nouveau
fichier est créé chaque fois que la vue est publiée.
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Parameétre Description

Sinon, les données sont ajoutées au fichier existant.

Inclure l'en-téte Si sélectionné, des noms de colonne sont ajoutés au
début du fichier.

3. Cliquez sur Vérifier le dispositif d'écriture HDFS pour vous assurer que le dispositif d'écriture HDFS peut se
connecter au systeme de fichiers distribués Hadoop et le modifier en écriture.

Remarque : si vous ne parvenez pas a écrire sur le systéme de fichiers distribué Hadoop (HDFS), consultez
Conseils pour configurer les systemes de fichiers distribués Hadoop (HDFS)..

4. Cliquez sur Enregistrer les modifications.

Autorisez les utilisateurs a accéder a la cible du systeme de fichiers distribués Hadoop. Pour plus
d'informations, voir Autoriser I'acces aux cibles.

Conseils pour configurer les systemes de fichiers distribués Hadoop (HDFS).

Pour que le systeme de fichiers distribués Hadoop puisse fonctionner correctement avec Pl Integrator for
Business Analytics, effectuez les taches suivantes :

e Créez |'utilisateur HDFS.

e Créez le répertoire d'utilisateur et accordez les autorisations.
La procédure suivante décrit comment effectuer ces taches.

1. Créez I'utilisateur HDFS.
a. Créez l'utilisateur HDFS sur le nceud sur lequel WebHDFS est installé.

b. Ajoutez I'utilisateur HDFS a un groupe.

Remarque : L'utilisateur HDFS peut étre ajouté a n'importe quel groupe. Toutefois, dans le cadre de cet
exemple, le groupe s'appellera groupe HDFS.

2. Créez le répertoire et accordez les autorisations
a. Créez un répertoire sur HDFS.
b. Définissez |'utilisateur HDFS comme propriétaire de ce répertoire.

Définissez le groupe HDFS comme groupe du répertoire.

o

Accordez les autorisations de lecture et d'écriture au propriétaire du répertoire (donc a I'utilisateur
HDFS).

e. Accordez les autorisations de lecture et d'écriture au groupe auquel le répertoire appartient.

Configurer la cible Microsoft SQL Server

Suivez la procédure ci-dessous pour configurer la cible Microsoft SQL Server et vérifier votre connexion a la base
de données.

Créez la cible Microsoft SQL Server avant de la configurer. Pour plus d’informations, voir Ajouter une cible de
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Remarque : Vérifiez que le compte de service qui exécute le service Pl Integrator Framework (ou I'utilisateur SQL
si vous utilisez I'authentification SQL) dispose des autorisations suivantes sur le serveur Microsoft SQL Server :

Niveau serveur — CONNECT SQL, VIEW ANY DATABASE

Niveau base de données — CONNECT, CREATE TABLE

Tous les schémas, y compris le schéma dbo — SELECT, ALTER, INSERT, DELETE

1. A la page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez la cible dans la liste Cibles de

publication.

Remarque : Si vous avez déja sélectionné votre cible, passez a I'étape suivante.

2. Configurez la cible Microsoft SQL Server avec les parametres suivants :

Parameétre

Description

Nom d'hote

Nom d’hoéte et instance (Hostname\lnstance) de la
machine sur laquelle SQL Server est exécuté.

Nom d'utilisateur d'authentification SQL

Mot de passe utilisé pour se connecter a SQL Server
(Ne le spécifiez que si vous utilisez I'authentification
SQL Server. Si vous utilisez la sécurité intégrée a
Windows, le compte de service est utilisé.)

Mot de passe d'authentification SQL

Mot de passe utilisé pour se connecter a SQL Server
(Ne le spécifiez que si vous utilisez I'authentification
SQL Server. Si vous utilisez la sécurité intégrée a
Windows, le compte de service est utilisé.)

Expiration de la publication

Temps alloué a la publication des données sur la
cible avant expiration du PI Integrator Framework.
La valeur par défaut est de 30 secondes.

Utiliser la haute disponibilité

(Facultatif) Connectez-vous a un SQL Server prenant
en charge la haute disponibilité et les clusters de
basculement. Loption Utiliser la haute disponibilité
active la propriété de connexion
MultiSubnetFailover dans la chaine de connexion.
Pour plus d'informations sur cette propriété,
reportez-vous au site Web de Microsoft.

Base de données

Nom de la base de données SQL Server dans
laquelle se trouvent les tables.

Schéma

Schéma SQL associé aux tables dans lesquelles les
données sont stockées.

3. Cliquez sur Se connecter pour vérifier la connexion a la base de données SQL.

4. Cliquez sur Enregistrer les modifications.

5. Autorisez les utilisateurs a accéder a la cible Microsoft SQL Server. Pour plus d’informations, voir Autoriser
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['acces aux cibles.

Configurer la cible de publication de la base de données Oracle

Suivez la procédure pour configurer la cible de publication de la base de données Oracle.

1.

5.

Installez les composants d'accés de la base de données Oracle. Pour plus d'informations, voir Installer Oracle
Database Access Components.

Ajoutez la cible de publication a Pl Integrator for Business Analytics. Voir Ajouter une cible de publication.

Configurez la cible de publication de la base de données Oracle. Pour plus d'informations, voir Configurer la
cible Oracle.

Donnez a l'utilisateur Oracle que vous saisissez dans la configuration de la cible de publication de PI
Integrator for Business Analytics les autorisations Oracle minimum suivantes :

e Privileges systéme : CREATE SESSION, CREATE TABLE, DELETE TABLE
¢ Privileges espace de table — Quota suffisant pour créer des tables

Autorisez les utilisateurs a accéder a la cible de publication. Voir Autoriser I'acces aux cibles.

Installer Oracle Database Access Components

Remarque : Cette étape est facultative. Oracle Database Access Components (ODAC) est obligatoire uniquement
si vous publiez sur la base de données Oracle.

Suivez cette procédure avant d'ajouter et de configurer la base de données Oracle en tant que cible de
publication.

1.

Installez Oracle Database Access Components sur I'ordinateur sur lequel Pl Integrator for Business Analytics
est installé.

Remarque : Consultez Configuration systeme requise pour trouver la version d'ODAC a installer.

Cherchez le fichier tnsnames.ora dans \ODAC_install_directory\Network\Admin\Sample.
Modifiez le fichier tnsnames.ora et ajoutez une entrée pour la base de données Oracle.

La syntaxe est la suivante :

Net_Service Name =

(DESCRIPTION=

(ADDRESS=(PROTOCOL=protocol _name) (HOST=Oracle database_host_name) (PORT=port)

(CONNECT_DATA=

(SERVER=service_handler_type)

(SERVICE_NAME=(TNS_listener_service name)
Net_Service_Name est |'alias pour SERVICE_NAME. Lors de la configuration de la cible de publication Oracle,
vous pouvez définir le paraméetre Data Source sur le Net_Service_Name. Pour en savoir plus sur le fichier
tnsnames.ora, reportez-vous a la documentation d'Oracle.

Déplacez le fichier tnsnames.ora vers le répertoire \ODAC_install_directory\Network\Admin.
Ajoutez I'emplacement d'ODAC a la variable d'environnement PATH.

Créez la variable d'environnement systéme TNS_ADMIN et dirigez-la vers I'emplacement du fichier
tnsnames.ora.
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7. Ensuite, ajoutez la base de données Oracle en tant que cible de publication. Pour plus d'informations, voir
Ajouter une cible de publication.

Configurer la cible Oracle

Suivez la procédure ci-dessous pour configurer la cible Oracle et vérifier votre connexion a la base de données
Oracle.

¢ Installez les composants d'acces de la base de données Oracle.
Voir Installer Oracle Database Access Components.

e Créez la cible Oracle. Pour plus d'informations, voir Ajouter une cible de publication.

1. Ala page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez la cible dans la liste Cibles de
publication.

Remarque : Si vous avez déja sélectionné votre cible, passez a I'étape suivante.

2. Configurez la cible Oracle avec les paramétres suivants :

Parametre Description

Source de données Nom Oracle Net Services, descripteur de connexion,
ou alias d'identification de |la base de données
Oracle

Remarque : voir Installer Oracle Database Access
Components pour en savoir plus sur la méthode de
spécification du nom Oracle Net Services.

Nom d’utilisateur Mot de passe utilisé pour la connexion a la base de
données Oracle

Mot de passe Mot de passe utilisé pour la connexion a la base de
données Oracle

Cliquez sur Se connecter pour vérifier la connexion a la base de données.
4. Cliquez sur Enregistrer les modifications.

Autorisez les utilisateurs a accéder a la cible Oracle. Pour plus d'informations, voir Autoriser |'accés aux
cibles.

Configurer la cible de publication ODBC SAP® HANA®

Installez le serveur SAP HANA et le client de base de données SAP HANA.

Créez la cible ODBC SAP HANA avant de la configurer. Pour plus d'informations, voir Ajouter une cible de
publication.

Vérifiez les autorisations suivantes pour la cible ODBC SAP HANA :

¢ Dans SAP HANA, I'accés ODBC aux données SAP HANA est activé par défaut pour tous les utilisateurs. Vous
pouvez limiter I'accés en désactivant I'acces ODBC dans SAP HANA. Cependant, assurez-vous que |'utilisateur
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SAP HANA que vous saisissez dans la configuration de la cible de publication de Pl Integrator for Business
Analytics dispose des autorisations d’acces suivantes :

e Sélectionnez l'autorisation nécessaire dans SYS.SCHEMAS, SYS.TABLES et SYS.TABLE_ COLUMNS.

¢ Les autorisations suivantes sont requises sur les schémas dans lesquels des tableaux seront créés :
e ALTER

e CREATE ANY

e DELETE

e DROP

e EXECUTE

* |nser

e SELECTIONNEZ

e UPDATE

1. Configurez la cible ODBC SAP HANA avec les paramétres suivants :

Parametre Description
Nom d'hote Nom d'héte ou adresse IP du serveur SAP HANA.
Port Numéro de port utilisé pour la connexion a

I'instance SAP HANA.

Nom d’utilisateur Mot de passe utilisé pour la connexion a l'instance
SAP HANA.

Password Mot de passe utilisé pour la connexion a l'instance
SAP HANA.

Base de données Si l'instance comporte plusieurs bases de données,

la base de données a laquelle se connecter
(facultatif).

Utiliser le connecteur TLS/SSL Utiliser SSL pour la connexion au serveur SAP HANA.

Remarque : Seuls les certificats stockés dans le
certificat SAP HANA sont pris en charge.

2. Cliquez sur Obtenir des schémas pour renseigner la liste des schémas.

Sélectionnez dans la liste le schéma sur lequel les tableaux sont inscrits.

Remarque : Si la liste est vide, un ou plusieurs parametres sont incorrects.

4. Cliquez sur Connecter pour vérifier que vous pouvez ouvrir la connexion ODBC avec SAP HANA.

Cliquez sur Enregistrer les modifications.

Autorisez les utilisateurs a accéder a la cible SAP HANA. Pour plus d'informations, voir Autoriser |'accés aux
cibles.
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Configurer la cible fichier texte

Suivez la procédure ci-dessous pour configurer la cible fichier texte.

Créez la cible fichier texte avant de la configurer. Pour plus d’informations, voir Ajouter une cible de publication.

1. A la page Administration, cliquez sur I'onglet Cibles. Ensuite, sélectionnez la cible dans la liste Cibles de
publication.

Remarque : Si vous avez déja sélectionné votre cible, passez a I'étape suivante.

2. Configurez la cible fichier texte avec les parametres suivants :

Parameétre Description
Répertoire Répertoire dans lequel le fichier texte est créé.
Ajouter un horodatage Si sélectionné, un horodatage de la publication de la

vue est ajouté au nom du fichier, et un nouveau
fichier est créé chaque fois que la vue est publiée.
Sinon, les données sont ajoutées au fichier existant.

Inclure I'en-téte Si sélectionné, des noms de colonne sont ajoutés au
début du fichier.
Délimiteur de champ Caractére(s) séparant les valeurs de données dans

un fichier de sortie. Par défaut, il s'agit d'un espace
a onglets. Pour choisir un délimiteur d’onglet, laissez
le champ vide ou saisissez \t.

Remarque : N'utilisez pas de caractére qui apparait
dans vos données (par exemple, un point). La
période pendant laquelle vos données seront
supprimées avant d'étre écrites dans le fichier.

Extension de fichier Extension de fichiers de sortie. La valeur par défaut
est .txt.

Remarque : A partir de Pl Integrator for Business
Analytics 2020 R2 SP2, les extensions de cibles
fichier texte sont limitées a .csv et .txt. Pour les
cibles ayant été configurées avec des extensions
différentes avant la mise a niveau vers 2020 R2 SP2,
I'extension continuera de fonctionner pour la cible
préconfigurée.

Si la cible préconfigurée est modifiée et que
I'extension est remplacée par .csv ou .txt, I'extension
précédemment enregistrée ne sera plus disponible.

3. Cliquez sur Enregistrer les modifications.

4. Autorisez les utilisateurs a accéder a la cible fichier texte. Pour plus d’informations, voir Autoriser |'acces aux
cibles.
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Autoriser I'acces aux cibles

La procédure suivante décrit comment accorder aux utilisateurs 'autorisation de publier leurs données sur une
cible de publication.

Cliquez sur l'icbne du menu E, puis cliquez sur Administration.

1.

2. Cliquez sur I'onglet Cibles.

3. Ensuite, cliquez sur la cible dans la liste Cibles de publication.

4. Pour autoriser l'acces a la cible de publication sélectionnée, cliquez sur Add Identity (Ajouter une identité)
dans le volet Target Access (Acces a la cible).

5. Sélectionnez l'identité et cliquez sur OK.

Cliquez sur Enregistrer les modifications.

Migrer la cible de vue Pl vers la cible Microsoft SQL Server

A partir de Pl Integrator for Business Analytics 2020 R2 SP2, la cible de vue Pl est obsoléte et toutes les vues
existantes utilisant la cible de vue Pl ne pourront plus étre publiées. La cible de vue PI n’est plus accessible dans
la liste Cibles de publication de I'onglet Cibles a la page Administration. La procédure suivante décrit comment
migrer une vue utilisant la cible de publication de vue Pl vers une cible de publication Microsoft SQL Server
comme alternative.

Remarque : Si vous n’avez plus besoin de publier la vue existante sur la cible de vue P, il est recommandé de la

supprimer a I'aide du bouton Supprimer la vue. Les tables de données et de métadonnées de la vue seront ainsi
supprimées de la base de données SQL PlintegratorDB dans SQL Server. Ne procédez ainsi qu’a condition d’avoir
déja migré votre vue vers une cible Microsoft SQL Server ou si vous avez décidé que la vue peut étre supprimée.

1. Siaucune cible de publication Microsoft SQL Server n’est configurée, voir Configurer la cible
Microsoft SQL Server.

2. Pour créer une copie de la vue a l'aide de la cible de publication de vue PI, sélectionnez-la a la page Mes
Vues et cliquez sur Modifier la vue.

3. Vérifiez que la vue copiée posséde la configuration souhaitée dans les pages Sélectionner les données et
Modifier la vue.

4. Une fois que vous étes prét a publier, accédez a la page Publier.
Cliquez sur la liste Configuration de la cible et sélectionnez la cible Microsoft SQL Server que vous avez créée
a I'étape 1.

6. Sélectionnez le Mode d’exécution et I'Heure de publication souhaités. Si vous avez sélectionné I'option
Exécuter selon une planification, spécifiez la fréquence de publication pour les exécutions suivantes.

7. Cligquez sur Publier pour publier la vue.
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Taches d'administration

Vous pouvez effectuer plusieurs taches d'administration sur votre systéme , y compris des vues de sécurité pour
des utilisateurs spécifiques, sécuriser I'accés a avec la délégation contrainte Kerberos, et restaurer des flux de

sortie.

A propos du groupe de service de Pl Integrators

Lors de I'installation de Pl Integrator, le groupe Windows du groupe de service de Pl Integrators est créé, et le
compte de service Windows ou les comptes virtuels spécifiés pour exécuter le service Pl Integrator Framework
sont ajoutés a ce groupe. Le groupe de service de Pl Integrators attribue au compte de service Windows ou aux
comptes virtuels les privileges minimum requis pour exécuter le service Pl Integrator Framework. Par
conséquent, nous vous conseillons de ne pas ajouter le compte de service Windows ou les comptes virtuels au
groupe d’administrateurs local sur la machine ou PI Integrator est installé.

Supprimer des serveurs et bases de données Pl AF

Vous pouvez supprimer les serveurs Pl AF que vous ne souhaitez plus utiliser dans vos vues.

Cliquez sur l'icbne du menu E, puis cliquez sur Administration.
2. Dans la page Administration, cliquez sur I'onglet AF Databases.

Sélectionnez le serveur Pl AF que vous souhaitez supprimer dans la liste Serveurs AF.

Remarque : Les bases de données sur le serveur sélectionné s'affichent dans la liste Bases de données AF, a
coté de la liste Serveurs AF.

4. Cliquez sur Supprimer le serveur AF pour supprimer le serveur Pl AF sélectionné, ainsi que ses bases de
données, dans la liste des serveurs et des bases de données disponibles.

Le serveur Pl AF n'apparait plus dans la liste Serveurs AF.

Modifier une cible de publication

Le chapitre suivant vous expliquera comment modifier les parametres de configuration pour la cible de
publication.

Remarque : Lorsque vous modifiez la configuration d'une cible, les modifications s'appliquent a toutes les vues
publiées par la suite sur cette cible. Par la suite, les vues planifiées et les vues de diffusion déja en cours
appliqueront la nouvelle configuration de cible lors de I'analyse suivante.

1. Cliquez surl'icone du menu E, puis cliquez sur Administration.
2. Ala page Administration, cliquez sur I'onglet Cibles.

La page Configuration de la cible de publication apparait.
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3. Sélectionnez une cible de publication dans la liste Cibles de publication.

Le volet Configuration de la cible apparatt.
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Remarque : Chaque type de cible de publication posséde un ensemble de paramétres de configuration
unique.

4. Modifiez les parameétres dans le volet Configuration de la cible.

Cliquez sur le lien de votre cible de publication pour afficher une description des parameétres de
configuration :

Configurer la cible de flux de données Amazon Kinesis
Configurer la cible Amazon Redshift

Configurer la cible Amazon S3

Configurer la cible Apache Hive

Configurer la cible Apache Kafka

Configurer la cible Azure Data Lake Storage Gen 2
Configurer la cible Azure Event Hubs

Configurer la cible Azure loT Hub

Configurer la cible Azure SQL Database

Configurer la cible Pool SQL dédié Azure

Configurer la cible Google BigQuery

Configurer la cible Google Cloud Storage

Configurer la cible Google Cloud Pub/Sub

Configurer la cible du systeme de fichiers distribués Hadoop (HDFS)
Configurer la cible Microsoft SQL Server

Configurer la cible Oracle

Configurer la cible fichier texte

5. Cliquez sur Enregistrer les modifications.

Supprimer une cible de publication

Cliquez sur l'icbne du menu E, puis cliquez sur Administration.

2. Ala page Administration, cliquez sur I'onglet Cibles.

La page Configuration de la cible de publication apparait.

Sélectionnez la cible de publication que vous souhaitez supprimer dans la liste Cibles de publication.

4. Cliquez sur Supprimer la cible de publication.

Vérifiez que la cible de publication n'apparait plus dans la liste Cibles de publication.

Ajouter un registre de schémas

Remarque : Cette fonctionnalité est disponible dans Pl Integrator for Business Analytics Edition Advanced.
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Cette version prend en charge le registre de schémas Confluent. Seuls les schémas Avro sont pris en charge.

Cliquez sur l'icone du menu E, puis cliquez sur Administration.

Cliquez sur I'onglet Navigateur de registre de schémas.

Dans le volet Ajouter un registre de schémas, entez un nom et I'URL du registre.
L'URL doit étre précédée de http:// ou https://.

Cliquez sur Ajouter un registre de schémas.

Le volet Schémas disponibles indique les schémas dans le registre. Le volet Apercu du schéma affiche les
paires nom-valeur du schéma sélectionné.

Ajouter un schéma au registre de schémas

vk wnN R

Cliquez sur l'icone du menu E, puis cliquez sur Administration.

Cliquez sur I'onglet Navigateur de registre de schémas.

Sélectionnez le registre dans le volet Registres de schémas.

Dans la section Ajouter ou mettre a jour des schémas, cliquez sur Sélectionner un fichier de schéma.

Dans la fenétre Ouvrir, recherchez le fichier de schémas, sélectionnez-le, puis cliquez sur Ouvrir.

Remarque : Seuls les fichiers de schémas Avro sont pris en charge.

Le nom du schéma s'affiche dans le volet Schémas disponibles et la structure du schéma dans le volet Apercu
du schéma.

Gérer les vues

En tant gu'administrateur, vous pouvez effectuer les actions suivantes sur les vues :

Importer et exporter des vues
Supprimer des vues
Ajouter des utilisateurs a des vues

Supprimer des utilisateurs de vues

Gérer l'acces a une seule vue

Vous pouvez gérer |'acces a une seule vue :

¢ Vous pouvez ajouter des identités a ou supprimer des identités d'une seule vue.

¢ Vous pouvez modifier les autorisations d'une identité.

Pour obtenir des informations sur la gestion de I'acces a plus d'une vue simultanément, voir Gérer |'accées a
plusieurs vues.
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Cliquez sur l'icone du menu E, puis cliquez sur Administration.
2. Cliquez sur I'onglet Vues.
3. Cochez la case pour sélectionner une vue.

Le volet Détails affiche I'étiquette Accés aux vues. L'acces a chaque identité peut étre modifié. Voir
Autorisations d’acces utilisateur pour plus d’informations.

Remarque : si le paramétre de sécurité d’usurpation d’identité est activé, les identités d’accés aux données
seront également affichées.

Views Details
Name Run Status Type Run Mode Start Time End Time Last Run Time = View Name
E Boiler View ibishe Assal Once B . A2 T:38 PM Boller View
a Comgressor . Pubished Assel Onoe *8h . VA2 7:39 PM View Access 0
L Adiiswator Owner
j per—

Add
Data Access @
A Administrators A Engineers

A Pl Integrator Service A Assat Analytics

Import ard Export

Delete

Remove Selected View

4. Effectuez |'une des actions suivantes :

a. Cliguez sur la fleche en regard des autorisations et sélectionnez dans la liste pour modifier les
autorisations de I'identité.

b. Cliquez sur Ajouter et suivez les invites pour accorder a l'identité spécifiée 'accés a la vue.

c. Sélectionnez une identité et cliquez sur Supprimer pour supprimer l'acces a la vue de l'identité.

Gérer I'acces a plusieurs vues

Vous pouvez sélectionner plusieurs vues simultanément et leur ajouter des identités.

Remarque : Vous ne pouvez pas supprimer des identités de plusieurs vues. Vous ne pouvez supprimer des
identités que d'une seule vue a la fois.

L'autorisation Propriétaire est accordée par défaut aux identités ajoutées a des vues.

Il existe cependant une exception si une identité est déja associée a une vue. Si la vue fait partie des vues
sélectionnées et que la méme identité lui est déja associée, elle conserve les autorisations définies
précédemment. Par exemple, l'identité Ingénieurs est associée a la Vue ABC et |'autorisation Lecteur est
accordée a la vue. La Vue ABC est ensuite sélectionnée avec d'autres vues, et |'identité Ingénieurs est associée a
toutes les vues. Dans ce cas, l'identité Ingénieurs pour la Vue ABC conserve son autorisation existante, a savoir
Lecteur. L'autorisation Propriétaire par défaut est associée a toutes les autres vues pour l'identité Ingénieurs.

Si un noeud est hors service, le Gestionnaire de clusters réaffecte toutes les taches qui lui étaient associées aux
nceuds Travailleur restants. Le noeud Travailleur hors ligne est automatiquement redémarré par le Service Pl
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Integrator Framework. Une fois redémarré, les taches existantes ne sont pas rééquilibrées pour inclure le nceud
Travailleur redémarré. Les nouvelles taches le sont toutefois entre tous les noeuds opérationnels. Si cela entraine
une distribution inégale des taches, vous pouvez les rééquilibrer manuellement.

1. Cliquez surl'icéne du menu E, puis cliquez sur Administration.
2. Cliquez sur I'onglet Vues.

3. Cliquez sur la colonne de gauche des vues que vous souhaitez sélectionner.

Views Details
Name Run Status Type Run Mode Start Time End Time Last Run Time View Name
@ Boller View Publishec Assal Once 8 . 9/8/22 7:38 PM Multiple Views Selected
B Compressor Publishec Once 8 . 0/B/22 7:39 PM

View Access ©

Data Access @

Multiple Views Selected

Import and Export

Delete

Remove Selected Views

4. Cliquez sur Ajouter des identités aux vues sélectionnées sous I'étiquette Acces aux vues.

Remarque : si le parameétre de sécurité d’usurpation d’identité est activé, les identités d’accés aux données
seront également affichées.

5. Dans la fenétre Ajouter une identité, sélectionnez les identités que vous souhaitez ajouter, puis cliquez sur
OK.

Remarque : si le parameétre de sécurité de I'usurpation d’identité de I'application est activé, I'acces aux
données s’affichera également avec une note indiquant « Plusieurs vues sélectionnées » au lieu des
identités.

Déplacement de vues entre des environnements

Dans certains navigateurs, le protocole par défaut utilisé est Web Sockets, dont la taille de paquet de données
est limitée a 64 K. Vous devez définir le type de transport sur Evénements serveur envoyés pour pouvoir traiter
les tailles de paquets supérieures envoyées lors de I'importation et de I'exportation de vues. Sur la page Mes

vues, cliquez sur l'icone en forme d'engrenage E dans le coin supérieur droit et définissez Type de transport
sur Evénements serveur envoyés. Ceci doit s'appliquer aux navigateurs Microsoft Edge uniquement.

Lors du développement de vos vues, vous les créez probablement dans un environnement, vérifiez qu'elles
produisent les résultats souhaités dans un environnement de test, pour enfin les déplacer dans votre systeme de
production. Utilisez PI Integrator for Business Analytics pour déplacer les vues entre ces environnements, en les
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exportant d’un systéme et en les important dans un autre. Vous pouvez exporter des vues individuellement ou
globalement dans un fichier de configuration des vues.

La procédure suivante suppose que vous exportiez des vues d'un premier systeme et les importiez dans un
second.

Cliquez sur l'icbne du menu E, puis cliquez sur Administration.
2. Dans la page Administration, cliquez sur I'onglet Vues.

La page Vues affiche la liste de toutes les vues dans votre instance de Pl Integrator for Business Analytics.
3. Sélectionnez les vues que vous souhaitez exporter et cliquez sur Exporter les vues sélectionnées.

Les fichiers sont exportés dans le répertoire Téléchargements. Les vues individuelles sont exportées dans un
fichier portant le nom de la vue, par exemple My Asset View.json. Les vues multiples sont exportées dans un
fichier nommé exportViews.json.

4. Déplacez le fichier exporté vers un emplacement accessible a partir de votre second systéme, a savoir le
systeme dans lequel vous souhaitez importer les vues.

5. Sur le second systéme, dans Pl Integrator for Business Analytics, cliquez sur I'icbne du menu et sur
Administration.

Dans la page Administration, cliquez sur I'onglet Vues.
7. Cliquez sur Importer des vues.
Dans la fenétre Ouvrir, sélectionnez le fichier que vous avez exporté, puis cliquez sur Ouvrir.

La page Importer des vues affiche la vue. Si vous avez importé un fichier de vue exporté, les vues contenues
dans le fichier sont extraites.

Les vues importées passeront par une étape de validation de leur nom en raison de la présence de
caractéres spéciaux. Si un nom de vue est jugé non valide, la zone de texte Nom de la vue sera surlignée en
rouge et vous ne pourrez pas importer cette vue. Pour importer cette vue, vous pouvez effectuer 'une des
deux actions suivantes :

¢ Modifiez le champ ViewnameAllowedSpecialCharacters dans C:\ProgramFiles\PIPC\Integrators\BA\
CAST.UL.WindowsService.exe.config pour inclure des caractéres spéciaux spécifiques, puis redémarrez
les services Integrator. Réimportez les vues pour qu’elles passent la validation.

¢ Modifiez le nom de la vue directement dans la zone de texte Nom de la vue. Si la nouvelle vue a passé la
validation, la zone de texte Nom de la vue est surlignée en vert, ce qui permet au nom de la vue de
passer la validation et I'importation. Pour plus d’informations, voir Validation du nom de vue.
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Import Views
100%
View Name AF Server AF Database Start Time End Time Publish Target | Matches | Autostart
Average Building °| OAKPIAF v | & | Facilities-16 v | & *-8h - | Apache Kafl v | & 5223 i
[ Daily Temperature| OAKPIAF v | & [ Facilities-16 ¥ | & *-8h = [Apache Kan v | o 223
Weekly Temperatt| OAKPIAF v | & | Facilities-16 v | & =8h | Apache Kafl v | & 223

Cancel Back Import Selected Views

Pl Integrator for Business Analytics tentera de localiser le serveur Pl AF et la base de données utilisés pour
créer la vue dans le premier systeme. S'il ne retrouve pas le serveur ou la base de données, ces champs
seront vides.

Remarque : Vous ne pouvez pas importer une vue a l'aide de la cible de publication Pl View car cette
derniere est obsoléte. Sélectionnez une autre cible de publication pour importer la vue avec succes.

9. Sélectionnez le serveur Pl AF, la base de données Pl AF et la cible de publication.

La colonne Correspondances vous indique le nombre de correspondances trouvées pour la forme avec le
serveur Pl AF et la base de données spécifiés.

10. (Facultatif) Cliquez dans les champs Nom de la vue, Heure de début et Heure de fin pour modifier les valeurs.

11. (Facultatif) Cliquez sur Démarrage automatique pour démarrer automatiquement la publication de la vue
une fois qu'elle est importée.

Remarque : Vous ne pouvez pas démarrer automatiqguement une vue qui n’a jamais été publiée.

Soyez vigilant lors de l'importation de plusieurs vues. Une fois importées, elles démarrent immédiatement et
peuvent surcharger les ressources de |'ordinateur. Nous vous recommandons de définir manuellement le
calendrier de publication si vous importez un plus grand nombre de vues.

12. Sélectionnez les vues que vous souhaitez importer et cliquez sur Importer les vues sélectionnées.

Les vues sont ajoutées a la fin de la liste des vues. Une fois importées, si Démarrage automatique est activé,
elles démarrent immédiatement et peuvent surcharger les ressources de |'ordinateur. Nous vous
recommandons de planifier manuellement les vues.

13. Rétablissez le Type de transport précédent. Dans la plupart des cas, il s'agit de Auto.

Consulter les enregistrements du journal

Vous pouvez consulter les enregistrements du journal d'une vue dans I'onglet Journaux de la page
Administration.

Vous pouvez filtrer les journaux en :

¢ Indiguant une plage de temps a I'aide des champs Heure de début et Heure de fin
e Sélectionnant une vue a l'aide de la liste Nom de la vue

¢ Indiquant le type d'erreur (Déboguer, Infos, Alerter, Erreur)
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Vous pouvez copier les journaux affichés dans le Presse-papiers ou les télécharger dans un fichier.

Configurer des etendues des journaux

L'étendue d’un journal définit un ensemble de parametres configurables qui contrélent le comportement de
journalisation. Elle prend en charge la configuration des niveaux de journalisation, le réglage du niveau de détail
et la limitation de la longueur des messages.

Il existe trois types d’étendue du journal :

¢ Par défaut : la configuration de journalisation s’applique a tous les journaux
¢ NameSpace : la configuration de journalisation s’applique a I'espace-nom spécifié

¢ Vue : la configuration de journalisation s’applique a la vue sélectionnée

Remarque : Il est fortement recommandé de consulter I'équipe d’assistance technique avant de configurer
les étendues des journaux. Des parametres incorrects peuvent entrainer la perte de données journalisées
importantes ou une journalisation excessive, ce qui risque d’affecter les performances du systéeme et de
consommer de I'espace disque.

Pour définir des étendues de journaux afin de personnaliser et filtrer le comportement de journalisation a partir
de l'onglet Journaux de la page Administration :

1. Cliquez sur le bouton Configuration des étendues des journaux dans le volet gauche.
2. Naviguez jusqu’au volet Configuration.
3. Cliquez sur Ajouter une étendue du journal.

¢ Sivous créez une étendue du journal de type NameSpace, saisissez I’espace-nom pour appliquer la
configuration.

¢ Sivous créez une étendue du journal de type Vue, sélectionnez la vue souhaitée dans la liste déroulante

Pour supprimer des étendues des journaux de l'onglet Journaux de la page Administration :

1. Sélectionnez I'étendue du journal répertoriée sous Etendues des journaux.
2. Sélectionnez Supprimer une étendue du journal.

e |'étendue du journal Tous (par défaut) ne peut pas étre supprimée.

Reportez-vous au tableau suivant pour configurer une étendue du journal avec les parametres suivants :

Parameétre Description

Niveau Infos, Déboguer, Alerter ou Erreur. Le niveau est réglé
par défaut sur Infos.

Niveau de détail Faible : permet d’enregistrer le message d’exception
de niveau supérieur.

Agrégat : permet d’enregistrer le message d’exception
de niveau supérieur et tous les messages d’exception
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imbriqués.
Courbe : permet d’enregistrer le message d’exception
de niveau supérieur et la courbe.

Complet : permet d’enregistrer le message
d’exception de niveau supérieur et tous les messages
d’exception imbriqués et les courbes jusqu’a

10 niveaux. Le réglage par défaut est Faible.

Longueur de message Limite la longueur du message. Doit étre supérieure a
100. La valeur par défaut est illimitée.

Définir vos stratégies de conservation d'enregistrement

Chaque fois qu'une vue est publiée, des données de journal et de statistiques sont collectées et stockées dans les
bases de données suivantes :

¢ Les données de journal sont stockées dans la base de données SQL PlintegratorLogs.

Remarque : Si vous interrogez directement la base de données, les horodatages sont au format GMT.

¢ Les données de statistiques sont stockées dans la base de données SQL PlintegratorStats.

Au fil du temps, ces enregistrements peuvent occuper beaucoup de place sur votre serveur. Pl Integrator for
Business Analytics supprime donc régulierement les enregistrements de journal et de statistiques. Les
parameétres des taches sont configurés dans le fichier %PIHOMEG64%\Integrators\BA\
CAST.UL.WindowsService.exe.config.

Le fichier de configuration comprend les différentes sections suivantes pour définir les stratégies relatives aux
enregistrements de journal et aux enregistrements de statistiques :

e Section <maintenanceTasks> , qui détermine quand les enregistrements sont supprimés. Deux taches sont
incluses : logRetentionPolicies et statRetentionPolicies.

¢ Sections <logRetentionPolicies> et <statsRetentionPolicies>, qui déterminent les enregistrements qui sont
supprimés.

Stratégie de conservation du journal

Pour obtenir des informations générales sur les stratégies de conservation des enregistrements, voir Définir vos
stratégies de conservation d'enregistrement.

La tache logRetentionPolicies dans la section maintenanceTasks du fichier de configuration de I'application
détermine quand les enregistrements du journal sont supprimés. Par défaut, les enregistrements du journal sont
supprimés toutes les 24 heures a 7 h 00.

Le tableau suivant décrit les parameétres de la tache.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 80



'AV EVA\TM Pl Integrator for Business Analytics

Taches d'administration

Parameétres de la tache logRetentionPolicies

Parametres Description du parametre Valeur par défaut

taskName Nom de la tache de conservation add
des enregistrements du journal. Ne | taskName="logRetentionPolicies"
modifiez pas cette valeur.

runFrequency Fréquence a laquelle la tache runFrequency="24hours"
statRetentionPolicies est exécutée.
Utilisez le temps Pl pour indiquer
les unités de temps. runFrequency
and timeOfDay ensemble
déterminent quand la tache est
effectuée.

timeOfDay Heure a laquelle la tache timeOfDay="7:00"
logRetentionPolicies est exécutée.
Utilisez le temps Pl pour indiquer
les unités de temps. runFrequency
and timeOfDay ensemble
déterminent quand la tache est
effectuée.

Stratégie de conservation du journal

La stratégie dans la section logRetentionPolicies détermine les enregistrements du journal qui sont supprimés.
Les plus anciens enregistrements sont supprimés en premier.

Remarque : Si la stratégie est supprimée, les enregistrements du journal sont indéfiniment conservés.

Vous pouvez supprimer des enregistrements du journal en fonction d'une quelconque combinaison des
informations suivantes :

e L'age des enregistrements
¢ Le nombre d'enregistrements

¢ Lataille totale de tous les enregistrements

La stratégie par défaut supprime les enregistrements du journal de plus de deux mois, maintient un nombre
maximum de 100 000 enregistrements et maintient une taille maximale des enregistrements du journal de 1 000
Mo.

Remarque : Chaque fois que la suppression planifiée supprime avec succés un nombre quelconque
d’enregistrements, la stratégie exécute également une opération de réduction automatique sur la base de
données pour en réduire la taille.
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Parameétres de la stratégie logRetentionPolicies

Parametre Description du parametre Valeur par défaut
uniquePolicyName Nom de la stratégie. uniquePolicyName="LogsPolicy1"
maximumTableRecordAge Age maximum des enregistrements | maximumTableRecordAge="2mont

du journal exprimé en mois. Utilisé | hs"
avec maximumTableRowCount et
maximumTableSizeOnDisk pour
déterminer les enregistrements du
journal qui sont supprimés.

maximumTableRowCount Nombre maximum de lignes de maximumTableRowCount="100000
données du journal. Utilisé avec "

maximumTableRecordAge et
maximumTableSizeOnDisk pour
déterminer les enregistrements du
journal qui sont supprimés.

maximumTableSizeOnDisk Taille maximale de tous les maximumTableSizeOnDisk="1000"
enregistrements du journal,
exprimée en mégaoctets (Mo).
Utilisé avec
maximumTableRecordAge et
maximumTableRowCount pour
déterminer les enregistrements du
journal qui sont supprimés.

Stratégie de conservation des statistiques

Tache de stratégie de conservation des statistiques

Les statistiques de chaque vue sont stockées dans une table distincte de la base de données SQL
PlintegratorStats. Le nom de la table correspond a I'ID de vue.

La tache statRetentionPolicies dans la section maintenanceTasks du fichier de configuration de I'application
détermine quand les enregistrements de statistiques sont supprimés. Le tableau suivant décrit les paramétres de
la tache statRetentionPolicies.

Parameétres de la tache statRetentionPolicies

Parameétre Description du parameétre Valeur par défaut

taskName Identifie le nom de la tache de taskName="statRetentionPolicies"
conservation de statistiques. Ne
modifiez pas cette valeur.

runFrequency Fréquence a laquelle la tache runFrequency="24hours"
statRetentionPolicies est exécutée.
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Parameétre Description du parameétre Valeur par défaut

Utilisez le temps Pl pour indiquer
les unités de temps. runFrequency
and timeOfDay ensemble
déterminent quand la tache est
exécutée.

timeOfDay Heure a laquelle la tache timeOfDay="7:00"
statRetentionPolicies est exécutée.
Utilisez le temps Pl pour indiquer
les unités de temps. runFrequency
and timeOfDay ensemble
déterminent quand la tache est
exécutée.

Par défaut, les enregistrements de statistiques sont supprimés toutes les 24 heures aprées le démarrage.

Stratégies de conservation des statistiques

Les stratégies dans la section statRetentionPolicies déterminent les enregistrements de statistiques qui sont
supprimés. Les stratégies de conservation des statistiques supposent que des vues sont publiées a des intervalles
planifiés et la fréquence de publication détermine les enregistrements qui sont supprimés. En regle générale,
plus une vue est publiée fréquemment, plus de statistiques sont générées, et vous souhaiterez supprimer des
enregistrements plus souvent. Ceci s'applique aux vues d'actif, aux vues d'événement et aux vues de diffusion
continue planifiée.

Les vues de diffusion publiées suite a des changements de valeurs clés ne sont pas publiées a intervalles
réguliers. Ainsi, pour gérer efficacement la quantité de données statistiques dans la base de données, Pl
Integrator for Business Analytics suppose que la diffusion de données pour ces vues se produit a la fréquence la
plus élevée possible, a savoir a des intervalles de 30 secondes. La stratégie qui inclut la fréquence de publication
de 30 secondes s'applique donc a toutes les vues de diffusion déclenchées par une valeur clé.

Remarque : Les statistiques de vues qui ne sont publiées qu'une seule fois sont conservées indéfiniment jusqu'a
ce que la vue soit supprimée.

Les stratégies suivantes sont définies par défaut :

e StatsPolicyl : définit une stratégie pour des vues publiées a une fréquence comprise entre 1 seconde et 5
minutes

e StatsPolicy2 : définit une stratégie pour des vues publiées a une fréquence comprise entre plus de 5 minutes
et 1 heure

e StatsPolicy3 : définit une stratégie pour des vues publiées a une fréquence de plus de 1 heure

Vous pouvez modifier les stratégies par défaut ou créer d'autres stratégies et indiquer le niveau de granularité
dont vous avez besoin. Vérifiez que vos stratégies couvrent tous les intervalles de temps possibles. Si un
intervalle de temps n'est pas inclus, les enregistrements de statistiques de vues publiées a l'intervalle manquant
seront alors conservés indéfiniment.

Pour chaque stratégie, vous pouvez supprimer les enregistrements d'une vue sur la base d'une quelconque
combinaison des informations suivantes :
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¢ |'age des enregistrements dans la table

¢ Le nombre total d'enregistrements dans la table

¢ La taille totale de la table

Vous trouverez ci-dessous une description des parameétres de la stratégie statRetentionPolicies et la liste des
valeurs par défaut de I'une des stratégies, StatsPolicyl.

Parameétres de la stratégie statRetentionPolicies

Parameétre

Description du parametre

Valeurs par défaut de StatsPolicyl

uniquePolicyName

Nom de la stratégie. Les noms de
stratégie doivent étre uniques. Si
plusieurs stratégies portent le
méme nom, le fichier de
configuration n'est pas exécuté et
une erreur est renvoyée.

uniquePolicyName="StatsPolicy1"

filterMinimumRunFrequency

La limite inférieure de la fréquence
de publication de la vue. Utilisé
avec filterMaximumRunFrequency
pour déterminer les vues
auxquelles cette stratégie
s'applique.

filterMinimumRunFrequency="1sec
ond"

filterMaximumRunFrequency

La limite supérieure de la
fréquence de publication de la vue.
Utilisé avec
filterMaximumRunFrequency pour
déterminer les vues auxquelles
cette stratégie s'applique.

filterMaximumRunFrequency="5mi
nutes"

maximumTableRecordAge

L'age des plus anciens
enregistrements qui sont
conservés. Utilisé avec
maximumTableRowCount et
maximumTableSizeOnDisk pour
spécifier les enregistrements qui
sont supprimés.

maximumTableRecordAge="24hrs"

maximumTableRowCount

Le nombre maximum de lignes qui
sont conservées dans la table. Si le
nombre de ligne dépasse ce
nombre, les plus anciens
enregistrements sont supprimés en
premier. Utilisé avec
maximumTableRecordAge et
maximumTableSizeOnDisk pour
spécifier les enregistrements qui
sont supprimés.

maximumTableRowCount="100000

n
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Parameétre Description du parameétre Valeurs par défaut de StatsPolicyl

maximumTableSizeOnDisk La taille maximale de la table en maximumTableSizeOnDisk="200"
mégaoctets (Mo). Les plus anciens
enregistrements sont supprimés en
premier. Utilisé avec
maximumTableRowCount et
maximumTableSizeOnDisk pour
spécifier les enregistrements qui
sont supprimés.

Vous trouverez ci-dessous une description de StatsPolicyl avec ses valeurs par défaut. La stratégie StatsPolicyl
s'applique aux vues qui sont publiées a une fréquence comprise entre 1 seconde et jusqu'a 5 minutes. Pour
chaque vue, les enregistrements de statistiques jusqu'a 24 heures sont conservés, le nombre de lignes dans la
table de la vue ne dépasse pas 100 000 et la taille totale de la table ne dépasse pas 200 Mo. Les enregistrements
qui ne remplissent pas ces trois conditions sont supprimés. Avec toutes les stratégies de conservation, les plus
anciens enregistrements sont supprimés en premier.

Remarque : Chaque fois que la suppression planifiée supprime avec succés un nombre quelconque
d’enregistrements, la stratégie exécute également une opération de réduction automatique sur la base de
données pour en réduire la taille.

Licence et flux de sortie

L'onglet Licence de la page Administration fournit des informations sur le nombre de flux de sortie utilisés et les
vues qui utilisent les flux de sortie.

Un flux de sortie est un point Pl (point de données) publié sur une cible ou référencé uniquement dans une vue.
A flux de sortie unique est un point de données PI distinct publié dans une ou plusieurs vues.

Votre logiciel et votre contrat de licence spécifiques déterminent le nombre maximum de flux de sortie uniques
dont vous pouvez disposer simultanément.

Par exemple, imaginons que trois vues soient configurées sur Pl Integrator : ProcLabl, TestPrd, et Fieldoutput.
ProcLab1 utilise 20 flux de sortie (15 flux de sortie uniques et 5 flux de sortie non uniques), TestPrd utilise 2 flux
de sortie uniques, et Fieldoutput utilise 22 flux de sortie (2 utilise 20 flux de sortie uniques et 20 utilise 20 flux de
sortie non uniques). Flux de sortie par vue : la liste indique les trois vues avec le total de flux de sortie utilisés
par chacune des vues. Les totaux suivants sont affichés :

¢ Flux de sortie uniques utilisés : 19 flux de sortie.

¢ Flux de sortie restants indique le nombre restant de flux de sortie disponibles. Le nombre total de flux
disponibles dépend du nombre maximum autorisé avec votre licence.

Augmenter le nombre de flux de sortie disponibles

Si le nombre de flux de sortie est insuffisant pour répondre a vos besoins, vous pouvez mettre a niveau vers une
version en comprenant un nombre maximum supérieur. Pour plus d'informations sur les nombres maximum de
flux de sortie, contactez votre gestionnaire de compte AVEVA.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 85



'AV EVA\TM Pl Integrator for Business Analytics

Taches d'administration

Recupération de flux de sortie

Récupérer des flux de sortie a partir de vues supprimées permet de libérer le nombre de flux de sortie uniques
disponibles pour de nouvelles vues. Il est important de comprendre que le fait de supprimer une vue de la page
Mes Vues ne modifie pas immédiatement le nombre de flux de sortie uniques comptabilisés par rapport a la
limite indiquée dans votre contrat de licence. Les flux de sortie uniques ne sont pas récupérés immédiatement
apres la suppression d'une vue ; ils sont récupérés automatiquement 7 jours aprés la derniere publication des
données du point PI.

Le flux de sortie est automatiquement récupéré par un service interne. La premiére récupération est effectuée
au démarrage de I'application Pl Integrator, puis le service est exécuté une fois toutes les 24 heures. Par
conséquent, il n'est plus nécessaire de cliquer manuellement sur le bouton Récupérer tous les flux, car les flux
éligibles sont automatiquement récupérés une fois par jour.

Modifier le compte de service Windows

Vous pouvez modifier le compte de service qui exécute Pl Integrator for Business Analytics. Vous pouvez spécifier
un compte de service Windows, un compte de service administré de groupe (gMSA) ou des comptes virtuels
Windows. Si vous passez d’un compte gMSA ou d’un compte virtuel a un autre compte, ou inversement, tenez
compte des éléments suivants :

¢ Sivous passez d'un compte de service Windows avec authentification SQL a un compte gMSA ou a des
comptes virtuels, le compte gMSA ou les comptes virtuels doivent utiliser I'authentification Windows pour
s'authentifier auprés du serveur SQL principal qui héberge Pl Integrator for Business Analytics. Il ne peut pas
étre configuré pour utiliser I'authentification SQL.

¢ Sivous passez d'un compte gMSA ou d’un compte virtuel a un autre compte, ou inversement, une fois que le
compte est modifié, vous devrez saisir a nouveau les informations d’identification pour chaque cible de
publication.

Vérifiez que le compte d’utilisateur connecté, ou le compte d’utilisateur qui exécute I'utilitaire Modifier le
compte de service, dispose des autorisations suivantes :

¢ Privileges d’administrateur local sur le serveur Microsoft Windows Server ou Pl Integrator for Business
Analytics est installé

¢ Privileges d’administrateur sur le serveur Pl AF ou la base de données de configuration de PI Integrator for
Business Analytics est installée

Remarque : Le serveur PI AF est identifié dans le fichier %PIHOME64%\Integrators\BA\
CAST.Ul.WindowsService.exe dans la section <appSettings> avec la clé InstancePath.

Les autorisations suivantes sont également requises pour le compte d’utilisateur connecté ou le compte
d’utilisateur exécutant l'utilitaire de modification du compte de service :

e Autorisation ALTER ANY LOGIN sur SQL Server

¢ ROle de base de données db_owner pour les bases de données PlintegratorDB, PlintegratorLogs et
PlintegratorStats

Remarque : La seule exception a cette régle concerne le cas ol vous utilisez I'autorisation SQL et ne
souhaitez pas changer de compte SQL. Ces autorisations supplémentaires ne sont alors pas requises.
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Si I'utilisateur procédant a I'installation ne dispose pas des autorisations requises sur les bases de données
SQL, un utilisateur disposant de privileges sysadmin doit tout d’abord exécuter le fichier Go.Bat, disponible
dans %PIHOMEG64%\Integrators\BA\SQL.

Si vous utilisez I'autorisation SQL et que vous ne souhaitez pas changer de compte SQL, vous n'avez pas
besoin d'exécuter ces fichiers.

¢ Le nouveau compte de service Windows qui exécutera le service Pl Integrator Framework doit posséder les
droits « Se connecter en tant que service » sur la machine sur laquelle Pl Integrator for Business Analytics est
installé. Un utilisateur disposant de priviléges d'administrateur peut octroyer ce droit au service. La
procédure d'octroi varie selon le systeme d'exploitation de votre ordinateur et de la version du logiciel.

¢ Le nouveau compte de service Windows doit également avoir un profil local. Connectez-vous a l'aide du
nouveau compte de service pour créer un profil sur le serveur Microsoft Windows ou PI Integrator for
Business Analytics est installé.

Lorsque vous avez terminé, passez a la procédure ci-dessous.

¢ Sivous passez d'un compte de service Windows avec authentification SQL a un compte gMSA ou a des
comptes virtuels, le compte gMSA ou les comptes virtuels doivent utiliser I'authentification Windows pour
s‘authentifier auprés du serveur SQL principal qui héberge Pl Integrator for Business Analytics. Il ne peut pas
étre configuré pour utiliser 'authentification SQL.

¢ Sivous passez d’'un compte gMSA ou d’un compte virtuel a un autre compte, ou inversement, une fois que le
compte est modifié, vous devrez saisir a nouveau les informations d’identification pour chaque cible de
publication.

1. A partir du répertoire %PIHOME64%\Integrators\BA, exécutez le fichier
ChangelntegratorServiceAccount.exe en tant qu’administrateur.

2. Suivez les invites et fournissez le mot de passe du compte qui exécute actuellement le service Pl Integrator
Framework.

Remarque : Vous devez tout d’abord fournir le mot de passe du compte de service qui exécute actuellement
le service Pl Integrator Framework avant de pouvoir changer de compte de service.

Si le compte est un compte gMSA ou un compte virtuel, n’indiquez aucun mot de passe et ignorez cette
étape.

3. Suivez les invites et fournissez le compte de service et le mot de passe du nouveau compte de service qui
exécutera les services Pl Integrator for Business Analytics.

L'utilitaire Modifier le compte de service ajoute le nouveau compte et ses autorisations au serveur Pl AF et a
SQL Server.

Remarque : Si le nouveau compte de service est un compte gMSA, indiquez le nom du compte de service
mais pas le mot de passe. Les comptes virtuels ne nécessitent ni nom de compte de service ni mot de passe.

4. Appuyez sur Entrée pour quitter |'utilitaire.

Si vous passez d’'un compte gMSA ou d’un compte virtuel a un autre compte, ou inversement, vous devrez saisir
a nouveau les informations d’identification pour chacune de vos cibles de publication.

Modifier le port Pl Integrator

Lorsque vous modifiez le port Pl Integrator, tous les utilisateurs connectés a I'application Web Pl Integrator for
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Business Analytics devront entrer a nouveau I'URL avec le nouveau port. Toutes les vues actives au moment ou le
port est modifié sont correctement exécutées.

1. Dans le Panneau de configuration Microsoft, accédez a Programmes et fonctionnalités.

2. Faites un clic droit sur Pl Integrator for Business Analytics dans la liste et cliquez sur Modifier dans le menu.
La fenétre Assistant d'installation de Pl Integrator for Business Analytics 2020 apparait.
Cliquez sur Modifier, puis sur Suivant.

4. Dans la fenétre Informations de connexion, entrez le nom d'utilisateur et le mot de passe du compte de
service Windows qui exécute le Service Pl Integrator Framework. Cliquez sur Suivant.

5. Dans la fenétre Configuration du port et du certificat TLS, entrez un autre numéro de port et cliquez sur
Valider le port pour vérifier la disponibilité du port.

Cliquez sur Suivant.
7. Dans la fenétre Prét a modifier I'application, cliquez sur Installer.

Lorsque l'installation est terminée, I'application utilise le nouveau port.

Modifier la configuration du certificat TLS

Dans le Panneau de configuration Microsoft, accédez a Programmes et fonctionnalités.

2. Faites un clic droit sur Pl Integrator for Business Analytics dans la liste et cliquez sur Modifier dans le menu.
La fenétre Assistant d'installation de Pl Integrator for Business Analytics apparait.
Cliquez sur Modifier, puis sur Suivant.

4. Dans la fenétre Informations de connexion, entrez le nom d'utilisateur et le mot de passe du compte de
service Windows qui exécute le Service Pl Integrator Framework. Cliquez sur Suivant.

5. Dans la fenétre Configuration du port et du certificat TLS, choisissez un certificat TLS dans I'une des sources
suivantes :

¢ Certificat auto-signé généré pendant l'installation — Il s'agit de la valeur par défaut. Sélectionnez
Certificat auto-signé.

Remarque : Si vous choisissez cette option, les utilisateurs qui se connectent depuis une machine a
distance peuvent voir apparaitre un message d'avertissement lié a la sécurité. Pour éviter |'affichage de
cet avertissement pour les certificats auto-signés, le certificat doit étre explicitement approuvé sur la
machine client. Consultez la solution dans I'article de la Base de connaissances Certificate error returned
when navigating to a Pl Vision or Pl Web API web site using a self-signed certificate (Renvoi d'une erreur
de certificat lors de I'accés a un site Web de Pl Vision ou Pl Web API a l'aide d'un certificat auto-signé).

¢ (Recommandé) Certificat TLS d'une autorité de certification — Sélectionnez Importer le certificat et
cliquez sur Sélectionner le certificat pour choisir un certificat émis par une autorité de certification et
importé sur la machine sur laquelle Pl Integrator for Business Analytics est en train d'étre installé.

6. Cliquez sur Suivant.
7. Dans la fenétre Prét a modifier I'application, cliquez sur Installer.

Lorsque l'installation est terminée, I'application utilise le nouveau certificat TLS.
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Types de données non pris en charge

Int16

Pl Integrator for Business Analytics ne prend pas en charge le type de données Int16 dans les situations suivantes

¢ Les données écrites dans des cibles AWS S3 au format Parquet ne peuvent pas étre publiées comme des
données .

¢ Les données sérialisées Avro publiées dans une cible de diffusion ne peuvent pas étre publiées comme des
données Int16.

Dans ces situations, Pl Integrator for Business Analytics convertit automatiquement les données Int16 dans le
type de données Integer.
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Démarrez Pl Integrator for Business
Analytics

1. Ouvrez un navigateur.
2. Saisissez I'URL de I'application PI Integrator for Business Analytics.

L'URL méne a la machine hote et au port du service Windows Pl Integrator for Business Analytics. L'URL est
https://hostname:numéro de port ou FQDN:numéro de port, ou FQDN correspond au nom de domaine
pleinement qualifié. Si vous utilisez le port 443, vous pouvez ignorer le numéro de port si vous indiquez I'URL
du . Si vous avez installé sur un hote appelé lab5 dans le domaine prod.onet.com et |'avez configuré pour
utiliser le port 7777, vous pouvez entrer ces deux URL :

Remarque : Si vous ne savez pas quel port a été spécifié lors de I'installation de Pl Integrator for Business
Analytics, accédez a la machine sur laquelle PI Integrator for Business Analytics a été installé. Ouvrez le
fichier %PIHOMEG4%\Integrators\BA\CAST.Ul.SelfHost.exe.config et localisez la valeur de la clé

« SelfHostPort ». Vérifiez I'URL aupres de I'administrateur Pl Integrator for Business Analytics de votre
systeme.

L'application s'ouvre a la page Mes Vues.

3. Cliquez sur I'icbne de menu E pour ouvrir le menu Pl Integrator for Business Analytics.

Le menu suivant apparait :
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Business Analytics
Advanced Edition

™ My Views

Manage your data views

% Create Asset View

Build a data view starting with
your asset hierarchy

"4 Create Event View

Build a data view starting with
your event frame hierarchy

% Create Streaming View

Build a streaming view with a
custom output shape

/ Administration

Manage servers, users, and
targets

Pl Integrator for Business Analytics
Démarrez Pl Integrator for Business Analytics

Vous pouvez ouvrir ce menu a partir de n'importe quelle page de |'application et effectuer les taches

suivantes :

e Accéder a la page Mes vues — Pour plus d’informations sur la page Mes vues, voir La page Mes Vues.

¢ Créer une vue d’actif — Pour plus d’informations sur la création de vues d’actif, voir Créer une vue d'actif.

e Créer une vue d’événement — Pour plus d’informations sur la création de vues d’événement, voir Créer

une vue d'événement.

¢ Créer une vue de diffusion — Pour plus d’informations sur la création de vues de diffusion, voir Créer une
vue de diffusion. Cette fonctionnalité est disponible avec Pl Integrator for Business Analytics Edition

Advanced.

e Accéder a la page Administration — Pour plus d’informations sur les taches que vous pouvez effectuer sur

cette page, voir Taches d'administration.
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La page Mes Vues

Lorsque vous saisissez I'URL de PI Integrator for Business Analytics, I'application s’ouvre a la page Mes Vues. Dans
cette page, vous pouvez créer des vues d'actif, des vues d'événement et des vues de diffusion. Cette page affiche

également la liste des vues auxquelles vous avez acces. La capture d'écran et le tableau ci-dessous décrivent les
informations disponibles a propos de vos vues et vous expliqueront comment utiliser cette page.

m

Create Asset View + Create Event View + Create Streaming Viev, O Modity View W Remave View
Name Run Status Run Moge A Start Time = Last Run Time:

Average Building Temperature .:'I'earl'; Streaming Out duled Stream ; Pmtcomin@n) _ Apr 1 10:27-38 PM

Buil 2 T ning 16% Assat n T Apr 15, 14 PM

Building HVAC Streaming Streaming Out led Stream Autosize Al Columns 5, 2018 10:27:00 PM

Daily Temperature Fublished Assel “ah Sort Ascending Apr 15, 2018 3:36:31 PM

Floor One Temperature Scheduled Asset o Continuous *8h Sort Descending Apr 15, 2018 10:27:35 PM

Floor Three Published Assel _J Once 8h Remove Sort Apr 15, 2018 9:55:53 PM

Floor Three AVAC Scheduled Asset Continuous *-8h Columns. Apr 15, 2018 10:27:28 PM

Floor Two Temperature Pubisning34% LR Continucus ~gn . ApI 15, 2018 10:27-33 PM

‘Weekly Temperature Slopped By User Assel Continuous “-&h * Apr 15, 2018 10:26.55 PM

Q
8} = -

Overview Log Security View Cenfiguration Statistics

Run Status Publishing 16% Publish Actions Search Shape

View Name Building AVAC Amoet Shepe

: 4 @ vavee
Pl AF Database Facilites-1600 Alvarado “ # % cooling
Publish Target SOL Server # % heating
& air signal (heating)

Run Mode Continuous

Run Frequeney 1 Minutes

Last Run Time Apr 15,2018 10:27:44 PM

Numéro Description

1 Toutes les vues auxquelles vous avez acces sont listées
dans le tableau. Vous ne pouvez modifier que les vues
pour lesquelles vous disposez d'autorisations d'acces
en écriture. Vous pouvez effectuer une copie d'une
vue pour laquelle vous disposez d'autorisations
d'acces en lecture, puis modifier la copie.

2 Utilisez Créer une vue d'actif pour créer une vue
d'actif. Pour en savoir plus, consultez Créer une vue
d'actif.

3 Utilisez Créer une vue d'événement pour créer une
vue d'événement. Pour en savoir plus, voir Créer une
vue d'événement.

4 Utilisez Créer une vue de diffusion pour créer une vue
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de diffusion. Pour en savoir plus, voir Créer une vue de
diffusion. Cette fonctionnalité est disponible avec PI
Integrator for Business Analytics Edition Advanced.

Pour modifier une vue, sélectionnez-la dans le tableau
et cliquez sur Modifier la vue.

Pour supprimer une vue, sélectionnez-la dans le
tableau et cliquez sur Remove View (Supprimer la
vue). La suppression d'une vue supprime le nom de la
vue dans la liste de noms de vues réservés. Notez que
la suppression d'une vue ne libére pas les flux de
sortie autorisés avec votre licence tant que 7 jours ne
se sont pas écoulés.

Pour plus d’informations, voir Récupération de flux de
sortie.

Cliquez sur les barres pour ouvrir et fermer le volet
des détails avec les onglets Apergu, Journal, Sécurité,
Afficher la configuration et Statistiques.

Pour la vue sélectionnée, les onglets Apergu, Journal,
Sécurité, Afficher la configuration et Statistiques
fournissent les informations suivantes sur la vue :

e Apergu indique si la vue a été publiée. Cet onglet
récapitule également les informations sur la vue,
comme la base de données Pl AF utilisée, |la date
de la derniere exécution et la forme qu'elle utilise.
Si la vue est actuellement en cours de publication,
la barre Etat d'exécution indique la progression.
Vous pouvez également arréter la procédure de
publication.

¢ Journal affiche des informations sur la vue
sélectionnée. Il est possible de régler les heures
de début et de fin, et de filtrer les messages pour
afficher ceux qui correspondent a un certain
niveau de sécurité, comme les erreurs critiques,
par exemple.

Remarque : Pour préserver 'utilisation des
ressources, les téléchargements de journaux sont
limités a un maximum de 100 000 lignes, quelles
gue soient les heures de début et de fin de
I'intervalle de récupération des journaux. Si vous
avez besoin de toute la table de journaux, vous
pouvez la récupérer a partir de la base de données
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sQL.

e Sécurité indique qui a accés a la vue et, si vous
bénéficiez des privileges adéquats, permet de
modifier le niveau d'accés.

o Afficher la configuration fournit un apercu rapide
de vos vues, notamment les éléments et attributs
de la vue, des détails sur les éléments et attributs
et les éventuels filtres de ligne.

e Statistiques affiche des statistiques sur la vue
sélectionnée. Pour plus d’informations, voir
Afficher les données de statistiques.

Placez votre curseur dans le titre de la colonne pour

activer I'icdbne du menu = et cliquez dessus pour
ouvrir le menu. Dans ce menu, vous pouvez
redimensionner les colonnes, trier les données de la
colonne et ajouter ou supprimer des colonnes de la
table.

10

L'icbne rouge du compteur de messages en haut a
droite affiche le nombre de messages
d'avertissements et de messages d'erreur enregistrés
par . Cliquez sur l'icbne pour ouvrir la liste des
messages. Cliquez sur les actions en haut de la liste de
messages. Supprimer les alertes/Annuler la
suppression des alertes active ou désactive les
alertes. Agrégation désactivée/Agrégation activée
contréle la fagon dont plusieurs occurrences d'un
méme message sont signalées. Agrégation désactivée
signale chaque occurrence d'un message. Agrégation
activée affiche le message une fois et signale le
nombre d'occurrences. Effacer tout supprime tous les
messages de la liste.

Suppress Alerts Aggregation: Off Clear a
A critical error has occurred, see the 3
event log for further details.

YIA2M5, 15124 PM Details

[

11

Cliquez sur l'icone en forme d'engrenage Hsituée
en haut a droite pour connaitre la version de et du
serveur Pl AF, et pour changer la langue et les
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parametres régionaux.
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Comment utiliser Pl Integrator for Business
Analytics

Pl Integrator for Business Analytics propose une interface utilisateur web facile a utiliser. Les principales
fonctionnalités sont les suivantes : Créer une vue d'actif, Créer une vue d'événement et Créer une vue de
diffusion ; et Modifier une vue, Copier une vue et Sécuriser vos vues.

Vues Pl Integrator for Business Analytics

Une vue est une description modélisée des données de Pl System que vous souhaitez analyser. Il existe plusieurs
types de vues : les vues d'actif, les vues d'événement et les vues de diffusion. La question que vous vous posez
déterminera le type de vue contenant le mieux a votre cas d'utilisation. Ce qui suit est un exemple de la facon
dont vous pouvez utiliser chaque type de vue pour répondre a différentes questions a propos de votre
entreprise.

Les vues d'actif permettent d'organiser les données en fonction de vos actifs et de comparer les actifs.

Par exemple, si vous souhaitez analyser un groupe d'éoliennes par production en mégawatt et voir les
résultats par modeéle et par fabricant. Vous pouvez créer une vue d'actif basée sur un modele d'élément
d'éolienne par production en mégawatt, par modele, et par attributs de fabricant. Cela vous permettra de
comparer les performances au sein de votre parc d'éoliennes.

Les vues d'événement permettent d'organiser les données en fonction de vos cadres d'événements et
d'identifier des modeéles dans les cadres d'événements.

Remarque : Pl Integrator for Business Analytics ne renvoie que les cadres d'événement fermés (avec une
heure de début et de fin valide). Il ne peut pas publier des données de cadre d'événement ouvert.

Pour reprendre I'exemple précédent, imaginons que vous souhaitiez analyser les temps d'arrét de vos
éoliennes. Vous pouvez créer une vue d'événement pour comparer la durée des temps d'arrét et inclure le
modele et les attributs de fabricant, afin de vérifier s'il existe un modeéle dans les différents cadres
d'événements des temps d'arrét.

Les vues de diffusion permettent d'organiser les données en fonction de vos actifs et de mettre ces données
a disposition quasiment en temps réel a des fins d'analyse prédictive.

En reprenant I'exemple ci-dessus, supposons que vous souhaitiez prévoir la puissance de sortie de chaque
éolienne au cours de I'heure suivante sur la base des données actuelles. Vous pourriez créer une vue de
diffusion incluant la vitesse du vent, la densité de I'air et la sortie en mégawatts actuelle de la turbine, et
utiliser ces données pour simuler un modele d'analyse prédisant la puissance de sortie sur la base de ces
entrées.

Qu'est-ce qu'une forme ?

Les vues sont créées a l'aide d'une forme, un modeéle de recherche de données dans le the Pl System. La
définition de forme fournit les informations suivantes, essentielles pour créer la vue :
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e données ainclure

e structure des données dans la vue

Les formes possédent la capacité unique de chercher des relations entre des éléments et des attributs, ainsi que
des éléments et des attributs eux-mémes. Avec PI Integrator for Business Analytics, vous pouvez définir des
parents, des enfants et leur relation en tant que partie intégrante de la forme, ainsi que des modéles plus
traditionnels, nom, et des parameétres de recherche. Vous pouvez également étendre la forme pour trouver des
correspondances d'actifs ou de cadres d'événements dérivés du méme modéle.

Chaque forme correspond a une vue respective :

¢ Les formes d'actifs contiennent des actifs, des attributs et leurs relations dans des vues d'actif.

¢ Les formes de diffusion et d'actif sont créées de la méme maniére. Les vues sont différentes dans le
Concepteur de message : les vues d'actif sont présentées sous forme de tableau et les vues de diffusion sous
forme de paires attribut-valeur.

¢ Les formes d'événement contiennent des cadres d'événement, des attributs de cadre d'événement et des
attributs d'élément référencé dans des vues d'événement.

Apercu sur l'utilisation de PI Integrator for Business Analytics

Ce chapitre vous expliquera comment utiliser Pl Integrator for Business Analytics pour générer des données
facilitant la prise de décisions pour votre outil Business Intelligence.

Conseil : Si vous utilisez pour la premiére fois, OSIsoft vous recommande de commencer par découvrir comment
créer une vue d'actif, puis des vues de diffusion ou d'événement.

1. Sélectionnez les données Pl System a inclure dans votre analyse.

Déterminez si votre analyse nécessite une vue d'actif, une vue d'événement ou une vue de diffusion. Si vous
souhaitez analyser vos données par actifs, créez une vue d'actif. Si vous souhaitez analyser vos données par
cadres d'événement, créez une vue d'événement. Si vous souhaitez analyser vos données par actifs et que
vous avez besoin de valeurs diffusées pour une analyse en temps réel ou une autre analyse, créez une vue de
diffusion.

¢ Vue d'actif — Commencez par créer une forme simple, pour trouver un seul actif, par exemple. Le volet
Correspondances affiche les éléments trouvés dans une base de données Pl AF et qui correspondent a la
forme que vous avez définie.

¢ Vue d'événement — Commencez par créer une forme simple, pour vous limiter a un seul cadre
d'événement et a un élément référencé par le cadre d'événement, par exemple. Ajoutez des attributs
d'élément qui peuvent fournir davantage de contexte a la forme de I'actif pour les données de
I'événement. Le volet Correspondances garde une trace des actifs, attributs, et cadres d'événements qui
correspondent a la forme.

¢ Vue de diffusion — Commencez par créer une forme simple, pour trouver un seul actif, par exemple. Le
volet Correspondances affiche les éléments trouvés dans une base de données Pl AF et qui
correspondent a la forme que vous avez définie.
2. Prévisualiser votre jeu de données

L'apergu affiche un sous-ensemble des informations. Il est établi a partir des 10 premieres correspondances
et utilise les 100 premiers enregistrements de chaque correspondance. Par conséquent, il est possible que
toutes les données n'apparaissent pas. L'objectif de I'apercu est de vous donner une idée de vos données
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pour que vous puissiez déterminer quelles données supplémentaires inclure afin de fournir davantage de
contexte, ou comment exclure des lignes afin de vous concentrer sur les données qui vous intéressent.

3. (Vues de diffusion uniquement) Indiquez le schéma utilisé pour envoyer les messages et comment le
message est déclenché.

4. Affiner votre jeu de données

Il existe une grande flexibilité dans la facon de modifier votre jeu de données final afin de produire les
résultats escomptés. Vous pouvez :

¢ Modifier I'affichage des colonnes de données/champs de données

¢ Ajouter des colonnes de données/champs de données

¢ Ajouter des colonnes d'heure/champs d'heure

e Ajouter des calculs sur une colonne ou un champ

¢ Filtrer les données pour inclure unique les données qui vous intéressent

¢ Définir comment les données sont récupérées (valeurs résumées, interpolées ou exactes)

Remarque : Les colonnes s'appliquent aux vues d'actif et d'événement et les champs aux vues de
diffusion.

5. Publier les données vers une cible de publication
Les données peuvent étre publiées une fois, ou de facon planifiée.

6. Visualisez vos données dans votre outil Business Intelligence préféré.
Pour des procédures plus détaillées, commencez par I'une des possibilités suivantes :

e Créer une vue d'actif
e Créer une vue d'événement

e Créer une vue de diffusion

Validation du nom de vue

La validation du nom de vue permet a Pl Integrator de créer, de modifier ou d’'importer des boites de dialogue.
Tous les caractéres Unicode et de localisation internationale sont autorisés, mais certains caractéres spéciaux ne
le sont pas. Les vues existantes qui font déja partie de la base de données de Pl Integrator ne devraient pas étre
affectées, sauf si l'utilisateur tente de modifier leur nom.

Si I'utilisateur saisit un nom de vue non valide, la zone de texte sera surlignée en rouge et un message d’erreur
s’affichera pour indiquer que le nom de vue n’est pas valide. Le scénario est identique pour la création, la
modification ou I'importation de boites de dialogue.

Les utilisateurs ont la possibilité de remplacer la table des caractéres autorisés par défaut en procédant comme
suit :

1. Ouvrez le fichier C:\Program Files\PIPC\Integrators\BA\CAST.Ul.WindowsService.exe.config dans un

éditeur de fichiers.
2. Modifiez la valeur ViewnameAllowedSpecialCharacters pour inclure les caracteres spéciaux.

Par exemple, si vous utilisez '@', ' ' ou '!l" dans les noms de vue, la valeur sera « @! ».

En raison de la nature du XML, certains caracteres réservés, tels que « & », nécessitent une séquence
d’échappement. Cela se traduirait par « &amp; » par exemple.
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3. Redémarrez les services Integrator.

4. Saisissez le nouveau Nom de vue. |l doit passer la validation puisque ViewnameAllowedSpecialCharacters a
été modifié.

ForceCreateTable

La fonctionnalité ForceCreateTable permet de forcer la création de certaines tables de publication associées a
des cibles SQL (SQL, Azure SQL, Oracle, AWS Redshift et HANA). Elle force la création d’une table de publication si
une table existante ne peut pas étre trouvée par Pl Integrator sur une cible de publication particuliere.
ForceCreateTable affecte toutes les vues de publication continue associées a des cibles SQL.

Elle se trouve dans C:\ProgramFiles\PIPC\Integrators\BA\CAST.Ul.WindowsService.exe.config.
Pour modifier la fonctionnalité ForceCreateTable, saisissez :
<add key="ForceCreateTable" value="false" />

Remarque : La valeur par défaut est « false ». Si I'utilisateur regle ForceCreateTable sur « true », Pl Integrator
créera une nouvelle table de publication si la table d’origine correspondant a cette vue est introuvable.

Créer une vue d'actif

Si vous souhaitez analyser vos données par actifs, créez une vue d'actif. Si vous souhaitez analyser vos données
par cadres d’événement, voir Créer une vue d'événement. Si vous souhaitez analyser vos données par actifs et
gue vous avez besoin de valeurs diffusées pour une analyse en temps réel ou une autre analyse, voir Créer une
vue de diffusion.

Cliquez sur l'icone du menu E, puis cliquez sur Créer une vue d'actif.

2. Donnez un nom a la vue.

Remarque : Respectez les conventions de dénomination de la cible sur laquelle cette vue sera publiée. Pour
plus d’informations, voir Noms de vues et points limites de destination.

3. Siplusieurs identités Pl AF ayant acces a Pl Integrator for Business Analytics sont affectées a votre compte
d’utilisateur, cliquez sur la liste déroulante Propriétaire de la vue, puis sélectionnez I'identité a laquelle vous
souhaitez autoriser I'acces a la vue.

Si votre compte d’utilisateur est associé a une seule identité Pl AF a laquelle I'accés a PI Integrator for
Business Analytics a été accordé, cette identité est automatiquement affectée a la vue.

Lorsque vous créez une vue pour la premiére fois, vous ne pouvez autoriser I'accés qu'a une seule identité Pl
AF. Vous pourrez autoriser I'acces a d'autres identités Pl AF ultérieurement. Pour plus d’informations, voir
Sécuriser vos vues.

4. Cliquez sur Create View (Créer une vue).

Dans le volet Actifs source , cliquez sur Créer une nouvelle forme.

Astuce : Vous pouvez utiliser la forme d’une vue existante en cliquant sur Importer une forme d’une autre
vue.

6. Utilisez les champs Serveur et Base de données pour consulter le serveur et |la base de données Pl AF
souhaités.

Remarque : Si le paramétre de sécurité d’usurpation d’identité de I'application est activé, vous verrez un
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bouton qui vous permettra de voir les identités d’accés aux données utilisées pour la vue.

Descendez dans la hiérarchie de I'arborescence Pl AF pour trouver I'actif que vous voulez analyser.

Faites glisser I'actif sur le volet Forme de I'actif.

Faire glisser un actif sur le volet Forme de I'actif

Select Data > Modify View

) Source Assets

> Publish

T Search Shape

Server CAST-INT-CL

T Asset Shape

Database Datacenter Demo

]
“

@ Assets
4 e Data Centers
- 8 Americas

- (‘a Atlanta

Thuto o rop and place

@ Calot

| » & colof

» D Colo2
» D Colo3

» ) Chicago

Attributes |

0 Select All

4 ColoNumber

& Zonel.Capacity

& Zonel.CapacityPercent
& Zonel.DCIE

& ZonelPUE

& ZonelPWR

& ZonelRollingCost

L'actif est ajouté a I'arborescence Asset Shape (Forme de I'actif).

eoeeococcoe

-

+ Matches

Lorsque vous sélectionnez un actif, le volet Attributs apparait et affiche les attributs de I'élément sélectionné.

9. Faites glisser des attributs a ajouter a votre forme.

Remarque : Vous pouvez trier, grouper et filtrer les attributs.

Ajout d'un attribut a I'aide de Déposer et placer automatiquement
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Select Data > Modify View > Publish

Ea Source Assets T Search Shape + Matches
Server CASTANT-CL v T_Asset Shape Found 5 Matches
Database Datacenter Demo oo 6 colet & @ ol
@ Colot
Assets
@ S @ colot
- fa Data Ceniers Q‘ t I & Colot
o uto drop and place
4 America; -
© ) & Zonel.Capacity @ Colot
4 fa Atlanta
| » @ Colol
» [ Colo2
» @ Colo3
» @ Chicago
P+ S
Attributes ‘
O select Al
4 ColoNumber

‘ & Zonel.Capacity

& ZonelCapacityPercent
& ZonelDCIE
& ZonelPUE
& ZonelPWR

eocoo

# ZonelRollingCost

-

Astuce : Si vous faites glisser un objet en dehors de I'arborescence Forme de I'actif, une infobulle contenant
le texte Déposer et placer automatiquement s’affiche. L'élément est ajouté automatiquement a
I'arborescence a un emplacement logique. Cet élément conserve la méme relation dans I'arborescence
Forme de I'actif qu'il a dans |'arborescence Pl AF. Si aucun emplacement ne semble logique, I'élément est
rejeté.

Remarque : Vous pouvez également placer 'objet dans I'arborescence Forme de I'actif. Une infobulle
s’affiche et vous indique comment ajouter I'actif comme entité parent, enfant ou jumeau. Ceci ne vous
empéche pas de déposer un objet dans un emplacement ne correspondant pas a la hiérarchie Pl AF.

Placement d'un élément dans I'arborescence Forme de I'actif
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Select Data » Modify View > Publish

@ Source Assets T Search Shape + Matches
Server CASTANT-CL v ToAsset Shape Found 5 Matches
Database Datacenter Demo oo 4 anitz;—ga\ert 7 % @ coo
b i Canacih P » @ Colot
6 Assets % @
r @ Data Centers Py » © Colot
r @ Americas Py » © Colot
| 4 e Atlanta .
» @ Colot
» @ Colo2
» [ Colo3
» D Chicago
» Ef) Houston
> @ MNew York

3 @ San Leandro

10. Faites glisser d'autres actifs et attributs sur le volet Forme de I'actif.
Le volet Correspondances affiche les éléments qui correspondent a la forme définie.

11. Pour afficher les données de tous les actifs partageant le méme modéle PI AF :

L

a. Cliquez sur l'icone 3 coté de I'actif pour ouvrir la boite de dialogue Editer les filtres.
b. Décochez la case Nom de I'actif.

c. Cochez la case Modeéle de I'actif et cliquez sur Enregistrer.

Le volet Correspondances affiche les données provenant de tous les actifs qui partagent ce modele.
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@ Source Assets T Search Shape ' Matches
. CASTINTCL . T Asset Shape Found 16 Matches
Database Datacenter Demo (s 4 4 @ ColoTemplate 4 % > @coor
& Zonel.Capacity a » @ Colot
@ Assets
& Zonel.CapacityPercent PR . » @ Colot
4 @ Data Centers @ Zonel PUR * % @ Colof
4 @ Americas & ZonelRollingCost " % > @ Colot
4 [ Atlanta » @ Colo2
» ) Colot » @ Colo2
» & Colo2 » @ Colo2
» [ Colo3 » @ Colo2
4 [ chicago » @ Colo2
» ) Colol » @ Colo3
» ) Colo2 » @ Colo3
» @ Colo3 » @ Coloz
» B Houston » @ Colo3
» B New York » @ Colo2
» @ san Leandro » @ Colod

12. Pour trouver des correspondances d'actifs similaires avec un jeu d'attributs différent :

a. Cliquez sur l'icbne # 3 coté de I'attribut facultatif,
b. Dans la boite de dialogue Editer les filtres, cochez la case Attribut facultatif, puis cliquez sur Enregistrer.

Par exemple, vous pouvez utiliser I'option Attribut facultatif si vous avez acquis de nouveaux équipements
au cours d'une certaine période et que les attributs du nouvel et de I'ancien équipement ne sont pas
identiques.

Edit Filters

# Attribute Name

Zonel.RollingCost

Attribute Category

Cost v

(+) Add Filter

¥ Optional Attribute (i

13. Cliguez sur Suivant pour voir un apergu du sous-ensemble de vos données.
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Les cent premieres lignes des 10 premieres correspondances provenant de la base de données Pl AF
s'affichent.

14. Pour affiner les résultats, vous pouvez ajouter plus de données, modifier les colonnes, filtrer les données, ou
modifier le mode de récupération des valeurs.

Pour plus d’informations, voir Modifier les données dans vos vues d'actif et d'événement.

Remarque : Etant donné que Pl Integrator for Business Analytics n’affiche que les 100 premiéres lignes pour
les 10 premiéres correspondances de votre forme, vous pouvez définir vos filtres de maniére a exclure ces
données. Dans ce cas, aucune donnée n'apparaitra sur la page, méme si votre vue configurée renvoie des
correspondances.

15. Cliquez sur Suivant.

— Asset View 1
Select Data > Modify View > Publish

Target Configuration Summary

S50L Server ¥ Shape and Matches

= There are 16 Matching Instances
* Run Once
Timeframe and Interval
Run on a Schedule
« Your Start Time is *-Bh

= Your End Time is *
= “Your Time Interval gets an interpolated
measurement Every 1 minute

16. Sélectionnez une cible dans la liste Configuration de la cible.

17. Cliquez sur Exécuter une fois pour créer la vue une fois, ou cliquez sur Exécuter selon une planification pour
ajouter de nouvelles données a la vue de facon périodique.

Remarque : Pour plus d’informations sur la publication de vues, voir Publier une vue selon une planification.

18. Cliquez sur Publier.

Colonne décalage

1. Cliquez sur la colonne pour ouvrir le volet Détails de la colonne.
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® Column Details

Name

Flow Rate
N

Data Content

Value

Column Offset

Data Type
Single

Remove Column

Apply Changes

2. Dans le champ Décalage de colonne, déplacez les colonnes vers le haut ou vers le bas par rapport aux autres
colonnes a l'aide des signes + et -. Selon la direction, la premiére ou le dernier nombre de lignes de la
colonne géneére une valeur nulle.

3. Lorsque vous avez terminé, cliquez sur Appliquer les modifications.

Créer une vue d'événement

Si vous souhaitez analyser vos données par cadres d'événement, créez une vue d'événement. Si vous souhaitez
analyser vos données par actifs, consultez Créer une vue d'actif. Si vous souhaitez analyser vos données par
actifs et que vous avez besoin de valeurs diffusées pour une analyse en temps réel ou une autre analyse, voir
Créer une vue de diffusion.

Remarque : ne renvoie que les cadres d'événement fermés (avec une heure de début et de fin valide). Il ne peut
pas publier des données de cadre d'événement ouvert.

1. Cliquez surl'icone du menu E, puis cliquez sur Créer une nouvelle vue d'événement.

2. Donnez un nom a la vue.

Remarque : Respectez les conventions de dénomination de la cible sur laquelle cette vue sera publiée. Pour
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plus d’informations, voir Noms de vues et points limites de destination.

3. Siplusieurs identités Pl AF ayant acces a Pl Integrator for Business Analytics sont affectées a votre compte
d'utilisateur, cliquez sur Autorisations d'accéss, puis sélectionnez l'identité a laquelle vous souhaitez
autoriser l'acces a la vue.

Si votre compte d’utilisateur est associé a une seule identité Pl AF a laquelle I'accés a PI Integrator for
Business Analytics a été accordé, cette identité est automatiquement affectée a la vue.

Lorsque vous créez une vue pour la premiére fois, vous ne pouvez autoriser I'accés qu'a une seule identité Pl
AF. Vous pourrez autoriser I'acces a d'autres identités Pl AF ultérieurement. Pour plus d'informations, voir
Sécuriser vos vues.

4. Cliquez sur Create View (Créer une vue).

Dans le volet Evénements source , cliquez sur Créer une nouvelle forme.

Conseil : Vous pouvez utiliser la forme d'une vue existante en cliquant sur Importer une forme d'une autre
vue.

6. Utilisez les champs Serveur et Base de données pour sélectionner le serveur et la base de données PI AF sur
lesquels les cadres d'événements ont été stockeés.

Remarque : si le parameéetre de sécurité d’usurpation d’identité de I'application est activé, il y aura un bouton
qui permettra a l'utilisateur de voir les identités d’accés aux données utilisées pour la vue.

7. Dans le volet Cadres d'événement, faites glisser les cadres d'événement et |'élément référencé dans le volet
Forme de I'événement.

Remarque : Cliquez sur l'icone Y dans le volet Evénements source et configurez les filtres pour afficher
uniguement les cadres d'événement qui vous intéressent. Vous pouvez, par exemple, filtrer par heure, par
actifs, par événements, et par modeles d'actif ou d'événement. Dans le volet Plus d'options, si Tous les
descendants est sélectionné, la recherche porte sur I'ensemble de la hiérarchie Pl AF. Sinon, seuls les cadres
d'événements au niveau de la racine sont examinés.

Conseil : pour profiter de conseils sur la création de formes d’événements, voir Conseils sur la création de
formes dans les vues d'événement.

8. Cliguez sur l'icbne a coté de I'élément pour ouvrir I'onglet Actifs et accéder directement a son
emplacement dans la hiérarchie PI AF.

9. Faites glisser les actifs et les attributs de I'arborescence Pl AF vers I'arborescence Forme de I'événement.

Pour obtenir des conseils sur la création de formes d'actifs, consultez Conseils sur la création de formes dans
les vues d'événement.

10. Pour récupérer les données de tous les cadres d'événement partageant le méme modele Pl AF :

2

. A # L .y
a. Cliquez surl'icone © enregard du cadre d'événement dans l'arborescence Forme de I'événement.
b. Décochez la case Nom du cadre d'événement.
c. Cochez la case Modeéle de cadre d'événement et cliquez sur Enregistrer.

11. Cliquez sur Suivant pour voir un apercu du sous-ensemble de vos données.

L'heure de début affichée correspond a I'heure de début du premier cadre d'événement ajouté a la forme.
Pl Integrator for Business Analytics ne récupére que les cadres d'événement fermés.

12. Pour affiner les résultats, vous pouvez ajouter plus de données, modifier les colonnes, filtrer les données, ou
modifier le mode de récupération des valeurs. Pour plus d'informations, voir Modifier les données dans vos
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Remarque : Etant donné que Pl Integrator for Business Analytics n'affiche que les 100 premiéres lignes pour
les 10 premieres correspondances de votre forme, vous pourriez définir vos filtres de sorte qu'ils excluent
ces données. Dans ce cas, aucune donnée n'apparaitra sur la page, méme si votre vue configurée renvoie des

correspondances valides.

13. Cliquez sur Suivant pour publier vos données.

14. Sélectionnez une cible dans la liste Configuration de la cible.

15. Cliquez sur Exécuter une fois pour publier la vue une fois, ou cliquez sur Exécuter selon une planification
pour ajouter de nouvelles données a la vue de fagon périodique.

16. Cliguez sur Publish (Publier).

Conseils sur la création de formes dans les vues d'événement

Sélectionnez le cadre d'événement a inclure dans votre vue d'événement a la page Sélectionner des données.

La page Sélectionner des données

Select Data > Modify View > Publish

"H Source Events

Server
O

Database

DFPIAF v

OSIPharmaCIP c v

l Y ‘ Enter Event name or string match pattern @.l

) EPSHUTDOWN

Event Frames Assets

) EPRINSE

| -

) EPWASH
» D CIP_422_SKID
» ) CIP_432_SKID

» (D Environmental

1 oo temnlate

s — -
Attributes | Filter @

O Select All

v " Search Shape

4 CIP Flow Rate (to User)
4 CIP Flow Rate (to User) High
& CIP Flow Rate (to User) Low

4 CIP Flow Rate (to User) Parameter

2 & & ¢ @

& CIP Supply Pressure

-

(4)
4 Event Shape @

4 M CIP_SKID_EPRINSE:1-1
4 [DEPRINSE
4 CIF Flow Rate (fo User)
4 CIF Flow Rate (to User) High
& CIP Flow Rate (fo User) Low
4 4 CONNECTING
4 DCIP_124_SKID
4 ACID SUPFLY FLOW

Q-

s

& ACID SUPPLY TANK LEVEL CON... &

& CIP Acid Tank Level

& CIF Caustic Tank Level

s
s

X %X X X M X X X X 2 X

+ Matches

(8)

Found 62 Matches

»

»

v

v

hd

hd

v

v

v

v

v

v

v

v

hd

v

v

v

v

v

" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
"4 CIP_SKID_EPRINSE:1-1
"# CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
"H CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1

"4 CIP_SKID_EPRINSE:1-1

Next

Le tableau suivant décrit les différents éléments de la page et |la facon de les utiliser pour créer la forme de votre

vue d'événement.
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unNombre Description

1 Indiquez le serveur et la base de données sur lesquels
se trouve la base de données Pl AF.

2 Cliquez sur I'onglet Cadre d'événement pour afficher
les cadres d'événement. Cliquez sur I'onglet Actifs
pour afficher les éléments.

3 Pour filtrer la liste de cadres d'événement, entrez une
chaine de caractéres de recherche pour le nom du
cadre d'événement.

4 Le volet Rechercher une forme dans lequel vous
indiquez le motif de recherche de votre vue
d'événement.

5 Le volet Forme de I'événement dans lequel vous
pouvez ajouter des cadres d'événement et leurs
attributs, et des éléments référencés et leurs attributs.

6 Le volet Attributs affiche les attributs que vous pouvez
ajouter au volet Forme de I'événement.

Conseil : Cliquez o sur a coté de l'attribut pour
ouvrir une fenétre qui affiche des données a propos
de l'attribut.

7 Liez un élément référencé a sa propre forme de
recherche distincte. Ne le faites que si vous souhaitez
inclure des éléments et attributs parents de I'élément
lié.

8 Le volet Correspondances est un apercu des actifs et
des cadres d'événement définis dans votre recherche
de forme pour lesquels des correspondances sont
trouvées dans la base de données Pl AF.

Lorsque vous travaillez avec la forme de I'événement :

¢ Vous pouvez ajouter autant de cadres d'événement que vous souhaitez, mais il ne peut y avoir qu'un seul
cadre d'événement a chaque niveau de la hiérarchie du cadre d'événement, comme illustré ci-dessous. Par
exemple, le nceud de forme de I'événement ne peut comporter qu'un seul cadre d'événement enfant. Faites
glisser le cadre d'événement du volet Cadres d'événement sur le volet Forme de I'événement.

Forme de I'événement : un nceud de forme d'événement avec un cadre d'événement enfant
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M4 Search Shape

¥ Event Shape

4 d CIP_SKID_EPRINSE:1-1 &S %
£ EPRINSE % & X

4 4 CONNECTING &S x
£ CIP_124_SKID % & x

¢ Chaque cadre d'événement ne peut comporter qu'un seul élément référencé. Faites glisser I'élément
référencé du volet Cadres d'événement sur la forme de I'événement.

¢ Cliquez sur le cadre d'événement dans le volet Cadres d'événement pour afficher ses attributs dans le volet
Attributs. Faites glisser un de ses attributs dans la forme de I'événement.

e Dans le volet Evénements source, cliquez sur I'onglet Cadres d'événement, puis cliquez sur la loupe située
en regard d'un élément pour passer au volet Actifs et voir I'emplacement de I'élément dans la hiérarchie PI
AF.

Rechercher un élément dans la hiérarchie Pl AF
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H4 Source Events v
<EUE DFPIAF v
el 0SIPharmaCIP o v

Y | Enter Event name or string match pattemn

Event Frames Assets

» "8 CIP_SKID_EFPRINSE:1-1
4 "4 CIP_SKID_EPRINSE:1-1

» " CONNECTING

» " DOWNLOADING

» "H STARTING

» " RUNNING

» "H UPLOADING

» "8 COMPLETE

FD EPRINSE Q
» D CIP_124_SKID Q

» "4 CIP_SKID_EPRINSE:1-1

» PH CIP_SKID_EPRINSE:1-1

¢ La page Attributs affiche les attributs pour I'élément sélectionné. Faites glisser un de ses attributs dans la
forme de I'événement.

e Les cadres d'événement et les éléments peuvent uniquement étre déposés dans l'arborescence Forme de
I'événement a I'aide de Déposer et placer automatiquement si cela répond a une logique établie. Si vous
faites glisser un élément vers une zone ouverte en dessous de la forme de I'événement, une infobulle affiche
Déposer et placer automatiquement. Pl Integrator for Business Analytics tente de faire correspondre la
relation de 'objet a d'autres objets de la hiérarchie Pl AF en I'appliquant a la forme. Déposer et placer
automatiquement permet uniquement d'ajouter I'objet déplacé a la forme lorsque I'objet est un parent ou
enfant immédiat d'un objet déja présent dans votre forme.

Déposer et placer automatiquement des objets
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M Search Shape
" Event Shape
4 by &S x
£0) EPRINSE G & x
FH CONNECTING & x
O,

Auto drop and place
&0 CIP_124_SKID

Conseil : si vous ne connaissez pas Pl Integrator for Business Analytics, commencez par utiliser Déposer et
placer automatiquement.

e Lorsque vous faites glisser un cadre d'événement, un élément, ou un attribut dans I'arborescence Forme de
I'événement, une infobulle vous indique si vous devez déposer I'objet en tant que parent, frére/sceur, ou
enfant.

Remarque : Ceci ne vous empéche pas de déposer un objet dans un emplacement ne correspondant pas a la
hiérarchie Pl AF.

Faire glisser et déposer des objets dans une arborescence de formes
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M4 Search Shape

" Event Shape

4 " CIP_SKID_EPRINSE:1-1 & x
£7) EPRINSE % &S x
4 " CONNECTING & x
,ﬁﬁ@: 124 SKID _ % & %

Drop as child

& ACID SUPPLY FLOW

Quand et comment utiliser des actifs liés
Dans la plupart des cas, vous créerez votre forme dans le volet Forme de I'événement en ajoutant votre cadre

d'événement, cadre d'événement enfant et éléments référencés, ainsi que leurs attributs, comme illustré dans la
capture d'écran ci-dessous.
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M4 Search Shape

*H Event Shape

4 "4 CIP_SKID_EPRINSE:1-1
4 [ EPRINSE %
& CIF Flow Rate (to User)
& CIP Flow Rate (to User) High
& CIP Flow Rate (to User) Low
4 P CONNECTING
4 FACIP_124_SKID %
& ACID SUPPLY FLOW
& ACID SUPPLY TANK LEVEL CONTROL

& CIP Acid Tank Level

B 0% % % % % % %R N R
X X X X X X X X xXx x X

& CIP Caustic Tank Level

Dans la forme de I'événement, vous ne pouvez ajouter des éléments que sous I'élément référencé par le cadre
d'événement de niveau supérieur. Dans |'exemple ci-dessus, vous ne pouvez pas ajouter d'éléments parents au
dessus de I'élément CIP_124 SKID dans la hiérarchie Pl AF. Si vous ajoutez besoin d'attributs ou d'éléments d'un
parent ou d'un élément référencé, cliquez sur le lien Actifs liés pour ouvrir le volet Forme de I'actif. (Voir la
capture d'écran ci-dessous.)

Lien d'actifs liés
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*H Search Shape

*H Event Shape

4 WY ClP_SKID_EPRINSE:1-1

OO

4 FEPRINSE
& CIP Flow Rate (to User)
& CIP Flow Rate (to User) High
& CIP Flow Rate (to User) Low
4 Y COMNECTING

4 FACIP_124_SKID

CFee

B 0% % % % % % % R R R
X X %X X X X X X X X X

& ACID SUPPLY FLOW
& ACID SUPPLY TANK LEVEL CONTROL
& CIP Acid Tank Level

& CIP Caustic Tank Level

Lorsque vous cliquez sur l'icone d'actifs liés, un second volet, Forme de I'actif, s'affiche. L'élément lié, ses
attributs et tous les éléments et attributs dérivés de celui-ci sont déplacés dans le volet Forme de I'actif. Dans cet
exemple, I'élément CIP_124 SKID est copié dans le volet Forme de I'actif avec les quatre attributs. Ceci est
illustré dans la capture d'écran ci-dessous.

Forme de I'actif ajoutée a la forme de recherche
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M Search Shape
HH Event Shape
4 " CIP_SKID_EPRINSE:1-1
4 FIEPRINSE
& CIP Flow Rate (to User)
& CIF Flow Rate (to User) High
& CIP Flow Rate (to User) Low
4 P CONNECTING

£D CIP_124_SKID

T= Asset Shape

4 [CIP_124_SKID
& ACID SUPPLY FLOW
& ACID SUPPLY TANK LEVEL CONTROL
& CIP Acid Tank Level

4 CIP Caustic Tank Level

Pl Integrator for Business Analytics
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B O% % % R R K
X X X X X XN X

B % % % N
X X X X 2

Dans le volet Forme de I'actif, vous pouvez ajouter des éléments et leurs attributs quel que soit leur
emplacement dans la hiérarchie Pl AF. Dans cet exemple, les éléments L1 HuMAB, NorthStreetPllant et

Philadelphia sont ajoutés a la forme de I'actif.

Eléments ajoutés a la forme de I'actif

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved.

Page 115



AV=VA"

Select Data > Modify View > Publish

"4 Source Events

Pl Integrator for Business Analytics
Comment utiliser Pl Integrator for Business Analytics

w " Search Shape

Server DFPIAF . "8 Event Shape
Database OSIPharmaCIP . 4 "4 CIP_SKID_EPRINSE:1-1 S %
4 FJEPRINSE % & X
I h & | Enter Event name or string match pattern & CIP Flow Rate (to User) & x
Event Frames Assets & CIP Flow Rate (to User) High a4
4 [ Data Centers & CIP Flow Rate (to User) Low S x
» € Americas 4 i CONNECTING S x
4 () PharmaCO KD CIP_124_SKID Y #x
4 ) North America
4 () Philadelphia
4 [ NorthstreetPllant
4 @ L1 HuMAB
&) CIP_000_SKID
» @ CIP_123_SKID
» @ CIP_124_SKID ‘ T Asset Shape
» ) CIP_422_SKID 4 [ Philadelphia & x
» € CIP_432_SKID 4 @) NorthstreetPllant # x
» (D Environmental 4 @ L1 HuMAB S x
&) no template 4 QcCIP_124_SKID %G S X
» (D syringe & ACID SUPPLY FLOW & n
» D T.STA 4P ACID SUPPLY TANK LEVEL CONTROL #x
e & CIP Acid Tank Level & x
» QT 4 CIP Caustic Tank Level & n
» @T112

Si vous cliquez sur le lien des actifs liés dans la forme de I'actif, le volet Forme de I'actif disparait, et I'actif et tous
ses attributs sont renvoyés vers le volet Forme de I'événement.

Remarque : L'unique raison de la séparation d'un élément dans le volet Forme de I'actif vise a inclure des

éléments et attributs qui se situent au-dessus de celui-ci dan

s la hiérarchie Pl AF. En fonction de la complexité de

la forme, la publication de la vue peut prendre plus de temps.

Créer une vue de diffusion

Remarque : Cette fonctionnalité est disponible dans Pl Integrator for Business Analytics Edition Advanced.

Voici une vue d'ensemble des principales étapes de création
accéder a la procédure spécifique.

1. Définir la forme de la vue de diffusion.

2. Choisissez le schéma a utiliser avec votre vue selon I'une

Utiliser un schéma importé d'un fichier

Utiliser un schéma importé d'un registre de schémas

e Utiliser un schéma généré

d'une vue de diffusion. Cliquez sur les liens pour

des approches suivantes :

Pour plus d'informations sur les schémas, voir A propos des schémas.
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Pour plus d'informations sur les déclencheurs de message, voir A propos des déclencheurs de message.

4. (Facultatif) Données de remplissage.

(Facultatif) Filtrer les données.

Enregistrer un schéma dans le registre de schémas

Un schéma importé a partir d'un fichier ou un schéma généré peut étre enregistré dans le registre de schémas.
Tous les schémas, quelle que soit leur source, sont enregistrés sous des schémas Avro. Lorsque le schéma est
enregistré, le schéma dans le volet Concepteur de message sera lié selon les regles appliquées par le registre de
schémas. Vous souhaiterez donc apporter des modifications avant d'enregistrer le schéma dans le registre.

Remarque : Vous pouvez toujours supprimer la connexion de votre schéma dans le volet Concepteur de message

du registre de schémas en cliquant sur Cesser d'utiliser le Registre.

Dans cette version, les schémas ne peuvent étre enregistrés que dans un registre de schémas. lls ne peuvent pas

étre enregistrés dans un fichier.

1. Dans la page Modifier la vue, cliquez sur Enregistrer le schéma dans le

registre.

Remarque : Options du schémadoit étre sélectionné pour que ce bouton s'affiche.

Avant d'enregistrer le schéma dans le registre, vous pouvez modifier et supprimer les propriétés du schéma.
Vous pouvez également réorganiser les propriétés si le schéma n'est pas synchronisé avec la forme de I'actif,
c'est-a-dire, s'il est défini en tant que Forme libre. Faites glisser et déposez les propriétés pour changer leur

ordre.

Message Designer

Schema Options Message Trigger Backfill Data
Free-form mode Trigger a new message when 1 key Do not backfill data
values change

Message Filters
0 filters

You are not syncing (free-form) your schema to the asset shape.

- | Save Schema to Registry

mport Schema Select Schema Structure
Select Import Source - | Fres-form

{
"Timestamp”: "|(¥) TimeStamp ",
"Zonel.Capacity”: "|4 Zone1l.Capacity (Valug) v,
“Zonel.CapacityPercent”: " 4 Zonel CapacityPercent (Value) v ",
“"Zonel .PWR": "4 Zonel PWR (Value) ",
“Zonel.RollingCost": "|4p Zone1 RollingCost (Value) v,
"ColoTemplate™: “|fColol1 (Name) v ["

}
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2. Dans la fenétre Enregistrer le schéma dans le registre, indiquez I'emplacement du registre de schémas dans
le champ URL du registre de schémas.

Conseil : Commencez a saisir dans le champ, et une liste des registres de schémas disponibles s'affiche.

3. Entrez un nom pour votre schéma dans le champ Sujet du schéma, puis cliquez sur Enregistrer.

Vous pouvez toujours modifier des propriétés du schéma. Vous ne pouvez toutefois plus réorganiser ou
supprimer des propriétés du schéma.

You are using the schema "ZoneSchema” from the schema registry at http://10.4.200.128:8081.

mport Schema

[¥5]

elect Schema Structure

"=

"Timestamp": "[(¥) TimeStamp v, &S X
"Zonel.Capacity": "4 Zonei.Capacity (Value) ", & K
"Zonel.CapacityPercent™: "|4 Zonel.CapacityPercent (Value) v |", &S K
“Zonel.PWR": "|4 Zonel.PWR (Value) v, R
“Zonel.RollingCost™: "|4f Zonel RolingCost (Value) v, & R
"ColoTemplate™: "/ Colol (Name) " F X

Remarque : Vous pouvez cliquer sur Cesser d'utiliser le Registre pour supprimer la connexion de ce schéma
au registre de schémas. Lorsque vous avez terminé, vous pouvez continuer a apporter des modifications
comme avant I'enregistrement du schéma.

A propos des déclencheurs de message

Le déclencheur de message détermine la fréquence et les conditions selon lesquelles un message est envoyé a la
cible de publication. Il existe deux types de déclencheurs : un basé sur un intervalle de temps et I'autre basé sur
les modifications apportées aux valeurs clés. Toutes les valeurs clés doivent étre des attributs de PI Point. Ces
options sont présentées dans la capture d'écran ci-dessous.
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G} Trigger a message in regular time intervals:

#) Trigger a new message when the key value(s) selected below have changed
@ #) Trigger a message when any of the selected key values have changed

Trigger a message when all of the selected key values have changed

Trigger on Archive Data (@ Snapshot Data
¢ 1. Déclencheur de message basé sur le temps
e 2. Déclencheur de message basé sur une modification des valeurs de données

Les sections ci-dessous expliquent comment utiliser ces options.

Déclencher un message a des intervalles de temps réguliers

Vous pouvez définir un intervalle de temps compris entre 30 secondes et 12 mois. Un message est envoyé a
I'intervalle de temps spécifié, que des modifications aient été apportées ou non aux données. Les vues avec ce
type de déclencheur de message sont appelées des vues de diffusion continue planifiée.

Remarque : En fonction de la taille du message et des mémoires tampons, un délai de réception des données
dans la cible est possible. La latence d'une extrémité a I'autre, a savoir l'intervalle entre I'entrée d'une valeur
dans le Pl System et son entrée dans le systeme cible, peut étre supérieure a l'intervalle entre les déclencheurs
de message.

Identifier les clés déclenchant le message

Vous pouvez choisir les changements de clé qui déclencheront un message. Les vues avec ce type de
déclencheur de message sont appelées des vues de diffusion déclenchées par une valeur clé. Dans la capture
d'écran ci-dessous, deux clés correspondant aux Pl Tags Zonel.PWR et Zonel.RollingCost, sont sélectionnées.
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Trigger a message in regular time in'tervals:l 1 (v || minutes “ |

® Trigger a new message when the key value(s) selected below have changed A _T_

#® Trigger a message when any of the selected key values have changed

() Trigger a message when all of the selected key values have changed A \'/

Triggeron () Archive Data (®) Snapshot Data (] v
Qe Message Content
{
“Timestamp”: *|(®) TimeStamp v s x
O "Zonel.Capacity”: "|4 Zonel.Capacily (Value) v, s %
) “Zonel.CapacityPercent”: "|4 Zonel.CapacityPercent (Value) v |, s x
@ “Zonel.PWR": " Zonel PWR (Value) v, s %
¥ |  "Zonel.RollingCost": "[ Zonel RolingCost (Value) v s X
"ColoTemplate™: | Colo1 (Name) v s %
¥

Une fois les clés identifiées, vous pouvez personnaliser les conditions selon lesquelles un message est déclenché.
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Trigger a message in regular time in'ten-'als:l 1 w || minutes vl

® Trigger a new message when the key value(s) selected below have changed A _T_

#® Trigger a message when any of the selected key values have changed

Trigger a message when all of the selected key values have changed A \.,_/

Trigger on Archive Data (® Snapshot Data =] v
Q‘. Message Content
{
"Timestamp": “|@Timestamp r|", S x
“"Zonel.Capacity™: |4 Zonei.Capacity (Value) v |, & R
"Zonel.CapacityPercent”: "|OZune1.Capacit!.fF'ercent (Value) '|", F X
= “Zonel.PWR": |4 Zonei PWR (Value) e &S R
L “Zonel.RollingCost™: " Zonel RollingCost (Value) v |, B
"ColoTemplate™: |[§§j Colo1 (Name) LA S X
¥

Ces choix sont décrits ci-dessous.

Déclencher un message en cas de changement de valeur clé

La premiére option entraine le déclenchement d'un message si les données de I'une des clés sélectionnées
changent.

Trigger @ message in reqular time inter'.'als:l 1 bl ” minuies |

® Trigger a new message when the key value(s) selected below have changed

# Trigger a message when any of the selected key values have changed

Trigger a message when all of the selected key values have changed
Trigger on Archive Data (® Snapshot Data

Vous trouverez ci-dessous une représentation graphique de cette option. Elle affiche deux clés : Clé A et Clé B.
Des messages sont déclenchés si une des clés change, comme indiqué par les points. Des messages sont envoyés
atl, t2, t3, t4 et t5, comme indiqué par les coches.
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t1 t2 t3 t4 t5

Key A c".,, —T

Key B Q\

[oee] v v vv v

Déclencher un message en cas de changement de toutes les valeurs clés uniquement

La deuxiéme option entraine I'envoi d'un message uniquement lorsque les valeurs de toutes les clés changent.

Trigger a message in regular time intervals: | 1 b ” minutess |

# Trigger @ new message when the key value(s) selected below have changed

Trigger a message when any of the selected key values have changed

#) Trigger a meszsage when all of the selected key values have changed

Trigger on Archive Data (® Snapshot Data

Elle est illustrée dans le graphique suivant. Trois messages sont envoyés a t2, t4 et t7. Les points verts indiquent
quelles valeurs modifiées sont enregistrées. La valeur a t5 n'est pas envoyée, comme indiqué par le point vide.
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Key A Q\ l

Key B Qs

t1  t2 t3 t4 t5 t6 t7

1 v v v

Type de données déclenchant le message

En plus d'identifier les données les plus critiques sur lesquelles il faut se concentrer, vous pouvez également
spécifier si vous voulez utiliser des valeurs d'archive ou d'instantané pour déclencher le message.

Trigger a message in regular time intervals: | 1 W ” minuiess |

® Trigger 2 new message when the key value(s) selected below have changed
Trigger a message when any of the selected key values have changed

# Trigger a message when all of the selected key values have changed

Trigger on Archive Data (® Snapshot Data

Configurer quand les messages sont envoyés

Lisez la rubrique de A propos des déclencheurs de message. Elle fournit le contexte dont vous avez besoin pour
définir le déclencheur de message.

Vous devez générer votre schéma avant de définir le déclencheur de message.

1. Dans la page Modifier la vue, cliquez sur Déclencheur de message.

Option Description
A Déclencher un message a des Les messages sont envoyés a
intervalles réguliers I'intervalle spécifié, qu'une
modification ait été apportée ou
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Option Description
non a la valeur clé.
B Envoyer un nouveau message Les messages sont envoyés si des

modifications sont apportées aux
valeurs clé.

lorsque la ou les valeurs clés
sélectionnées ci-dessous ont
changé

¢ Choisissez I'une des options suivantes :Si vous avez sélectionné l'option A, passez a I'étape 3.
¢ Sivous avez sélectionné |'option B, passez a |'étape 4.
2. (A uniquement) Cliquez sur les listes pour spécifier l'intervalle de temps entre les messages.
Vous pouvez spécifier des intervalles compris entre 30 secondes et 12 mois.

Intervalle de temps de message

# Trigger a message in regular time intervals: | 1 w | minutesw

Trigger a new message when the key value(s 1 seconds
2 minutes
3 hours
4 days
3 months
s}
7
8
-

3. (B uniguement) Suivez les étapes suivantes :
a. Sélectionnez les clés dont les valeurs déclencheront le message.

b. Sélectionnez une des options suivantes :

Option Description

Déclencher un message en cas de changement de
I'une des valeurs clés sélectionnées

Une seule valeur clé doit changer pour déclencher
un message

Déclencher un message en cas de changement de
toutes les valeurs clés sélectionnées

Toutes les valeurs clés doivent changer pour
déclencher un message

Choisissez si le message est déclenché selon des changements de la valeur d'instantané ou de la valeur

d'archive des clés sélectionnées.

Pour plus d'informations sur I'impact de ces choix sur les données envoyées, voir A propos des déclencheurs

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved.

Page 124




'AV EVA\TM Pl Integrator for Business Analytics

Comment utiliser Pl Integrator for Business Analytics

de message.

Quelles données sont envoyées a la cible ?

Aprés avoir configuré le moment ol un message est envoyé, indiquez quel type de données est envoyé. Pour
chaque propriété, vous pouvez choisir dans une liste d'options de valeur.

Remarque : Pour les scénarios basés sur une clé, le type de données qui déclenche le message (archive ou
instantané) est distinct des données effectivement envoyées a la cible. Par exemple, vous pouvez spécifier
gu'une modification apportée aux données d'instantané d'une clé déclenche le message. Vous pouvez toutefois
préciser que la valeur d'archive de la clé (et non la valeur d'instantané) est envoyée a la cible. Dans la capture
d'écran ci-dessous, Valeur est sélectionné pour la propriété Zonel.Capacity.

ng Message Content
{

"Timestamp™: "|( TimeStamp ",

v "Zonel.Capacity": "|" Zone1 Capacity (Valueg) L

. ) . Template P
Zonel.CapacityPerc Category lue) + |7,
Path

Description

Guid

i "Zonel.RollingCost™ Y L

i "Zonel.PWR": |4 Zon

"ColoTemplate”: EEH Ifnafglﬂecurded Value
]. Average

Minimum

Maximum

Range

Standard Deviation
Standard Deviation (Population)
Count
Percent Good
Snapshot
Time optoens
TimeStamp
Year -

Les scénarios suivants décrivent les conditions dans lesquelles un message est déclenché.

e Scénario 1: Données d'intervalle
e Scénario 2 : Tout changement de clé de données d'archives déclenche un message

e Scénario 3 : Tout changement de clé de données d'instantané déclenche un message
Dans chaque situation, les propriétés peuvent étre configurées avec une option de valeur différente. Les

scénarios décrivent |'effet de la configuration des propriétés avec les options Valeur, Derniére valeur enregistrée
et Instantané.
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Scénario 1 : Données d'intervalle

Les données d'intervalle sont envoyées aux intervalles spécifiés. Dans I'exemple suivant, t1 et t4 marquent le
début et la fin de I'intervalle de temps. L'horodatage du message est I'heure a t4. Les données qui sont envoyées
dépendent de I'option de valeur sélectionnée pour la propriété :

¢ Sila propriété est configurée pour une valeur d'instantané, la valeur d'instantané a t3 est alors envoyée avec
I'horodatage t4. (1)

¢ Sila propriété est configurée pour la derniére valeur enregistrée, la derniere valeur enregistrée avant
I'norodatage du message est alors envoyée. Dans cet exemple, la valeur d'archive a t2 est envoyée avec
I'horodatage de message t4. (2)

¢ Sila propriété est configurée pour une valeur, les valeurs d'archive et d'instantané a l'intervalle de temps
sont alors utilisées pour calculer la valeur interpolée a t4. (3)

time interval

tl t2 t3 t4

2/
O O

message time stampJ

Key

Valeur d'archive

Valeur instantanée

Valeur interpolée

Scénario 2 : Tout changement de clé de données d'archives déclenche un message

Lorsqu'une valeur d'instantané est entrée a t3, elle déclenche I'archivage (a t2) de la valeur d'instantané a t2. La
valeur d'archive a t2 déclenche le message et I'horodatage est t2. L'illustration suivante montre les données qui

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 126



'AV EVA\TM Pl Integrator for Business Analytics

Comment utiliser Pl Integrator for Business Analytics

sont envoyées a la cible en fonction de I'option de valeur sélectionnée :

¢ Si A est configuré pour des données de derniére valeur enregistrée, la valeur d'archive a t2 est alors envoyée
(1).

¢ Si A est configuré pour des données de valeur, la valeur interpolée a t2 est alors envoyée (1).
De méme, les données qui sont envoyées pour la propriété B dépendent de sa configuration :

¢ Laderniére valeur enregistrée est la premiére valeur dans Pl Data Archive avant ou au moment de
I'norodatage du message (t2). Dans cet exemple, si B est configuré pour la derniere valeur enregistrée, la
valeur d'archive qui constitue la premiéere valeur avant t2 est alors envoyée (2).

¢ Si B est configuré pour des données de valeur, les données sont alors interpolées a t2 a I'aide de la valeur
d'archive a t1 et de la valeur d'instantané a t3 (3).

message time stamp

—

tl t2 t3

v Key A

Key B

Key

Valeur d'archive

Valeur instantanée

Valeur interpolée

Scénario 3 : Tout changement de clé de données d'instantané déclenche un message

Un changement de l'une des clés de la valeur d'instantané déclenche un message. Dans cet exemple, le message
est déclenché par la Clé A. Les données d'instantané de la Clé A déclenchent un message a t3 et I'horodatage du
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message est t3. La valeur d'instantané a t3 est renvoyée pour la Clé A (1).

La Clé B n'est pas sélectionnée comme clé de déclenchement. Les valeurs d'une deuxiéme clé, Clé B, sont
déterminées par sa configuration :

¢ Sila Clé B est configurée pour la derniére valeur enregistrée, la valeur d'archive a t1 avec I'horodatage du
message t3 est alors envoyée. (2)

¢ Sila Clé B est configurée pour une valeur d'instantané, la valeur d'instantané a t2 est alors envoyée avec
I'horodatage du message t3. (3)

¢ Sila Clé B est configurée pour une valeur, la valeur interpolée a t3 est alors envoyée avec I'horodatage t3. (4)

message time stamp_\L

t1 t2 t2

v Key A

Key B

Key

Valeur d'archive

Valeur instantanée

Valeur interpolée

Si vous sélectionnez I'option Déclencher un message en cas de changement de toutes les valeurs clés
sélectionnées, toutes les clés doivent changer pour qu'un message soit déclenché. Des valeurs d'instantané sont
renvoyées pour toutes les clés sélectionnées, et I'horodatage de la derniére clé pour renvoyer une valeur
d'instantané correspond a I'horodatage du message.

Apercus de données de vue de diffusion

Les apercus des données affichent toujours des valeurs d'archive. Si le résultat des paramétres du déclencheur
de message est tel que des données d'instantané sont envoyées a la cible, ces données d'instantané
n'apparaissent pas dans I'apercu. Vous verrez des valeurs d'archive.
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Données dans le désordre

Les vues de diffusion déclenchées par une clé ne déclencheront pas un message sur un événement dont
I'horodatage est antérieur a I'horodatage du dernier événement.

Données de remplissage

Lorsque vous publiez vos données, les valeurs actuelles de votre forme sont envoyées a la cible. Vous pouvez
obtenir des valeurs antérieures en remplissant vos données.

Remarque : les données de remblayage sont prises en charge avec des vues de diffusion planifiées et permettent
d’effectuer des mises a jour automatiques des données. Il n'est pas pris en charge avec les vues de diffusion
déclenchées par une valeur clé.

1
2
3.
4

Dans la page Modifier la vue, cliquez sur Données de remplissage.
Cliquez sur Remplir les données a partir de.
Cliquez sur l'icone de calendrier dans la zone de texte pour ouvrir le calendrier.

Faites défiler le calendrier et cliquez sur la date de début.

Définir la forme de la vue de diffusion

Si vous souhaitez analyser vos données par actifs, consultez Créer une vue d'actif. Si vous souhaitez analyser vos
données par cadres d'événements, consultez Créer une vue d'événement.

Cliquez sur l'icbne du menu E, puis cliquez sur Créer une vue de diffusion.

Donnez un nom a la vue.

Remarque : Respectez les conventions de dénomination de la cible sur laquelle cette vue sera publiée. Pour
plus d’informations, voir Noms de vues et points limites de destination.

Si plusieurs identités Pl AF ayant accés a Pl Integrator for Business Analytics sont affectées a votre compte
d'utilisateur, cliquez sur Autorisations d'acces, puis sélectionnez l'identité a laquelle vous accorderez I'acces
alavue.

Si votre compte d’utilisateur est associé a une seule identité Pl AF a laquelle I'accés a PI Integrator for
Business Analytics a été accordé, cette identité est automatiquement affectée a la vue.

Lorsque vous créez une vue pour la premiére fois, vous ne pouvez autoriser I'accés qu'a une seule identité Pl
AF. Vous pourrez autoriser I'acces a d'autres identités Pl AF ultérieurement. Pour plus d'informations, voir
Sécuriser vos vues.

Cliquez sur Create View (Créer une vue).

Dans le volet Actifs source , cliquez sur Créer une nouvelle forme.

Conseil : Vous pouvez utiliser la forme d'une vue existante en cliquant sur Importer une forme d'une autre
vue.

Utilisez les champs Serveur et Base de données pour consulter le serveur et la base de données Pl AF
souhaités.

Remarque : si I'usurpation d’identité est activée, il y aura un bouton qui permettra a I'utilisateur de voir les

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 129



AV=VA"

Pl Integrator for Business Analytics

Comment utiliser Pl Integrator for Business Analytics

identités d’acces aux données utilisées pour la vue.

Descendez dans la hiérarchie de I'arborescence Pl AF pour trouver I'actif que vous voulez analyser.

Faites glisser I'actif sur le volet Forme de I'actif.

Faire glisser un actif sur le volet Forme de I'actif

Select Data > Modify View

) Source Assets

> Publish

T Search Shape

Server CAST-INT-CL

T Asset Shape

Database Datacenter Demo

]
“

@ Assets
4 e Data Centers
- 8 Americas

- (‘a Atlanta

Thuto o rop and place

@ Calot

| » & colof

» D Colo2
» D Colo3

» ) Chicago

Attributes |

0 Select All

4 ColoNumber

& Zonel.Capacity

& Zonel.CapacityPercent
& Zonel.DCIE

& ZonelPUE

& ZonelPWR

& ZonelRollingCost

eoeeococcoe

-

L'actif est ajouté a I'arborescence Forme de |'actif.

+ Matches

Lorsque vous sélectionnez un actif, le volet Attributs apparait et affiche les attributs de I'élément sélectionné.

9. Faites glisser des attributs a ajouter a votre forme.

Remarque : Vous pouvez trier les attributs, les regrouper par catégorie, ou filtrer les attributs a afficher pour
trouver plus facilement ceux que vous cherchez.

Ajout d'un attribut a I'aide de Déposer et placer automatiquement
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Ea Source Assets T Search Shape + Matches
Server CASTANT-CL - T_Asset Shape Found 5 Matches
Database Datacenter Demo ooy & Colot s X & colot
@ Colot
Assets
CD ) @ Colot
A fa Data Centers Q‘ t | @ colof
L utoc drop and place
4 America -
Ea § & Zonel.Capacity @ Colol
4 (@ Atlanta
| » @ Colot
» @ Colo2
» @ Colo3
» @ Chicago
P+ S
Attributes ‘
O Select All
4 ColoNumber

‘ & Zonel.Capacity

& ZonelCapacityPercent
& ZonelDCIE
& ZonelPUE
& ZonelPWR

eocoo

# ZonelRollingCost

-

Remarque : Si vous faites glisser un objet en dehors de |'arborescence Forme de |'actif, une infobulle
contenant le texte Déposer et placer automatiquement s'affiche. L'élément est ajouté automatiquement a
I'arborescence a un emplacement logique. Cet élément conserve la méme relation dans I'arborescence
Forme de I'actif qu'il a dans |'arborescence Pl AF. Si aucun emplacement ne semble logique, I'élément est

rejeté.

Vous pouvez également placer I'objet dans |'arborescence Forme de I'actif. Une infobulle s'affiche et vous
indique comment ajouter |'actif comme entité parent, enfant ou jumeau. Ceci ne vous empéche pas de
déposer un objet dans un emplacement ne correspondant pas a la hiérarchie Pl AF.

Placement d'un élément dans I'arborescence Forme de I'actif
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Select Data » Modify View > Publish

@ Source Assets T Search Shape + Matches
Server CASTANT-CL v ToAsset Shape Found 5 Matches
Database Datacenter Demo oo 4 anitz;—ga\ert 7 % @ coo
b i Canacih P » @ Colot
6 Assets % @
r @ Data Centers Py » © Colot
r @ Americas Py » © Colot
| 4 e Atlanta .
» @ Colot
» @ Colo2
» [ Colo3
» D Chicago
» Ef) Houston
> @ MNew York

3 @ San Leandro

10. Faites glisser d'autres actifs et attributs sur le volet Forme de I'actif.
Le volet Correspondances affiche les éléments qui correspondent a la forme définie.

11. Pour afficher les données de tous les actifs partageant le méme modéle PI AF :

L

. oA o e . a1 .
a. Cliquez surl'icone *“  a coté de l'actif pour ouvrir la fenétre Editer les filtres.
b. Décochez la case Nom de I'actif.

c. Cochez la case Modeéle de I'actif et cliquez sur Enregistrer.

Le volet Correspondances affiche les données provenant de tous les actifs qui partagent ce modele.
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@ Source Assets T Search Shape ' Matches
GarEr CASTINTCL . T Asset Shape Found 16 Matches
Database Datacenter Demo [ 4 4 @ ColoTemplate s x> Qcoot
& Zonel Capacity /x> ©cool
@ Assets
& Zonel.CapacityPercent PR . » @ Colot
4 @ Data Centers @ Zonel PUR * % @ Colof
4 © Americas & Zonel RollingCost % @ Cobot
4 [ Atlanta » @ Colo2
» ) Colot » @ Colo2
» [ Colo2 » @ Colo2
» &) Colo3 » & Colo2
4 [ Chicago » & Colo2
» ) Colol » @ Colo3
» ) Colo2 » @ Colo3
» [ Colo3 » @ Colo3
» B Houston » @ Colo3
» B New York » @ Colo2
» @ san Leandro » @ Colod

12. Pour trouver des correspondances d'actifs similaires avec un jeu d'attributs différent :

a. Cliquez sur l'icbne # 3 coté de I'attribut facultatif,
b. Dans la boite de dialogue Editer les filtres, cochez la case Attribut facultatif, puis cliquez sur Enregistrer.

Par exemple, vous pouvez utiliser I'option Attribut facultatif si vous avez acquis de nouveaux équipements
au cours d'une certaine période et que les attributs du nouvel et de I'ancien équipement ne sont pas
identiques.

Edit Filters

# Attribute Name

Zonel.RollingCost

Attribute Category

Cost v

(+) Add Filter

¥ Optional Attribute (i

13. Cligquez sur Suivant.
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La page Modifier la vue s'affiche. Voir La page Modifier la vue pour une présentation des taches que vous
effectuerez pour modifier votre vue.
14. Choisissez le schéma pour vos données en suivant I'une des procédures suivantes :
e Utiliser un schéma généré
e Utiliser un schéma importé d'un fichier

e Utiliser un schéma importé d'un registre de schémas

Remarque : Pour plus d'informations sur les options du schéma, voir A propos des schémas.

Regrouper des résultats a |'aide de groupes Joker

Dans certains cas, il peut étre judicieux de regrouper les formes d'éléments ou d'attributs. Par exemple, certains
attributs partagent un attribut de nom et vous souhaitez créer un tableau avec une colonne pour chaque type
d'attribut dans le tableau de sortie. Dans I'exemple suivant, il existe 3 attributs de Zonel : Zonel.Capacité,
Zonel.PSC (Puissance), et Zonel.Dépenses. Ces attributs (Capacité, PSC, et Dépenses) sont également partagés
par Zone2, Zone3, et Zone4. (Par exemple, les attributs de Zone2 sont Zone2.Capacité, Zone2.PSC, et
Zone2.Dépenses.) Vous souhaitez comparer ces attributs par zones. La capture d'écran suivante est une vue
partielle de cette structure Pl AF.
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[ Source Assets

Server CAST-INT-CL v

Database Datacenter Demo

0
-

@ Assets
4 [P Data Centers
4 [ Americas

4 [ Atlanta

» ) Colot

» ) Colo2 -
L —

Attributes | Firer x|l

0O select All

3

& ColoNumber
 Zonel.Capacity
 Zonel.CapacityPercent
4 Zonel.DCIE
 ZonelPUE

& ZonelPWR

4 ZonelRollingCost
 ZonelStatus

& Zone2 Capacity

4 Zone2 CapacityPercent
 Zone2 DCIE

4 Zone2 PUE

 Zone2 PWR

& Zone2 RollingCost
 Zone2 Status

 Zone3 Capacity

Q0 Q0 QCQQOQCQQOCQCQOCQCOC0OCOC0COoOOCOCC

& Zone3 CapacityPercent

4
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En utilisant un joker simple, vous obtiendriez le résultat suivant avec 64 correspondances. Bien que certaines
combinaisons soient logiques (le regroupement des attributs de Zone4, par exemple), d'autres combinaisons
comprennent des zones différentes qui ne correspondent pas au résultat attendu.

Select Data > Modify View > Publish

e Source Assets T Search Shape + Matches
Server CASTANT-CL . T.Asset Shape Found 64 Matches
Database PR . 4 [ Atlanta 9 4@ atlanta
4 @ Colol * 9 4 @ Colol
@ Assets & Zone" Capacity " % # Zone4 Capacity
4 (@ Data Centers T : % & Zonea PWR
0 @) A & Zone*RollingCost a2 # Zone4 RollingCost
4 e Atlanta 4 @ Allanta
‘ » © Colot 4 @ colot
» @ colo2 4 Zone3 Capacity
> @ cos # ZonedPWR
> @ chicago 4 Zone4 RollingCost
» @ Houston i @ Aflanta
» 67 New York — - 4 @ Colo1
Attributes | ® ‘ # Zone2 Capacity
O Select Al # Zone4PWR
S P # Zone4RollingCost
4 Zonel.Capacity (i ] 4 @ atanta
4 Zonel CapacityPercent [ ] ‘ @ Colo!
¢ G Py # ZonelCapacity
& Zonel PUE e Rz
T P 4 Zone4RollingCost
A= R T
# ZonelRollingCost i ]

Dans cet exemple, vous souhaitez générer un jeu de données avec une colonne par attribut au lieu de 12

colonnes (3 pour chacune des 4 zones). Vous pouvez ajouter des groupes Joker aux attributs dans I'arborescence
Forme de I'actif pour obtenir les résultats souhaités. La procédure et I'exemple suivants illustrent le concept de

groupes Joker et la facon dont ils peuvent étre utilisés.

1. Créez une forme avec l'actif et un jeu d'attributs qui vous intéressent.
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Select Data > Modify View > Publish

@ Source Assets T Search Shape + Matches
Server CASTINT-CL . T Asset Shape Found 1 Match
4 2 A anta
Database Catacenter Demo S v ) Atlanta PR @ Atlanta
4 @ colot S n 4 @ Colot
@ Assets X
& Zonel.Capacity s 4 Zonel.Capacity
4 Data Centers
8 & ZonelPWR a3 # Zonel PWR
- Americas i
e & Zone1RollingCost a3 & Zone!RollingCost
4 @ Atlanta
‘ » &) Colol
» ) Colo2
» @ colo3
» fa Chicago
> @ Houston
» @ New York

» fa San Leandro

Attributes | x

0O Select All

4P ColoNumber

4 Zonel.Capacity

& Zonel.CapacityPercent
4 ZonelDCIE

& Zonel.PUE

& ZonelPWR

4 Zonel RollingCost

LI - - T - I - -]

Ll

2. Cliquez sur o a coté du premier attribut (Zonel.Capacity).

3. Dans la boite de dialogue Editer les filtres, remplacez la chaine de caractére sur laquelle vous regroupez les
résultats par un astérisque.

Dans cet exemple, Zonel serait remplacé par un astérisque (*).
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Edit Filters

Show Wildcard Groups &
# Attribute Name

* Capacity

Attribute Category

Capacity r

(#) Add Filter

Optional Attribute o

Les correspondances suivantes sont alors générées. Une correspondance regroupe les attributs de la méme
zone (Zonel), mais les trois autres correspondances regroupent les attributs de zones différentes.

[

4. Cliquez sur Save.
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SelectData > Modify View > Publish
@ Source Assets T Search Shape ' Matches
Server pR—— B % Asset Shape Found 4 Matches
Database Datacenter Demo oo © B s © sena
4 @ Colol PR 4 @ colol
@ Assets & “Capacity S x 4 Zone4 Capacity
4 (D Data Centers & 7one1PUR S # ZonelPWR
4 § Americas 4 ZonelRolingCost s # ZonelRollingCost
4 @ Atlanta 4 @ Atlanta
| » ) Colot 4 @ Colot
» @ colo2 # Zone3.Capacity
» @ Colo3 # ZonelPWR
» 8 Chicago 4 Zone1RollingCost
» & Houston 4 D Atlanta
> e New York 4 @ Colol
» ) San Leandro & Zone2 Capacity
# Zone1PWR
# Zone1RollingCost
4 @ Atlanta
Attributes ‘ x| P
4 ZonelCapacity
0O select All # ZonelPWR
& ColoNumber [ = # Zone1RoliingCost
4 Zonel.Capacity ]
& Zonel.CapacityPercent e
& Zonel DCIE (5]
# Zone1 PUE L]
& Zonel PWR [:]
# Zonel RollingCost i ]
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5. Cliquez sur < a coté du deuxiéme attribut (Zonel.PWR).
6. Dans la boite de dialogue Editer les filtres, remplacez la méme chaine de caractére (Zonel) par un astérisque.

La boite de dialogue Editer les filtres affiche les éléments suivants :

Edit Filters

Hide Wildcard Groups €
¥ Attribute Name

‘ You've added a wildcard symbol (*) to multiple nodes in the

‘ 1PuR Shape Tree:
Attribute Category  *.Capacity
& PWR

| Power r

Group Together Keep Wildcards

# Add Filter
OptionaIAttrl'bthe 6 mnatching gro 0 on these Shape ltems are — different gcaras that dont

Don't show this message again

7. Cliquez sur Grouper ensemble.

Dans la boite de dialogue Editer les filtres, I'astérisque est remplacé par Groupe 1. Le volet droit indique les
attributs inclus dans le Groupe 1 (Groupl.Capacity et Group1.PWR).

Edit Filters

Hide Wildcard Groups €
¥ Attribute Name Group Name Group Usage
‘ Group 1 & Group 1 .Capacity
& Group 1 .PWR

| Group 1 x PWR

Attribute Category

‘ Power r

® Add Filter

Optional Attribute @ (#) Create New Wildcard Group

8. Cliquez sur Save.

Les deux attributs de la forme de I'actif s'affichent avec le joker du Groupe 1.
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Select Data > Modify View > Publish
@ Source Assets T Search Shape + Matches
Server Jp—— v Tz Asset Shape Found 4 Matches
Database Datacenter Demo oo = LG S @ pne
4 @ Colol S x 4 @ colot
@ Assets & B copeciy £ % # Zonea Capacity
4 [ Data Centers & [Grotplil FWR S n # Zone4 PWR
4 Q@ Americas # ZonelRoliingCost % # Zone1RollingCost
4 [ Atlanta 4 @ Atlanta
‘ » @ Colol 4@ calol
» @ Colo2 # Zone3 Capacity
» @ Colo3 # Zone3PWR
» € Chicago # Zone1RollingCost
» (@ Houston 4 @ Atlanta
» 6D New York 4 @ Colol

> San Leand
& San Leandro # Zone2 Capacity

# Zone2 PWR

# Zone1 RollingCost

4 [‘B Atlanta
Attributes | x| 4 @ colol
# Zone1.Capacity
O Select Al # Zone1PUR
O L] # ZzonelRollingCost
4 Zonel Capacity [ ]
4 Zonel CapacityPercent [ )
& Zonel.DCIE ;]
& Zonel PUE [:]
& ZonelPWR ;]
o

& ZonelRollingCost

9. Cliquez sur < en regard du troisieme attribut (Zonel.RollingCost).
10. Supprimer la chaine de caracteres partagée (Zonel).

11. Cligquez sur Groupe 1 dans le volet de droite et faites-le glisser dans le champ Nom de I'attribut.

Edit Filters

Hide Wildcard Groups €

¥ Attribute Name GroupNgme Group Usage

IRallinaCost Group 1 \ & Group 1 .Capacity
% Group 1 i & Group 1 .PWR
Attribute Category
‘ Cost T
& Add Filter
Optional Attribute @ (® Create New Wildcard Group (=) Delete Wildcard Group
Insert Wildcard Group 1 at cursor position

Les trois attributs du joker Groupe 1 apparaissent sur la capture d'écran suivante.
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Edit Filters

Hide Wildcard Groups €
¥ Attribute Name Group Name Group Usage

‘ Group 1 & Group 1 .Capacity
& Group 1 .PWR
Attribute Category & Group 1 .RollingCost

| Group 1 x .RollingCost

‘ Cost v

® Add Filter

Optional Attribute @ (#) Create New Wildcard Group

Save

12. Cligquez sur Save.

Select Data > Modify View > Publish
@ Source Assets T Search Shape + Matches

Server CASTINT-CL . T Asset Shape Found 4 Matches
4 @ Atlanta
4 @ cCalot

» [ Atlanta
Database Datacenter Demo

4]
-

» @ Atlanta
@ Assets

& |Group 1 .Capacity » @ Atlanta

4 e Data Centers =

& Group1 PWR » @ Atlanta

4 eAmericas
4 [ Atlanta

| » ) Colot

» @ Colo2

L S W
XX X X X

4 Group 1 RollingCost

» ) Colo3
» B Chicago
r e Houston

» 6D New York -

Attributes | ®

O select All

3

4 ColoNumber

4 Zone! .Capacity

4 Zonel.CapacityPercent
4 Zonel.DCIE

& ZonelPUE

& Zonel PWR

4 ZonelRollingCost

eoecocCeQOoQQOQ

4

Grace aux groupes Joker, les 4 correspondances indiquent le regroupement des attributs Zonel, Zone2,
Zone3, et Zone4.
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v Matches

Found 4 Matches
4 @ Atlanta
4 @ Colo
& Zoned Capacity
& Zoned PWR
& Zone4 Rol ngCost
4 @ Atlanta
4 @ Colo
L 4 Zone3.Capacity
# Zone3a PWR
& Zone3 Rol ngCost
4 @ Atlanta
4 @ Colo
L 4 Zone2 Capacity
& Zone2 PWR
4 Zone2 RollingCost
4 @ Atlanta
4 [ colat
L 4 Zonel.Capacity
& ZonelPWR

& ZonelRollingCost

La page Modifier la vue

Dans la page Modifier la vue, vous indiquez le schéma a utiliser pour envoyer les messages et spécifiez quand les
messages sont envoyés. Vous pouvez éventuellement exclure des données et des données de remplissage d'une
période antérieure. La capture d'écran ci-dessous identifie les différents volets et fonctions et fonctionnalités
clés.
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Select Data > Modify View > Publish Next
T Shapes o’ Message Designer @) Preview @

To Asset Shape Preview Start Time

| Schema Options ” Message Trigger ” Backfill Data ” Message Filters |
EROSUTDAO 5 S 7 ) Y o 2
& ColoNu.. & x You Jcing your sche Jhe asset shal J a flattened 53 ‘)e Preview End Time
0 Zonel.. 4 % Import Schema Select Schema Structure ) ‘
® Zonel.. & x | Select Import Source v| | Sync to Asset Shape (Flattened) v| {
"Colol": "Colol",
®zonel.. & % “ColoNumber™: "1.664574",
Save Schema to Registry "Zonel.Capacity™: "162",
"Zonel.CapacityPercent™: 171.21975703007812,
"Zonel.DCiE": "38.5215",
{ @ "Times‘tamp": "2@18-19-29T81:51:56.8603267-87:0¢
"Colol": "[& Colo1 (Name) v, & ‘}["
“ColoNumber™: "[4 ColoNumber (Valug) v, & "Colol": "Colol”,
"ColoMumber”: "1
“Zonel.Capacity™: "|4p Zonel Capacity (Value) v, & “Zonel.Capacity”
"Zonel.CapacityPercent™: 172.82561950683594,
"Zonel,.CapacityPercent”: "|0 Zone1.CapacityPercent (Value) v 4 "Zonel.DCiE™: "37.82698",
"Timestamp”: “2018-18-29T@1:52:56.8603267-87:0¢
“Zonel.DCiE": |4 ZonelDCIE (Value) v, Vi 1
"Timestamp”: "|® TimeStamp v 4 ¢ "Colol": "Colol”,
"ColoMumber™: "
3 "Zonel.Capacity™: "
"Zonel.CapacityPercent™: 173.21989440891797,
"Zonel.DCiE": "37.55756",
"Timestamp”: " a7:e¢
b
{
"Colol": "Colol",
"ColoMumber™: "1.67812",
© Add Property to Schema "Zonel.Capacity™: "182",
: "ZFanael FanaritwPercent”: 177 7A73IA?AAACAARRR
unNombre Description

1 Forme de I'actif — Vous pouvez glisser et déposer des
éléments et attributs de la forme sur les propriétés du
schéma dans le volet Concepteur de message.

2 Concepteur de message — Dans ce volet, vous
sélectionnez le schéma, indiquez le déclencheur de
message, modifiez les propriétés du schéma et
remplissez des données.

3 Apercu — Affiche les 100 premiers messages au format
du schéma affiché dans le volet Concepteur de
message.

4 Schéma — Affiche le schéma utilisé pour envoyer les
messages.

5 Options du schéma — Sélectionne le schéma utilisé
pour envoyer les messages. Vous pouvez utiliser un
schéma généré basé sur la forme de I'actif ou
importer un schéma a partir d'un fichier ou d'un
registre.
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unNombre Description

6 Modifiez les propriétés du schéma, changez l'ordre
des propriétés du schéma ou supprimez les propriétés
du schéma. Toutes les options ne sont pas disponibles
avec tous les types de schémas.

7 Déclencheur de message - Indique la fréquence et les
conditions selon lesquelles un message est envoyé a la
cible de publication.

8 Données de remplissage — Indique les valeurs
antérieures a envoyer a la cible de publication.

9 Filtres de message — Indique les résultats de données
a exclure.

Pour obtenir des informations sur |'exécution des taches dans la page Modifier la vue, voir ci-dessous :

e Utiliser un schéma importé d'un fichier

e Utiliser un schéma importé d'un registre de schémas
e Utiliser un schéma généré

¢ Configurer quand les messages sont envoyés

e Données de remplissage

A propos des schémas

Remarque : Cette fonctionnalité est disponible dans Pl Integrator for Business Analytics Edition Advanced.

¢ Par défaut, la forme de la recherche est utilisée pour générer le schéma des messages de diffusion. Vous
pouvez utiliser ce schéma généré ou importer un schéma. Les valeurs de données de la forme sont alors
attribuées au schéma.

Schémas importés
Des schémas peuvent étre importés depuis un fichier ou un registre de schémas.

e Schémas importés depuis un fichier — Les formats de schémas suivants peuvent étre importés depuis un
fichier : JSON (JavaScript Object Notation), CSV (valeurs séparées par des virgules) et Apache Avro. Une fois
importés, vous attribuez des valeurs aux propriétés et vous modifiez les propriétés.

¢ Schémas importés depuis un registre de schémas — Cette version prend en charge le registre de schémas
Confluent utilisant des schémas Apache Avro.

e Les schémas Avro importés depuis le registre de schémas appliquent des regles strictes. Une fois importés, le
nom de la propriété et le type de données sont dérivés du nom et du type de champ Avro, respectivement,
et ne peuvent pas étre modifiés. Si I'une des conditions suivantes est avérée, la vue ne sera pas publiée.

¢ Une valeur n'est pas attribuée a une propriété
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¢ Le type d'une propriété est différent et le champ Avro correspondant ne prend pas en charge le type
« null »

¢ Le type est différent et le champ Avro ne prend pas en charge le type « null » ; la vue est publiée mais le
champ est ignoré.

Schémas générés

Les schémas générés sont synchronisés avec la forme de I'actif dans une structure imbriquée, aplanie ou de
forme libre. Les noms de propriétés du schéma correspondent aux noms de I'actif et de I'attribut dans la forme.
La valeur de la propriété prend les valeurs de données de I'actif ou de |'attribut lié de la forme. En mode aplani,
le schéma s'affiche dans une structure non hiérarchique. En mode imbriqué, la hiérarchie du schéma est
conservée. Dans les schémas aplanis et imbriqués, vous pouvez modifier les noms de propriétés, les valeurs
associées aux propriétés et les types de données. Vous pouvez créer un schéma imbriqué ou aplani et le
convertir en schéma de forme libre. Le schéma de forme libre vous offre la plus grande flexibilité de modification
du schéma. Outre le fait de pouvoir effectuer tout ce que vous voulez avec un schéma aplani ou imbriqué, vous
pouvez également modifier les propriétés en ajoutant, supprimant et réorganisant les propriétés.

Utiliser un schéma importé d'un fichier

Lisez A propos des schémas pour obtenir des informations sur les différentes méthodes d'utilisation d'un
schéma.

Dans le volet Concepteur de message, cliquez sur Options du schéma.
2. Cliquez sur Sélectionner le schéma et choisissez Fichier.
Dans la fenétre Ouvrir, sélectionnez le fichier de schéma, puis cliquez sur Ouvrir.

Les schémas aux formats suivants sont pris en charge : JSON, CSV et Apache Avro. Les fichiers doivent avoir
une extension .json, .csv ou .avsc pour étre affichés dans le Concepteur de message.

4. Attribuez la valeur aux propriétés du schéma selon I'une des méthodes suivantes :
¢ Faites glisser un actif ou attribut de la forme de I'actif sur le schéma.
e Cliquez sur I'icone du crayon pour ouvrir la fenétreEditer la propriété. Sélectionnez un actif ou un attribut
dans la forme, puis sélectionnez une valeur dans la liste Contenu de données de la propriété. Cliquez sur
Mettre a jour la propriété.
Faites glisser et déposez une propriété du schéma pour la déplacer vers un autre emplacement.
Cliquez sur le x pour supprimer la propriété du schéma.
Cliquez sur Ajouter une propriété au schéma en bas a gauche pour ajouter une propriété du schéma.
a. Entrez le nom de la propriété et cliquez sur Confirmer.

b. Attribuez une valeur a la propriété en faisant glisser un attribut de la forme de I'actif ou en cliquant sur
l'icbne ~

8. Passez a la procédure suivante Configurer quand les messages sont envoyés.

Utiliser un schéma importé d'un registre de schémas

Lisez A propos des schémas pour obtenir des informations sur les différentes méthodes d'utilisation d'un
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schéma.

1. Dans le volet Concepteur de message, cliquez sur Options du schéma.
2. Cliquez sur Sélectionner le schéma d'importation et choisissez Registre de schémas.

3. Sélectionnez le schéma dans le Navigateur de registre de schémas, puis cliquez sur Utiliser le schéma
sélectionné.

4. Attribuez la valeur aux propriétés du schéma selon I'une des méthodes suivantes :
¢ Faites glisser un actif ou attribut de la forme de I'actif sur le schéma.

e Cliquez sur I'icone du crayon pour ouvrir la fenétre Editer la propriété, sélectionnez un actif ou un
attribut dans la forme, puis sélectionnez une valeur dans la liste Contenu de données de la propriété.
Cliquez sur Mettre a jour la propriété.

Pour pouvoir continuer et publier votre vue, vous devez fournir des valeurs valides pour toutes les propriétés
de votre schéma. Les schémas Avro importés depuis le registre de schémas appliquent des regles strictes. Le
nom et le type de données ne peuvent pas étre modifiés. Si les types de données du schéma et de la valeur
sélectionnée sont différents, Pl Integrator for Business Analytics tente une conversion du type de données.
S'il ne parvient pas a convertir le type de données, des valeurs nulles apparaissent pour cette propriété.
Consultez le volet Apercu pour voir les valeurs nulles. Vous devez résoudre toutes les valeurs de type
incorrect. Si des valeurs ne sont pas résolues, la vue n'est pas publiée. Une exception s'applique si le schéma
autorise les valeurs nulles. Dans ce cas, les différences de type de données non résolues ne doivent pas étre
résolues et vous pourrez publier votre vue.

5. Passez a la procédure suivante Configurer quand les messages sont envoyés.

Utiliser un schéma généré

Lisez A propos des schémas pour obtenir des informations sur les différentes méthodes d'utilisation d'un
schéma.

1. Dans le volet Concepteur de message, cliquez sur Options du schéma.
Par défaut, le schéma qui apparait est synchronisé avec la forme de I'actif et affiché dans une structure plate.
2. Cliquez sur Sélectionner la structure du schéma et choisissez I'une des options.
¢ Synchroniser avec la forme d'actif (plat) - Le schéma s'affiche dans une structure non hiérarchique.
¢ Synchroniser avec la forme d'actif (imbriqué) — La hiérarchie du schéma est conservée.
¢ Forme libre — S'applique quelle que soit la hiérarchie affichée (imbriqué ou plat).

Le schéma affiche les propriétés avec les valeurs de données des actifs et attributs associés de la forme. Vous
pouvez choisir une autre valeur de propriété dans la liste de toutes les propriétés disponibles pour I'élément
ou l'attribut Pl AF.

3. Pour attribuer une autre valeur a la propriété du schéma, cliquez sur la fleche et sélectionnez une propriété
dans la liste.

4. Pour apporter d'autres modifications a la propriété du schéma, cliquez sur I'icéne du crayon pour ouvrir la
fenétre Editer la propriété.

Remarque : Par exemple, vous pouvez modifier le nom de la propriété du schéma ou le type de données par
défaut de la propriété.

5. (Schéma Forme libre uniquement) Faites glisser et déposez la propriété du schéma pour la déplacer vers un
autre emplacement.
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Conseil : Les propriétés au méme niveau de la hiérarchie ne peuvent pas étre réorganisées. Une propriété ne
peut étre déplacée que pour devenir I'enfant d'un autre parent.

Toutes les propriétés enfants d'un parent donné doivent avoir des noms uniques. Un déplacement est rejeté
si cette regle n'est pas respectée.

(Schéma Forme libre uniquement) Cliquez sur le x pour supprimer la propriété du schéma.

7. (Schéma Forme libre uniquement) Cliquez sur Ajouter une propriété au schéma en bas a gauche pour
ajouter une propriété du schéma.

8. Passez a la procédure suivante Configurer quand les messages sont envoyés.

Utiliser des filtres pour affiner la forme de vue

Sur la page Select Data (Sélectionner des données), vous commencez généralement par ajouter un actif ou cadre
d'événement unique a la forme de recherche. Vous pouvez ensuite utiliser des filtres pour étendre cette forme a

d'autres actifs ou cadres d'événement. Cliquez sur l'icone s pour ouvrir la boite de dialogue Edit Filters (Editer
les filtres). La capture d'écran suivante présente la boite de dialogue Edit Filters ( (Editer les filtres) pour une
forme de vue d'actif.

Remarque : L'exemple dans cette section décrit I'édition des filtres pour une forme de vue d'actif. Les filtres de
cadre d'événement incluent des conditions de noms similaires, et le comportement des filtres est identique a
celui des filtres de vue d'actif.

Boite de dialogue Edit Filters (Editer les filtres) pour une forme de vue d'actif

Edit Filters

¥ Asset Name @J

MS301:Anne Morth:T1

o —_— ¥ Asset Template @_)

M5 Transformer r

Asset Category @

MS Transformer r

(¥ Add Filter

La capture d'écran identifie le filtre et les conditions qu'il inclut.
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unNombre Description

1 Exemple de filtre de vue d'actif
2 Condition de nom de I'actif

3 Condition de gabarit de I'actif

4 Condition de catégorie de I'actif

Vous pouvez rechercher sur la base d'une ou plusieurs de ces conditions. Toutes les conditions sélectionnées
doivent étre remplies pour étre déterminé comme une correspondance. Par exemple, dans la capture d'écran,
Asset Name (Nom de I'actif) et Asset Template (Gabarit de I'actif) sont sélectionnés et ces deux conditions
doivent étre remplies pour trouver une correspondance. Seuls les actifs dont le nom est MS301:Anne North:T1 et
qui sont basés sur le gabarit MS Transformer seront affichés dans le volet Matches (Correspondances).

Pour les vues d'événement, les conditions de filtre sont nommées Event Name (Nom de I'événement), Event
Template (Gabarit de I'événement) et Event Category (Catégorie de I'événement). Le comportement des filtres
est toutefois le méme que celui des filtres de vue d'actif.

Vous pouvez étendre votre recherche pour qu'elle inclut le plus de correspondances possible en ajoutant des
filtres. Cliquez sur le signe plus (+) pour ajouter un autre ensemble de filtres.

Remarque : Utilisez la barre de défilement pour dérouler vers le bas et afficher des filtres supplémentaires.

Chaque filtre se compose d'un ensemble de conditions Asset Name (Nom de I'actif), Asset Template (Gabarit de
I'actif), Asset Category (Catégorie de I'actif) qui s'appliquent comme des conditions AND (et°. Chaque condition
sélectionnée dans le filtre doit correspondre pour déterminer un actif comme étant une correspondance.

En cas d'application de deux filtres ou plus, les conditions de chaque filtre doivent étre remplies pour déterminer
un actif comme correspondant.

Dans I'exemple, un second ensemble de filtres est ajouté et la condition Asset Name (Nom de I'actif) est définie
sur DrilIBit*.

Second filtre dans une vue d'actif
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Edit Filters

¥ Asset Name

DrillEit*

Asset Template

ElementTemplate

Asset Category

(=) Remove Filter

(+) Add Filter

Le service Pl Integrator Framework recherche le serveur Pl AF :

¢ Avec le premier filtre, il recherche un actif nommé MS301:Anne North:T1 et basé sur le gabarit MS
Transformer.
¢ Avec le second filtre, il recherche un actif dont le nom commence par DrillBit.

La recherche renvoie les actifs correspondants a /'une ou I'autre de ces conditions. Des filtres multiples
s'appliguent donc comme un filtre OR (ou).

Modifier les données dans vos vues d'actif et d'événement

Remarque : Il est possible de modifier une vue publiée. Pour plus d'informations sur la modification d'une vue
publiée, voir Modifier une vue.

Avant de publier une vue, vous pouvez affiner vos résultats de données, notamment :

¢ Modifier la fagon dont vos données sont récupérées

Vous pouvez régler l'intervalle d'échantillonnage ou choisir d'utiliser une colonne clé pour organiser les
données dans la vue. Consultez Options de récupération de données pour plus d'informations sur les
différentes méthodes de récupération des données et sur les options qui permettent de créer les
représentations de données souhaitées. Pour plus d'informations sur la définition de la méthode de
récupération de données dans vos vues, voir Configurer la récupération des valeurs.

¢ Ajouter des colonnes de données pour afficher les informations des attributs
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Pour plus d'informations, voir Ajouter une colonne de données.

¢ Ajouter une colonne d'heure qui affiche vos données de temps dans un format différent
Pour plus d'informations, voir Ajouter une colonne d'heure.

¢ Modifier une colonne
Pour plus d'informations, voir Modifier une colonne.

¢ Filtrer les données dans une vue

Pour plus d'informations, voir Filtrer les données.

Options de récupération de données

Vous pouvez controéler la fagon dont les données sont récupérées dans votre vue en modifiant l'intervalle
d'échantillonnage ou en triant les données en colonnes clés a partir d'un attribut.

¢ Dans une vue d'actif, les données sont récupérées de I'une des fagons suivantes :
e Aintervalle de temps régulier (interpolées)
e Sur la base d'un attribut de temps de référence (compressées)

¢ Les horodatages sont dérivés de I'attribut de référence. Selon I'option que vous choisissez, tous les
autres sont interpolés ou se voient attribuer une valeur nulle s'il n'existe aucune valeur pour cet attribut
a I'horodatage exact.

¢ Dans une vue d'événement, les données sont alignées en cadres d'événements et formatées de I'une des
fagons suivantes :

¢ Une archive récapitulative pour chaque événement. C'est idéal pour les diagrammes de Pareto.

¢ Dans un diagramme de Pareto, les deux barres et une ligne apparaissent. Les valeurs individuelles sont
représentées par des barres et les barres les plus longues s'affichent sur la gauche. La durée totale est
représentée par une ligne.
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Configurer la recupération des valeurs

1. Ala page Mes Vues, sélectionnez la vue que vous souhaitez modifier et cliquez sur Modifier la vue. Cliquez
ensuite sur Suivant pour ouvrir la page Modifier la vue.

Remarque : Si vous vous trouvez déja sur la page Modifier la vue, passez directement a I'étape suivante.

2. Cliquez sur Editer le mode de valeur et choisissez la facon dont vos données seront traitées dans le rapport :

¢ (Vues d'événement uniquement) Valeurs résumées renvoie une ligne par cadre d'événement sur
I'ensemble de I'horodatage spécifié pour la vue d'événement. Utilisez cette option pour générer des
résultats qui peuvent étre affichés dans un diagramme de Pareto. L'option Valeurs résumées n'apparait
que si vous modifiez une vue d'événement.

Valeurs résumées
Edit Value Mode

* Summarized Values

Sampled Values

Save Changes

Les valeurs résumées sont les valeurs de cadre d'événement affichées dans Pl System Explorer. Par
défaut, c'est la valeur du point Pl de la fin du cadre d'événement.

"

Remarque : La valeur du cadre d'événement est configurée dans Pl System Explorer au niveau de
I'attribut. Le parameétre Par plage de temps dans la boite de dialogue Référence des données du point PI
indiqué ci-dessous, indique le mode de récupération des valeurs configuré.
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Data server: | css-hi_pisys

(@ Tag pame: |E1255_TEI'~'1P

() Attribute: |

Lnit of Measure

Value retrieval methods

Source Units:

By Time: |Automaﬁc

Relative time: |

| End Time

By Time Range:

Calculation basis: Time Weighted

Min percent good: a0

Read only

ne prend pas en charge la méthode de récupération de valeur Par heure définie sur Non pris en charge.
Pour plus d'informations, consultez l'article de la Base de connaissances Les valeurs de calcul résumées

de cadres d'événement Integrator sont vides.

¢ Valeurs d'échantillonnage tou(te)s les modifie l'intervalle d'échantillonnage pour qu'une valeur soit
interpolée a l'intervalle de temps défini ; toutes les 15 minutes par exemple.

Valeurs d'échantillonnage tou(te)s les

Edit Value Mode

) Summarized Values

® Sampled Values

® Sample values every | 1+

minutes =

® |nterpolate @
O Exact ©®

© Use Key Column | cdi158 v
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Cliquez sur Valeurs d'échantillonnage tou(te)s les et définissez l'intervalle de temps :

¢ Interpoler renvoie toujours une valeur a l'intervalle de temps défini, en interpolant les valeurs au
besoin.

¢ Exactes renvoie les valeurs a l'intervalle de temps, si elles existent. Si aucune valeur de temps
n'existe, la valeur sera zéro.

e Utiliser une colonne clé utilise un attribut pour organiser la fagon dont les données sont interpolées.

Utiliser une colonne clé

Edit Value Mode x

Summarized Values

* Sampled Values

Sample values every | 1+ || minutes =

* Use Key Column | cdt158 »
® Interpolate @
Exact @

¢ Interpoler trouve les valeurs de la colonne clé et leurs données d'horodatage enregistrées. Les
valeurs des autres colonnes sont interpolées aux mémes horodatages que ceux de la colonne clé.

Sélectionnez I'attribut, puis choisissez I'une des options suivantes :

¢ Exactes trouve les valeurs de la colonne clé et leurs horodatages enregistrés. Si aucune valeur
n'existe a ces horodatages enregistrés pour les autres colonnes, une valeur nulle est renvoyée.

3. Cliquez sur Enregistrer les modifications.

Calcul des données

Sur la page Modifier la vue, vous pouvez ajouter une colonne de données récapitulatives pour n'importe quelle
colonne numérique de votre vue : Vous trouverez ci-aprés des exemples de valeurs calculées que vous pouvez
spécifier :

¢ Total : total de toutes les valeurs pour l'intervalle

¢ Average (Moyenne) : moyenne de toutes les valeurs pour l'intervalle

e Minimum : valeur minimale dans l'intervalle

¢ Maximum : valeur maximale dans l'intervalle

¢ Range (Plage) : valeur maximale dans I'intervalle moins la valeur minimale dans l'intervalle

L'intervalle est déterminé a I'aide d'horodatages dans la vue :
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¢ L'heure de début correspond a I'horodatage de la ligne précédente

¢ L'heure de fin correspond a I'horodatage de la ligne actuelle

La capture d'écran et le tableau ci-dessous illustrent la relation entre les horodatages et les valeurs calculées.
Dans cet exemple, deux colonnes ont été ajoutées, Volume 1 - Minimum et Volume 1 - Average. Les deux sont
basées sur la colonne Volume 1. La ligne actuelle correspond a la ligne dont I'horodatage marque la fin de
I'intervalle. L'horodatage de la ligne précédente marque le début de l'intervalle. Volume 1 - Minimum prend
toutes les valeurs de données entre ces deux heures, recherche la valeur minimale et renseigne la colonne
Volume 1 - Minimum de la ligne actuelle, c'est-a-dire la ligne de I'heure de fin). De méme, elle permet de
calculer la valeur de la colonne Volume 1 - Average a I'aide d'une moyenne des valeurs de Volume 1 entre
I'heure de début et I'heure de fin, et renseigne la colonne Volume 1 - Average de la ligne actuelle.

Select Data > Modify View > Publish

Asset View 1

= Add Column Y Edit Row Filters 2= Edit Value Mode
5 columns 0 Row Filters Interpolated Values
Every 1 minute
TimeStamp Volume1 Volumet - Minimum Volumet - Average

2M0/2017 6:13:04.514 AM
2M10/2017 6:14:04.514 AM
2072017 6:15:04.514 AM
2072017 6:16:04.514 AM @
2M0/2017 6:17:04.514 AM @J
2M10/2017 6:18:04.514 AM
2M0/2017 6:19:04.514 AM
2072017 6:20:04.514 AM

45 5642967224121
45.1628189086914
44.7613410949707
44.35986328125

43.9583892822266
43.5569114685059
43.1554336547852
42.7539596557617

45.5642949855283
45.1628183669969
44.7613417484654
44.359865129934
43.9583885114025 @J
43 556911892871
43.1554352743396
42.7539586558081

45.7650332947941
45.3635566762626
44.9620800577311
44.5606034391997
44.1591268206682
43.7576502021368
43.3561735836053
42.9546969650738

Q «—06

unNombre Description

1 Heure de début de l'intervalle

2 Heure de fin de l'intervalle

3 Volume minimum dans l'intervalle entre les heures de
début et de fin

4 Moyenne des volumes dans l'intervalle entre les
heures de début et de fin

5 Ligne actuelle

Pour en savoir plus sur |'ajout d'une colonne de données récapitulatives, consultez Ajouter une colonne de
données.

Ajouter une colonne de données
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A la page Mes Vues, sélectionnez la vue que vous souhaitez modifier et cliquez sur Modifier la vue. Cliquez
ensuite sur Suivant pour ouvrir la page Modifier la vue.

Remarque : Si vous vous trouvez déja sur la page Modifier la vue, passez directement a |'étape suivante.

Cliquez sur Ajouter une colonne.

Cliquez sur I'onglet Colonne de données et sélectionnez |'attribut qui correspond a la source des données.

Add Column

ata Column Time Column

Select Column Data Source

F @ Floo*
Column Mame
4 [ Any
|Unic:|L.eCo|umr*Nar‘1e |
4 @ vav

Use Default Name
& Terminal Load
& Cold Deck Damper Pasiticn Column Data Content @
Health Status |‘-.fa|L|-& hd |
& Hot Deck Damper Position

ata Type
Latitude
~  [Double v |

=l e

Add Column

Attribuez un nom unique a la colonne.

Définissez un mode de calcul (une moyenne, par exemple) a appliquer aux attributs dans le champ Contenu
de données de colonne.

Remarque : La fonction Last Recorded Value est utilisée avec des données qui ne doivent pas étre
interpolées, comme un attribut d'état activé ou désactivé, par exemple. Last Recorded Value remonte dans la
chronologie et renvoie la valeur la plus récente de la modification dans I'attribut d'état.

(Facultatif) Modifier le type de données dans le champ Type de données.

Cliquez sur Ajouter une colonne.

Ajouter une colonne d'heure

Sélectionnez Colonne d'heure pour ajouter des informations de temps supplémentaires a vos vues.

Remarque : Certaines étapes différent selon que vous créez une vue d'actif ou une vue d'événement. Lorsque la
procédure est différente, le type de vue est indiqué sur I'étape a laquelle il s'applique.

1. Ala page Mes Vues, sélectionnez la vue que vous souhaitez modifier et cliquez sur Modifier la vue. Cliquez

ensuite sur Suivant pour ouvrir la page Modifier la vue.

Remarque : Si vous vous trouvez déja sur la page Modifier la vue, passez directement a I'étape suivante.

2. Cliquez sur Ajouter une colonne.

(Vues d'actif) Cliquez sur I'onglet Colonne d'heure.
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Sélectionnez Colonne d'heure pour ajouter des colonnes qui affichent vos données d'horodatage dans un
format différent.

Add Column

Select Time Column Options for

Data Column Time Column

Year (2016)

b.

C.

Maonth

Month Name
Week of the Year
Day

Day of the Week
Hour

Minute

Second
Milliseconds

UTC Seconds
UTC Milliseconds
Ticks

Time Zone Offset

ocal

GMT

+ 1

TimeStamp

Display 1time column

Dans la liste Sélectionner des options de colonne d'heure pour, sélectionnez I'heure locale ou I'heure
moyenne de Greenwich (GMT).

Par exemple, si vous choisissez Heure et GMT, vous ajoutez a votre vue une colonne indiquant I'heure de
votre point Pl au format GMT.

Sélectionnez une unité de temps dans la colonne de gauche et cliquez sur la fleche droite.

Lorsque vous avez terminé, cliquez sur le bouton Afficher colonne de temps.

(Vues d'événement) Cliquez sur I'onglet Colonne d'heure.

La liste Sélectionner des options de colonne d'heure pour affiche les différentes données d'heure que vous
pouvez afficher dans la vue d'événement, y compris I'heure de début et I'heure de fin du cadre d'événement.
Vous pouvez afficher ces données a I'heure locale de I'ordinateur exécutant le Service Pl Integrator
Framework ou a I'heure moyenne de Greenwich (GMT).
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Select Time Column Options for | Local

Year jl(_gor\j;-'ll Stamp t Frame Loc T
Month Event Frame Local Start Time Stamp s

Month Name Event Frame Local End Time Stamp

Week of the Year Event Frame GMT Start Time

Day

Day of the Week (wednesds Event Frame Duration

Hour Event Frame Relative Time

Minute

Second

Milliseconds

UTC Seconds

UTC Milliseconds

Ticks 000
Time Zone Offset (42¢

Display 4 time columns

a. Dans la liste Sélectionner des options de colonne d'heure pour, sélectionnez les données que vous

souhaitez afficher dans votre vue.

Le tableau suivant décrit les différents types d'heure que vous pouvez afficher dans votre vue.

Options

Description

Local

Lorsque vous utilisez des valeurs échantillonnées :
horodatage des données a I'heure locale. Lorsque
vous utilisez des valeurs résumées : cette heure
correspond a I'heure de fin locale du cadre
d'événement.

GMT

Lorsque vous utilisez des valeurs échantillonnées :
horodatage des données a I'heure GMT. Lorsque
vous utilisez des valeurs résumées : cette heure
correspond a I'heure de fin GMT du cadre
d'événement.

Heure de début locale du cadre d'événement

Heure de début du cadre d'événement a I'heure
locale.

Heure de fin locale du cadre d'événement

Heure de fin du cadre d'événement a I'heure locale.

Heure de début GMT du cadre d'événement

Heure de début du cadre d'événement a I'heure
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Options Description

GMT.
Heure de fin GMT du cadre d'événement Heure de fin du cadre d'événement a I'heure GMT
Durée du cadre d'événement Heure de fin du cadre d'événement — (moins) heure

de début du cadre d'événement.

Heure relative du cadre d'événement Heure de ligne — (moins) heure de début du cadre
d'événement.

5. Sélectionnez I'unité de temps dans la colonne de gauche et cliquez sur la fleche droite.

Par exemple, si vous sélectionnez Heure de début locale du cadre d'événement et Heure, vous ajoutez une
colonne contenant uniquement I'heure de début du cadre d'événement au format de I'heure locale.

6. Lorsque vous avez terminé, cliquez sur le bouton Afficher colonne de temps.

Modifier une colonne

Il est possible de renommer une colonne, de définir un mode de calcul (moyenne des valeurs de chaque colonne,
par exemple), de modifier les types de données, de modifier les unités de mesure, ou de supprimer la colonne.

1. Cliquez sur la colonne pour ouvrir le volet Détails de la colonne.

¢ Pl Integrator Framework réserve les chaines de caractéres non sensibles a la casse ID, PlintTSTicks et
PlintShapeld comme noms de colonnes. Vous pouvez utiliser ces chaines de caracteres pour nommer des
colonnes dans vos vues d'actif et d'événement. Dans ce cas, une barre de soulignement (_) est toutefois
ajoutée au nom de la colonne dans vos données cibles. Par exemple, ID_ou Id_.

Remarque : Cette restriction ne s'applique pas aux cibles suivantes : flux de données Amazon Kinesis,
Amazon S3, Apache Kafka, Azure Event Hubs, Azure l1oT Hub, Google Cloud Storage, Google Pub/Sub,
Systeme de fichiers distribué Hadoop et Fichier texte.

¢ Les noms de colonnes sont reformatés en fonction des limitations de chaque magasin cible. Par exemple, les
noms de colonnes Oracle sont limités a 30 caractéres et les noms de colonnes de plus de 30 caractéeres sont
tronqués.

¢ Les cibles de base de données Oracle contiennent des chalnes réservées. Si ces chaines apparaissent dans les
noms de colonnes, un trait de soulignement (_) a la chaine.

¢ Les noms de colonne doivent étre uniques.

¢ Cette Last Recorded Value fonction du champ Contenu de données est utilisée avec des données qui ne
doivent pas étre interpolées, comme un attribut d'état activé ou désactivé, par exemple. Last Recorded Value
remonte dans la chronologie et renvoie la valeur la plus récente de la modification dans I'attribut d'état.
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@ Column Details

MName

Forecasted Chance of Rain |

Reset Name to Default

Data Content 0

VEINE v |

Data Type

Double v |

Remove

Apply Changes

1. Apportez des modifications a la colonne.

2. Lorsque vous avez terminé, cliquez sur Appliquer les modifications.

Filtrer les données

Il est possible de filtrer les données dans une vue a l'aide de plusieurs parametres. Vous pouvez, par exemple,
indigquer que vous souhaitez inclure des lignes si la colonne contient des éléments avec une valeur numérique
spécifique ou correspondant a un modele de chaine de caracteres.

Lorsque vous appliquez un filtre, prend le jeu de données correspondant a votre forme d'actif, I'ajoute au jeu de
données correspondant a votre filtre, et génere le sous-ensemble de données qui répond aux deux critéres.

1. Ala page Mes Vues, sélectionnez la vue que vous souhaitez modifier et cliquez sur Modifier la vue. Cliquez
ensuite sur Suivant pour ouvrir la page Modifier la vue.

Remarque : Si vous vous trouvez déja sur la page Modifier la vue, passez directement a I'étape suivante.

2. Cliquez sur Editer les filtres de ligne et choisissez un type de filtre.

Remarque : Les plus utilisés sont les filtres numériques et les chaines de caracteres.

Les filtres de cadres d'événement s'appliquent uniquement aux vues d'actifs. Par conséquent, lorsque vous
créez une vue d'événement, ce type de filtre n'apparait pas comme option.
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Row Filters x

Add New Row Filter

String Include rows based on whether the contents of a column match a
string pattern
Diqit Include rows based on whether the contents of a column contain
- certain digital values
NuUmeric Include rows based on whether the contents of a column contain
certain numeric values
. Include rows where the contents of a column contain a value
Mull Values
Include rows where certain Event Frames are active
Event Frame

Close

Pour en savoir plus sur I'application d'un filtre Cadre d'événement, consultez Filtrer par cadres
d'événements.

Lorsque vous avez terminé, cliquez sur le bouton Enregistrer.

4. Dans la boite de dialogue Filtres de ligne, cliquez sur Fermer.

Filtrer par cadres d'événements

La procédure suivante indique la marche a suivre pour appliquer un filtre de ligne de cadre d'événement a une
vue d'actif.

Remarque : Le filtrage par cadres d'événements s'applique uniguement aux vues d'actif.

En définissant une forme d'actif, vous créez un groupe de correspondances qui répondent a des critéres
identiques. En appliquant un filtre de cadre d'événement a cette vue, vous définissez une forme d'événement
constituant un groupe de correspondances pour un ensemble de cadres d'événements. Ensuite, Pl Integrator
associe ces deux groupes sur la base d'un actif commun, afin d'obtenir un sous-ensemble de données répondant
a des criteres communs aux deux groupes.

Imaginons, par exemple, un ensemble de puits dans lequel un certain type d'équipement fonctionne I'un apres
I'autre dans chaque puits et que des cadres d'événements soient utilisés pour enregistrer les données recueillies
par cet équipement. Chaque cadre d'événement posséde une heure de début et une heure de fin différente
s'appliquant a un puits spécifique. Vous pouvez utiliser le filtre de cadre d'événement par ligne pour inclure les
données de vue d'actif pour le puits, pour la période d'utilisation de I'équipement dans ce puits uniqguement.
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1. Ala page Mes Vues, sélectionnez la vue que vous souhaitez modifier et cliquez sur Modifier la vue. Cliquez
ensuite sur Suivant pour ouvrir la page Modifier la vue.

Remarque : Si vous vous trouvez déja sur la page Modifier la vue, passez directement a |'étape suivante.

2. Utilisez les champs Heure de début et Heure de fin pour modifier la plage de temps afin d'inclure les heures

auxquelles les cadres d'événements ont été enregistrés.

Remarque : Si les heures de début et de fin sont exclues de la plage de temps du cadre d'événement, aucun

cadre d'événement ne pourra étre trouvé.

3. Cliquez sur Editer les filtres de ligne et sélectionnez Cadre d'événement comme type de filtre.

recherche désormais les cadres d'événement pour cette vue dans votre base de données Pl AF et affiche un

sous-ensemble des résultats.

Create New Event Frame Row Filter

» "d Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc
» ¥4 Casing Temperature Excursion Rog
» "4 Casing Temperature Excursion Roc
» "4 Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc

» "4 Casing Temperature Excursion Roc ¥

Shape Tree
4 [ Catalytic Cracking
4 @ Boiler-210
& Feed Rate
# Fuel Gas Flow
& Fuel Gas Volume

Event Frame

Related Asset

Start Time El

Y

4. Cliquez sur l'icone

pour ouvrir le menu . Cliquez sur le crochet droit (>) dans I'une des catégories de
filtre pour ouvrir le volet correspondant.

Y

Dans les champs de filtre, indiquez les paramétres pour affiner la recherche de cadres d'événements. Par
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exemple, saisissez une chaine de caractéeres correspondant au modeéle dans le champ Nom de I'événement
ou sélectionnez un modéle dans Modéle de I'événement.

Event Frames

Y

Event Name

Event Template

Clear All Filters Apply Hiters

Cliquez sur Appliquer les filtres.
6. Sélectionnez un cadre d'événement parmi les résultats et faites-le glisser dans le volet central.
Le filtre inclut désormais les lignes pour lesquelles ce cadre d'événement est actif.

7. Vous pouvez également élargir les criteres de recherche des filtres de ligne afin d'inclure tous les cadres
d'événements correspondant au méme modeéle ou a la méme catégorie. Pour cela, utilisez le menu
déroulant pour modifier la recherche de Nom de I'événement a Modéle de I'événement ou Catégories
d'événements.

Create New Event Frame Row Filter

v S [ Y | ‘ Include rows with this Event Frame Active
matches |EventFrameAnalysis 20150612 01:45:32 XV
Event Name

» "H EventFrameAnalysis 20150612 01:46:32 tis any. Drag an element from the Shape Tree to specify.

Event Categories
» "8 EventFrameAnalysis 20150612 01:46:32 - AUTCYEnTCeamoh

» H§ EventFrameAnalysis 20150612 01:46:32
» Y@ EventFrameAnalysis 20150612 01:46:32
» BH FuantFramaAnalsis 2MR0R19 04632

v

récupere les cadres d'événements correspondant et les affiche dans le volet d'apergu en bas de la fenétre.

8. Cliquez sur l'icone a coté de la condition de I'événement.

9. Pour aligner les cadres d'événement avec le bon actif, faites glisser I'actif ou I'attribut de I'arborescence de
formes vers les critéres de filtre.

Cette étape permet de définir la relation entre les deux jeux de données (le jeu de données du cadre
d'événement et le jeu de données des actifs et des attributs). Cette relation est similaire a I'association d'une
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clause dans un tableau relationnel permettant de faire I'équation entre I'attribut d'un tableau (ou d'un jeu de
données) et I'attribut d'un autre tableau (ou jeu de données). Dans cet exemple, I'équation est faite entre
I'actif qui « possede » le cadre d'événement et |'actif de I'arborescence de formes.

actualise I'affichage des cadres d'événements correspondants dans |'apercu.

10. Lorsque vous avez terminé de définir le filtre, cliquez sur Enregistrer le filtre de ligne de cadre d'événement.

A propos de la publication de grandes vues

Les grandes vues contenant 100 éléments et attributs combinés ou plus sont susceptibles d'étre soumises a une
limite liée au protocole de transport Web Sockets dont la taille de paquet de données maximale est de 64 K.
Avant de publier une grande vue, vous devrez peut-étre définir le type de transport sur Evénements serveur
envoyés pour pouvoir traiter les tailles de paquets supérieures. Ceci ne doit s'appliquer qu'aux utilisateurs du
navigateur Web Microsoft Edge.

Sur n'importe quelle page, cliquez sur l'icone en forme d'engrenage H dans le coin supérieur droit et
définissez Type de transport sur Evénements serveur envoyés.

A propos des vues publiées en continu

Les vues peuvent étre publiées en continu selon une planification. Vous pouvez republier une vue a intervalles
courts d'une minute et jusqu'a 12 mois. Par exemple, vous pouvez configurer la republication de votre vue a 12 h
chaque jour.

Remarque : Les vues continues sont exécutées a I'heure locale lorsque le Service Pl Integrator Framework est
exécuté. Les utilisateurs se trouvant dans un autre fuseau horaire doivent donc prendre cela en compte lorsqu'ils
planifient leurs exécutions.

Chaque fois que la vue est publiée, les nouvelles données sont ajoutées aux données existantes. Le tableau ou
fichier cible ne cesse donc de se développer a chaque republication de la vue. Lors de la publication de vues
selon une planification, aucune option ne permet actuellement de remplacer les données. Par conséquent, vous
devez supprimer manuellement les données du tableau ou du fichier cible de publication dont vous n’avez plus
besoin.

Vous spécifiez la plage de temps de la période que vous souhaitez mettre a jour. Si l'utilisation des ressources est
trop importante, vous pouvez spécifier des intervalles plus courts et mettre a jour les données en publiant a
plusieurs reprises.

Vous spécifiez que vous souhaitez publier votre vue selon une planification dans la page Publish (Publier). Pour
plus d'informations, voir Publier une vue selon une planification.

Sur la page My Views (Mes vues), le Run Mode (Mode Exécution) des vues publiées en continu est défini sur
Continuous (Continu).

2018 prend en charge les mises a jour automatiques de données Pl System publiées pour des cibles
sélectionnées. Pour plus d’informations sur cette fonctionnalité, voir Comment les données publiées sont mises
ajour.
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Noms de vues et points limites de destination

Lorsque publie une vue, le nom de la vue est utilisé pour créer le nom du point de destination. Chaque cible
inclut des conventions et régles de dénomination d'un nom acceptable propres. Si un nom de vue contient un
caractere non autorisé par la cible, supprime le caractére ou le remplacement par un caractére de soulignement

().

Les cibles incluent également des regles sur la longueur du nom. Si le nom du point limite dépasse ces limites,
affiche un avertissement ou un message d'erreur.

Consultez la documentation de votre cible pour connaitre les conventions de dénomination et les limites de
longueur applicables.

Publier une vue une fois

Les vues exécutées une seule fois peuvent étre publiées immédiatement ou vous pouvez spécifier leur
publication ultérieure.

Pour plus d'informations sur la publication de vues selon une planification, reportez-vous a Publier une vue selon
une planification. Pour plus d'informations sur la publication de vues de diffusion, reportez-vous a Publier une
vue de diffusion.

1. Sur la page Publish (Publier), sélectionnez la cible dans la liste Target Configuration (Configuration de la
cible).

2. Cliquez sur Exécuter une fois.

3. (Facultatif) Indiquez la date et I'heure auxquelles vous souhaitez publier la vue.

Remarque : Les vues planifiées sont exécutées a I'heure locale de I'ordinateur qui exécute le Service Pl
Integrator Framework. Si vous vous trouvez dans un autre fuseau horaire, vous devrez peut-étre convertir
votre heure planifiée locale dans le fuseau horaire Service Pl Integrator Framework pour obtenir le résultat
souhaité.

4. Cliquez sur Publish (Publier).

Publier une vue selon une planification

Vous pouvez publier une vue selon une planification continue. Sur la page Publish (Publier), vous pouvez
spécifier la fréquence a laquelle vous souhaitez publier la vue. Les résultats de chaque exécution sont ajoutés
aux résultats précédents. Pour plus d'informations sur les vues publiées en continu, consultez A propos des vues
publiées en continu.

1. Sur la page Modifier la vue, saisissez la fréquence d'échantillonnage, ainsi que les heures de début et de fin.

Remarque : Pl Integrator for Business Analytics renvoie des données dans la plage de temps spécifiée par
I’heure de début et I’heure de fin uniquement lors de la premiere exécution.

2. Cliquez sur Suivant.

Sur la page Publish (Publier), sélectionnez la cible dans la liste Target Configuration (Configuration de la
cible).

4. Cliquez sur Run on a schedule (Exécuter selon une planification).
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5. Spécifiez la date et I'heure de la premiére exécution.

Remarque : Les vues planifiées sont exécutées a I'heure locale de I'ordinateur qui exécute le Service Pl
Integrator Framework. Si vous vous trouvez dans un autre fuseau horaire, vous devrez peut-étre convertir
votre heure planifiée locale dans le fuseau horaire Service Pl Integrator Framework pour obtenir le résultat
souhaité.

6. Spécifiez la fréquence des exécutions suivantes.

Remarque : Vous pouvez indiquer une fréquence allant d'une minute a 12 mois.

7. Cliquez sur Publish (Publier).

Planification des vues d'actif

Lorsque les vues d'actifs sont publiées selon une planification Pl Integrator for Business Analytics utilise les
paramétres suivants pour déterminer les plages de temps discretes dans lesquelles les données sont récupérées

e Heure de début

e Heure de fin

* Fréquence d'exécution

e Fréquence d'échantillonnage

e Premiére exécution

Pl Integrator for Business Analytics publie des données dans la plage de temps spécifiée par les parametres Start
Time et End Time uniquement lors de la premiére exécution.. Lors des exécutions suivantes, Pl Integrator for
Business Analytics évalue la fenétre de récupération des données avec la formule suivante :

e Start Time = End Time de la derniére publication + Sample Frequency

e End Time = End Time configurée, évaluée lors de I'exécution

Selon la configuration des parametres, il peut y avoir des différences considérables dans les données récupérées.
Pour plus d'informations, ainsi que des exemples qui illustrent I'effet des différentes configurations sur les
données récupérées, consultez How does view scheduling work for Pl Integrator Asset Views? (Comment
fonctionne la planification des vues d'actif Pl Integrator ?).

Publier une vue de diffusion

Les grandes vues contenant 100 éléments et attributs combinés ou plus sont susceptibles d'étre soumises a une
limite liée au protocole de transport Web Sockets dont la taille de paquet de données maximale est de 64 K.
Avant de publier une grande vue, définissez le type de transport sur Evénements serveur envoyés pour pouvoir
traiter les tailles de paquets supérieures.

Sur la page Mes vues, cliquez sur l'icbne en forme d'engrenage n dans le coin supérieur droit et définissez
Type de transport sur Evénements serveur envoyés.

Remarque : Les vues de diffusion ne peuvent diffuser que 25 000 correspondances de la forme de la recherche.
Lorsque cette limite est atteinte, aucune autre correspondance n'est diffusée et un message d'erreur est ajouté
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dans le fichier journal de la vue.

Sur la page Publier, sélectionnez la cible dans la liste Configuration de la cible.

2. (Apache Kafka uniquement) Sélectionnez une rubrique vers laquelle le message est envoyé.
Par défaut, les messages sont envoyés vers une rubrique portant le méme nom que la vue.
Vous pouvez également choisir d'envoyer les messages vers des rubriques existantes.

a. Cliquez sur Obtenir des rubriques pour renseigner la liste des rubriques disponibles dans laquelle vous
pouvez sélectionner.

b. Cliquez sur la fleche pour afficher la liste des rubriques.
Indiquez I'heure de début de la premiére publication de la vue.
4. Cliquez sur Publish (Publier).

Afficher les données de statistiques

L'onglet Statistiques fournit des informations sur le processus de publication de vues. Ceci est utile pour
résoudre les problemes d'étranglement pendant la lecture de données du Pl System en écrivant les données
dans la cible. Les statistiques incluent I'heure de chaque exécution publiée. Ceci peut étre utile lors de la
planification quand des applications en aval lisent les données de la cible.

Si vous ne voyez pas les statistiques d’une période antérieure, il est possible que Pl Integrator ait purgé ces
enregistrements du SQL Server sur lequel ils sont stockés afin d’éviter une utilisation excessive du disque. Voir
Définir vos stratégies de conservation d'enregistrement pour plus d’informations sur la fréquence de suppression
de ces enregistrements. Utilisez la procédure ci-dessous pour vous familiariser avec les informations de I'onglet
Statistiques.

1. Dans la page Mes vues, sélectionnez la vue qui vous intéresse.

2. Sile volet Détails de la vue n'est pas ouvert, cliquez sur le bouton en bas a droite pour I'ouvrir. Cliquez
ensuite sur I'onglet Statistiques.

Les statistiques de la vue sélectionnée s'affichent.

Qverview Log Security View Configuration Statistics
Run History Duration (seconds)
Run Instances + Duration Rows Written Rows Filtered Error Count All Runs
seconds ¥ 9
26
. - 24\
1/22/207:18 AM 22.327 0 0 0 gl | W, VANAT, WIPS, WP, WY, W U S g 'V, VN f’\.».m.o.-...../\-j Nertnees,,
1/22/20 7:28 AM 23.23 0 0 0 T(: | |
16 ‘ ‘
1/22/207:38 AM 24.019 0 0 0 - | |
12+
1/22/20 7:48 AM 22.291 0 0 0 0] ‘ |
Total 96 2,121.159 0 ] 0 | 7 |‘ ‘
2
24 *-

Download All Reports able Full Reporting T T T T T T T T T T T T T T T T
| bl ! || e (] -y | 10PM 11PM Wed2z 01AM DZAM O0ZAM O4AM O05AM 0BAM OTAM 08AM ODAM 10AM 1AM 12PM 01PM

3. Cliquez et choisissez un des statistiques dans I'en-téte de tableau pour afficher les données de tendance.
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Qverview Log Security View Configuration Statistics

Run History Duration (seconds)
All Runs

1/22/20 7:18 AM 22.327 0 ] 0 - :i
000 204
1/22/20 7:28 AM 2323 0 0 [\ ]
000 18-
1/22/20 7:38 AM 24019 0 0 [ ol
12+

1/22/20 7:48 AM 22.291 0 0 [ o
o o]

Total 96 2,121.159 0 0 0 | 1
-+

2

| Download All Reports Enable Full Reporting

T T T T T T T T T T T T T T T n
10PM 11PM Wed 22 01AM DZAM 0DZAM 04AM 05 AM 05AM OTAM 03AM 09AM 10AM 1AM 12PM 01FM

4. Cliquez sur une ligne du tableau pour afficher des statistiques supplémentaires pour I'exécution sélectionnée
dans le volet de droite.

5. Cliquez sur Afficher toutes les exécutions pour revenir a la vue de tendance.

Qverview Log Security View Configuration Statistics

Run History Duration (seconds)
ZD:

1/22/207:18 AM 22.327 0 0 [ *
1/22/20 7:28 AM 23.23 0 0 [:} 15
1/22/20 7:38 AM 24.019 0 0 [:}
10
1/22/20 7:48 AM 22.291 0 0 0
5
Total 96 2,121.159 0 0 0 |
| View Logs for Run Download Selected Report Enable Full Reporting o

T T
Reading from FI Filtering & Caleulating Wiriting to MSSQL

6. Sélectionnez une partie du graphique de tendance pour effectuer un zoom avant.

Duration (seconds)
All Runs

26 {23.7 01/22/20 05:48:47 AM|

B e L S —
22 - 1
20 -

L}.

T T T T T T T T T T T T T T T LI
10PM 11 PM Wed22 01AM O2AM 03 AM 04AM 05 AM OHAM OF AM OB AM CBAM 10AM 11AM 1ZPM 01FPM

La zone sélectionnée est agrandit pour remplir I'axe X du graphique.
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Duration (seconds)
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7. Cliquez sur la loupe pour effectuer un zoom arriere.

Duration (seconds)

All Runs

26 -

<]

22 _“

20

18
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12
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S_

5

4

.

o 1
06 AN 0815 06:20 06:45 07 AM 07:15 07:30 0745 08 AM

8. Cliquez sur un nceud du graphique de tendance pour afficher les détails de cette exécution.
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Duration (seconds)
All Runs
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9. Cliguez sur Afficher les journaux d'exécution pour voir les enregistrements du journal de I'exécution.

Pl Integrator vous améne a l'onglet Journal de I'exécution sélectionnée.

Activer la génération de rapports complets

Remarque : L'assistance technique utilise la fonctionnalité Activer la génération de rapports complets pour
collecter des statistiques complétes permettant de résoudre des problémes liés a la publication de vues.
N'activez cette fonctionnalité que si I'assistance technique vous le demande. Lorsque la génération de rapports
complets est activée, I'espace disque disponible peut étre rapidement rempli.

1. Identifiez la vue qui rencontre des problemes de performances.

2. Accédez a l'onglet Statistiques de la vue, puis cliquez sur le bouton Activer la génération de rapports
complets.

Attendez que la prochaine publication programmeée s’exécute pour la vue.

4. Dans l'onglet Statistiques, faites défiler pour afficher les instances d’exécution qui se sont produites apres
avoir activé la génération de rapports complets.

5. Cliquez sur l'instance d’exécution, puis sélectionnez Télécharger le rapport sélectionné. L'instance de vue
doit avoir une icbne de graphique a barres a c6té de I’horodatage pour indiquer que la génération de
rapports complets a été activée pendant I'instance d’exécution en question.

6. Cligquez sur le bouton Désactiver la génération de rapports complets.

Comment les données publiées sont mises a jour

Sync Pl Integrator surveille les actifs dans le Pl System pour les vues d'actif, les vues de diffusion continue
planifiée et les vues de diffusion déclenchées par une valeur clé. Il maintient vos données publiées a jour selon
les manieres suivantes :
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¢ Pl Integrator Sync surveille votre forme d'actif et suit les modifications apportées a Pl AF affectant les
correspondances dans votre vue. Par exemple, supposons que vous ayez une vue de pompes et qu'il existe
10 correspondances. Une nouvelle pompe est ajoutée a Pl AF qui entraine 11 correspondances dans votre
forme d'actif. Sync Pl Integrator publie les données des 11 correspondances et, pour les vues d'actifs et les
vues de diffusion continue planifiée, il remplit les données de la nouvelle pompe.

¢ Pl Integrator Sync surveille les modifications apportées aux données dans Serveur Data Archive et met a jour
les données publiées. Par exemple, lorsqu'une valeur de données dans Serveur Data Archive est mise a jour
avec une nouvelle valeur, Pl Integrator Sync publie la nouvelle valeur sur la cible.

Remarque : Pour une définition des différents types de vues de diffusion, voir A propos des déclencheurs de
message.

Pl Integrator Sync surveille les données remplies et dans le désordre, et met a jour les données publiées
précédemment toutes les 30 minutes. Ainsi, lorsqu'une modification est apportée dans Pl AF ou Serveur Data
Archive, 'application de cette modification a vos données peut prendre jusqu'a 30 minutes. Si les données
tardent a arriver dans Pl Data Archive et que Pl Integrator for Business Analytics a déja publié des données pour
la période couverte par ces données tardives, ces dernieres seront automatiquement mises a jour dans la table
de destination. Pour vous assurer que toutes les données sont publiées, configurez un délai dans le parametre
Heure de fin de la vue (par exemple, *-1h), ou remplissez manuellement les données une fois qu'elles sont
arrivées dans Pl Data Archive. Pour plus d’informations, voir Mettre a jour les données manuellement.

Pour tirer profit des fonctionnalités de synchronisation de PI Integrator Synch, vous devez utiliser Serveur Data
Archive 2017 ou version ultérieure.

Le tableau suivant indique chaque cible et le type de synchronisation pris en charge.

Prend en charge la Prend en charge la
Type Cible synchronisation avec Pl synchronisation avec
AF Serveur Data Archive
Base de données Azure SQL Database
relationnelle

Microsoft SQL Server

Base de données Oracle

SAP HANA

Data Warehouse Amazon Redshift

Apache Hive

Pool SQL dédié Azure

Google Big Query

AN NENE NANANEN
AN NENE N N NN
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Prend en charge la Prend en charge la
Type Cible synchronisation avec Pl synchronisation avec
AF Serveur Data Archive
Non structurées Fichier texte
*
Data Lake Amazon S3

*

Azure Data Lake Storage G
en 2

AN

Google Cloud Storage

*

Hadoop HDFS

*

Plateforme de messagerie | Flux de données Amazon
Kinesis

Apache Kafka

*
*

Azure Event Hubs

Azure loT Hub

*
*

Google Cloud Pub/Sub

AN END VBN NA NN

ANANANE NN

Remarque : Pour les cibles Data Lake et fichier, Pl Integrator Sync surveille les modifications apportées a la forme
des vues d’actifs et publie les données des correspondances a venir. Les modifications de Pl Data Archive ne sont
toutefois pas prises en charge. Sync Pl Integrator ne remplit donc pas les données pour ces cibles ni ne met a
jour les modifications apportées aux données publiées. L'exception a cette regle réside dans

Azure Data Lake Storage Gen 1 et Azure Data Lake Storage Gen 2 qui prennent en charge la synchronisation de la
forme de la vue d’actif et des modifications apportées aux données.

Remarque : Les cibles de diffusion en continu offrent une prise en charge de la synchronisation pour la diffusion
en continu planifiée uniquement. Les vues de diffusion en continu déclenchées par une clé ne prennent pas en
charge la synchronisation.

Comment les données publiées sont synchronisées avec Pl AF

Ce qui suit décrit comment les données publiées sont synchronisées avec les modifications apportées a la
hiérarchie Pl AF :

¢ Un élément est ajouté a PI AF :

Remarque : Assurez-vous que toutes les modifications apportées dans Pl System Explorer / le serveur AF ont
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été enregistrées avant de créer une vue qui cible ces modifications. Les éléments qui ne correspondaient pas
a la forme de votre vue lors de la création, et qui sont modifiés ultérieurement pour correspondre a la forme
de votre vue, ne seront pas automatiquement ajoutés a votre ou vos vues existantes. De plus, si la forme de
la vue contient des attributs qui ne sont pas marqués comme facultatifs dans la configuration de la vue, ces
attributs doivent étre présents sur I'élément lors de la création de I'élément pour que ce dernier et les
attributs correspondants soient ajoutés a votre ou vos vues existantes.

¢ Vues d'actif et vues de diffusion continue planifiée : si un élément ou une combinaison d'éléments et
d'attributs est ajouté(e) a Pl AF et entraine une nouvelle correspondance dans votre vue, les données du
nouvel élément sont publiées et les données sont remplies a I'heure de début de la vue d'origine.

¢ Vues de diffusion déclenchées par une valeur clé : si un élément ou une combinaison d'éléments et
d'attributs est ajouté(e) a Pl AF et entraine une nouvelle correspondance dans votre vue, les données du
nouvel élément sont uniquement ajoutées. Les données publiées précédemment ne sont pas remplies.

¢ Un élément est supprimé de Pl AF : si un élément est supprimé de PI AF entrainant un changement du
nombre de correspondances dans votre vue, les données de I'élément ne sont pas publiées. Les données
publiées précédemment sont toutefois conservées.

¢ Un élément est renommeé dans Pl AF : si un élément est renommé dans PI AF, I'élément est
automatiquement renommé dans la vue. Le nouveau nom apparait dans les données publiées, mais les
données publiées précédemment conservent |I'ancien nom d'élément.

Remarque : Les modifications des autorisations d’identité AF sur les éléments existants ne sont pas suivies
par Pl Integrator Sync. Par exemple, si des autorisations de sécurité AF sont ajoutées a un élément qui n’est
pas en cours de publication par une vue, les données relatives a cet élément ne seront plus
automatiquement publiées a I'avenir, et ne seront pas non plus incluses dans les remplissages de données. Si
les autorisations de sécurité AF sont supprimées d’un élément, les publications suivantes pourront toujours
accéder aux données de I'élément malgré la révocation des autorisations. Pour refléter les modifications des
autorisations d’identité AF sur un élément existant, les vues faisant référence a cet élément devront étre
republiées, ou I'élément lui-méme devra étre recréé. Pour plus de détails sur I'identité AF utilisée par

Pl Integrator Sync, voir Sécurité des données.

Ce qui suit décrit comment les données publiées sont synchronisées avec les données Serveur Data Archive
remplies et dans le désordre pour chaque type de vue :

¢ Vues d'actif : en cas de changement des données Pl Data Archive, les données cibles sont automatiquement
mises a jour. Sync Pl Integrator remplace les données dans la cible.

¢ Vues de diffusion continue planifiée : en cas de changement d'une valeur de données, la nouvelle valeur est
publiée sur la cible. La valeur publiée précédemment n'est toutefois pas supprimée. Loption Données de
remplissage de la page Modifier la vue doit étre activée pour permettre cette fonctionnalité.

¢ Vues de diffusion déclenchées par une valeur clé : la mise a jour des données n'est pas possible pour les vues
de diffusion déclenchées par une valeur clé.

¢ Vues d’événements — Les vues d’événements ne capturent pas automatiquement les données de
modification et les données dans le désordre, mais ce type de données peut étre publié manuellement a
I'aide de la fonctionnalité de mise a jour des données (bouton). La plage de temps que vous spécifiez dans
votre mise a jour manuelle des données capturera tous les cadres d’événements dont I’heure de fin se situe
dans cette plage.
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Mise a jour manuelle

Vous pouvez mettre a jour manuellement les données quelle que soit la version de Pl Data Archive.

Toutefois, si vous utilisez PI Data Archive 2016 R2 ou une version antérieure, Pl Integrator for Business Analytics
ne prend pas en charge la mise a jour automatique des données. Par conséquent, la mise a jour manuelle des
données qui ont été modifiées depuis la publication est la seule option disponible.

Vous ne pouvez mettre a jour manuellement les données que dans des vues d'actif et dans des vues de diffusion
continue planifiée pour des cibles prises en charge. Vous ne pouvez pas mettre a jour les données dans des vues
qui ne sont publiées qu'une fois ou qui sont publiées sur une cible fichier ou HDFS, et vous ne pouvez pas mettre
a jour les vues de diffusion déclenchées par une valeur clé.

Vous ne devez mettre a jour manuellement que si les données ont changé depuis leur derniere publication dans
le magasin de données cible. Toutes les modifications apportées aux données avant une publication planifiée
sont écrites dans le magasin de données avec les dernieres valeurs.

Les données peuvent changer dans certaines circonstances :

¢ Les données se trouvaient en mémoire tampon sur un nceud d'interface au moment de la publication de la
vue.

¢ Les données sont remplies ou recalculées. Ceci s'applique généralement aux points Pl AF Analytics.

¢ Les données sont saisies manuellement aprés la publication de la vue.

Mettre a jour les données manuellement

1. Sélectionnez une vue dans la page Mes vues dont I'état Mode d'exécution est défini sur Continu ou
Diffusion continue planifiée.

2. Cliguez sur la barre horizontale dans le coin inférieur droit de la page Mes Vues pour ouvrir le volet
d'informations.
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My Views

=+ Create Asset View

+ Create Event View

& Modify View

¥ remove View

3. Cliquez sur I'onglet Apergu.

My Views

BL o deta : w starting with your ?;_Ess data view starting with time Modify existing data view Remove selected view
i Name Run Status Type Run Mode Start Time
Pump A19375X1 Mot Yet Published Asset Continuous *-8h
-Pump C97534X2 Not Yet Published Asset ‘Once *-8h
‘Pump G27834V3 Not Yet Published Asset ‘Once *-8 hours
-Pump B9I0B53V1 Not Yet Published Asset ‘Once *-8h
-Pump G78359X2 Not Yet Published Asset ‘Once *-8h
‘Pump U57328X2 Not Yet Published Event ‘Once
-Pump X75132X3 Not Yet Published Asset ‘Once *-8h
——
— m

& Create Asset View

Build a data view starting with your

+ Create Event View

data view starting with time

& Modify View
Modify existing data view

X Remove View
Remave selected view

asset hierarchy
] Name Run Status Type Run Mode Start Time E|¥Y=
Pump A19375X1 Scheduled Continuous *8h 5
‘Pump C97534X2 Not Yet Published ‘Once 8h
{Pump G27834V3 Not Yet Published ‘Once =8 haurs
{Pump B90B53V1 Not Yet Published ‘Once i=8h
Pump G78359X2 Not Yet Published ‘Once -8h
{Pump U57328X2 Not et Published ‘Once : :
‘Pump X75132X3 Not Yet Published ‘Once ~8h
i »
| —mE
Qverview Log Security
Run Status Scheduled Publish Actions Search Shape
View Name Pump A15375X1 Asset Shape
Pl AF Database Datacenter Demo 4 @ Atlanta
Publish Target SQL Server 4 @ colot
View Type Asset # ColoNumber
& Zonel Capacity
Run Mode Continuous
& Zonel CapacityPercent
¢ Dans le volet Actions de publication, cliquez sur Mettre a jour les données.
Remarque : Si le bouton Mettre a jour les données est désactivé, cela signifie que la mise a jour
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manuelle n’est pas prise en charge pour cette vue. Pour en savoir plus sur les vues pouvant étre mises a
jour, voir Comment les données publiées sont mises a jour.

4. Indiquez la période des données que vous voulez mettre a jour.

Remarque : Vous pouvez seulement mettre a jour des données pour une période donnée dans le passé.

5. Cliquez sur Confirmer.

Remarque : Pl Integrator supprime d’abord les données existantes spécifiées dans la plage de temps avant
de publier de nouvelles données.

Modifier une vue

Lorsqu'une vue est modifiée, les effets concernent la gestion des données existantes :

¢ Lorsqu’une vue d'actif ou d’événement publiée précédemment est modifiée et publiée a nouveau, les
données existantes sont supprimées. Les données publiées précédemment ne sont pas conservées. L'heure
de début de la vue d'actif ou d'événement modifiée correspond a I'heure de début de la premiere
publication. Lorsqu’une vue qui publie sur une cible de publication basée sur un fichier est publiée a
nouveau, les fichiers de données publiées existantes sont supprimés. Pour les cibles de publication basées
sur une table, I'action de nouvelle publication supprime la table cible existante. Dans les deux cas, les
données publiées précédemment ne sont pas conservées. L'heure de début de la vue d'actif ou d'événement
modifiée correspond a I'heure de début de la premiére publication.

¢ Les données lues a partir d'une cible de diffusion dans un autre systeme ne sont pas modifiées. Vous devrez
harmoniser les différences dans les données envoyées pour la vue d'origine et la vue modifiée. Dans la
plupart des cas, vous devrez probablement supprimer les données stockées existantes avant de publier la
vue modifiée.

Vous pouvez également effectuer une copie d'une vue et modifier la copie. Cette vue sera considérée comme
une nouvelle vue.

1. Dans la page Mes vues, sélectionnez la vue que vous souhaitez modifier et cliquez sur Modifier la vue.
2. Dans la boite de dialogue Modifier la vue, effectuez I'une des taches suivantes :
e Pour modifier la vue — Cliquez sur Editer cette vue.

e Pour modifier une copie de la vue — Sélectionnez Editer une copie de cette vue, entrez un nom unique
pour la vue, puis cliquez sur Editer la vue.

La vue sélectionnée s'affiche a la page Sélectionner des données. Vous pouvez continuer a apporter des
modifications a la forme de données, a modifier la vue et a publier les données.

Pour plus d'informations sur la modification d'une vue, reportez-vous a Créer une vue d'actif, Créer une vue
d'événement et a Créer une vue de diffusion.

Remarque : si le parameétre de sécurité d’usurpation d’identité de I'application est activé, la vue modifiée ou
copiée utilisera les identités AF associées a I'utilisateur qui a copié ou modifié la vue pour l'acces aux
données au lieu des identités AF associées a I'utilisateur en charge de la derniere publication. Pour plus
d'informations, reportez-vous a la section Data security.
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Copier une vue

Pour créer une copie de la vue de votre choix : sélectionnez-la a la page Mes Vues et cliquez sur Modifier la vue.

Renommer une vue

Vous pouvez renommer une vue sur la page Mes Vues.

1. Sur la page Mes Vues, cliquez sur I'une des barres dans le coin inférieur droit de la page pour ouvrir le volet
d'informations.

Le volet s'ouvre et I'onglet Apergu est sélectionné.

. ;s
2. Cliquezsur © aco6té dunom de lavue.

Remarque : Il n'est pas possible de renommer des vues pour les cibles Flux de données Amazon Kinesis,
Amazon S3, Apache Kafka, Azure Event Hubs, Azure loT Hub, Azure Data Lake Storage Gen 2, Google

BigQuery, Google Cloud Pub/Sub, Google Cloud Storage, Systéme de fichiers distribué Hadoop et Fichier
texte.

3. Modifiez le nom de la vue, puis cliquez sur Renommer.

Sécuriser vos vues

Vous pouvez contréler I'accés a toutes les vues pour lesquelles vous avez I'autorisation Propriétaire. Pour plus
d'informations, reportez-vous a la section Autorisations d’acces utilisateur .

Cliquez sur l'icone du menu E, puis cliquez sur Mes Vues.
2. Sur la page Mes vues, sélectionnez une vue dans la liste.
Les détails de la vue apparaissent sous la liste dans le volet Détails.

3. Cliquez sur I'onglet Security.
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+ Create Asset View + Create Event View l + Create Streaming View [# wodif
Name Run Status Start Time Run Mode Creatiod
Bailer Wiew Fublished “-Bh Once Q822 §
Compressor View FPubdished *-8h Once IRF22 3
Pump View Fublished “8h Once 0112122
|
| e
Owerview Log Security View Configuration Statistics
Identities
View Access @ Data Access @
-l- o @grator Sarv -
Pl Imtegrat rvica & Adminiatrators 2 World
2 ngneers
! Add (= Remove

Remarque : les identités d’accés aux données correspondent aux identités AF utilisées pour accéder aux
données sources lorsque le paramétre de sécurité d’usurpation d’identité de I'application est activé ; elles ne
sont affichées que lorsque ce parameétre est activé.

4. Vous pouvez effectuer les actions suivantes sur la vue sélectionnée sous Acces a la vue.
¢ Modifier les autorisations sur une vue
e Ajouter une nouvelle identité et accorder une autorisation a la vue

e Supprimer l'acces a une vue
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Sécurité de Pl Integrator Framework

Trois notions générales sont a prendre en compte pour la planification de la sécurité de Pl Integrator for Business
Analytics :

e Sécurité de I'application — Définit les meilleures pratiques pour sécuriser les services de Pl Integrator for
Business Analytics, telles que les mesures de défense contre les attaques par déni de service (DoS).

e Sécurité des données : détermine les utilisateurs autorisés a accéder aux données dans Pl AF et comment
cette sécurité est gérée.

Remarque : La sécurité des données publiées se trouvant sur la cible désignée doit étre prise en compte. La
sécurité des données publiées est traitée et gérée dans la cible de publication elle-méme. Pour plus
d’informations sur la gestion de I'accés aux données de cible, voir Secure views for an identity.

e Sécurité d’acces des utilisateurs — Définit les utilisateurs autorisés a accéder a I'application web Pl Integrator
for Business Analytics, leur niveau d’accés (Administrateur) et leurs droits d’accés et de configuration de vues
spécifiques et de cibles de publication dans I'interface utilisateur (IU) de Pl Integrator for Business Analytics.

Securité de I'application

Mesures de défense contre le déni de service (DoS)

Data

Pour optimiser la sécurité de PI Integrator for Business Analytics, nous vous recommandons d’installer Pl
Integrator dans une architecture intranet, afin qu’il soit protégé par la sécurité de votre réseau.

Dans les cas ou il est nécessaire d’écrire sur des cibles basées sur Internet, comme une plate-forme cloud, PI
Integrator doit étre configuré pour publier sur ces cibles via un proxy HTTP. Pour plus d’informations, voir
Comment connecter Pl Integrator pour publier sur des cibles via un proxy HTTP.

security

L'accés aux données Pl AF dans l'interface utilisateur de Pl Integrator for Business Analytics et les données qui
peuvent étre publiées par les services Pl Integrator dépendent du parametre d’usurpation d’identité de votre Pl
Integrator for Business Analytics. Le mode d’usurpation d’identité permet aux utilisateurs d’accéder aux
ressources Pl AF depuis I'interface utilisateur de Pl Integrator en fonction des autorisations de sécurité AF d’un
compte Active Directory.

Le parametre d’usurpation d’identité de I'application est désactivé par défaut :

¢ lors de la configuration d’une vue, les utilisateurs sur les machines clientes font des demandes a Pl AF par
I'intermédiaire du service Pl Integrator Framework. L'utilisateur hérite des autorisations Pl AF et Pl Data
Archive qui ont été accordées au compte de service Pl Integrator for Business Analytics.

¢ Toutes les publications et mises a jour planifiées par le service Pl Integrator Sync utilisent les autorisations
accordées au compte de service Pl Integrator for Business Analytics.

¢ Lorsque le mode d’usurpation d’identité est désactivé, I'intégrateur Pl utilise les autorisations de sécurité AF
du compte de service de I'intégrateur Pl pour accéder aux ressources Pl AF.
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Le parameétre de sécurité de I'usurpation d’identité de I'application est activé :

¢ lors de la configuration d’une vue a des fins de publication, un utilisateur demande des données a un serveur
Pl AF par I'intermédiaire du service PI Integrator Framework. Le service Pl Integrator Framework renvoie des
données a l'utilisateur final uniquement qui s’est vu accorder un acces en lecture aux données dans les
serveurs Pl AF.

¢ Lorsque l'usurpation d’identité est activée, les autorisations de sécurité AF d’un utilisateur de connexion
actuellement authentifié sont utilisées. L'activation du mode d’usurpation d’identité permet a l'utilisateur
d’accéder aux ressources de Pl AF avec les autorisations de sécurité AF de 'utilisateur authentifié actuel.
Toutes les publications et mises a jour planifiées par le service Pl Integrator Sync utilisent les autorisations
accordées a l'utilisateur actuellement authentifié.

e A partir de Pl Integrator for Business Analytics 2020 R2 SP2, une liste des identités AF mappées sur le
créateur de la vue au moment de la premiere publication de chaque vue est utilisée pour déterminer les
données qu’une vue peut publier a chaque publication suivante. Plus précisément, I'acces de |'utilisateur aux
objets du serveur PI AF source (tels que les éléments, les attributs et les modeéles) pour une vue est
déterminé par les autorisations de sécurité AF définies pour les identités AF associées d’'un compte
d’utilisateur Active Directory de cet utilisateur particulier. Lorsqu’une vue est publiée, les identités AF
associées a 'utilisateur qui publie la vue sont sauvegardées avec la configuration de la vue.

Un accés supérieur aux données

e Limitez les autorisations Pl AF pour le compte de service Pl Integrator aux autorisations minimales requises
pour qu’ils puissent voir et publier les données qu’ils doivent pouvoir voir. Pour plus d’informations, voir
Taches a effectuer apres l'installation.

¢ Limitez les autorisations de Pl Data Archive pour le compte de service Pl Integrator aux autorisations
minimales requises pour publier les données dans PI Integrator for Business Analytics. Pour plus
d’informations, voir Taches a effectuer apres l'installation.

Autorisations d'acces utilisateur

Un utilisateur peut accéder a I'interface utilisateur (1U) de Pl Integrator for Business Analytics lorsque I'identité
AF a laquelle il est associé est présente sur la page Utilisateurs de Pl Integrator for Business Analytics
Administration. Il existe deux réles d’autorisation d’accés au niveau de I'application : Administrateur Pl Integrator
et Utilisateur Pl Integrator.

¢ Administrateur — Les utilisateurs associés a une identité AF dont la case Administrateur est cochée peuvent
exécuter toutes les fonctions administratives de I'interface utilisateur de Pl Integrator for Business Analytics,
telles que I'ajout ou la modification d’identités, de vues et de cibles de publication existantes, ainsi que la
possibilité d’ajouter et de configurer des autorisations pour d’autres utilisateurs. Ils peuvent également voir
et modifier toutes les vues, indépendamment du fait que I'identité de I'AF dispose d’autorisations de lecteur
ou de propriétaire.

Utilisateur — Les utilisateurs qui ne sont pas associés a une identité AF dont la case Administrateur est cochée
ne peuvent pas accéder a la page Administration. L'acces aux vues individuelles via I'interface web dépend
de l'autorisation de vue attribuée a I'utilisateur pour cette vue (propriétaire de la vue, lecteur de la vue). Les
administrateurs disposent d’un accés complet aux vues créées par tous les utilisateurs, quelle que soit
I'autorisation de vue. Pour plus d’informations, voir Autorisations d’accés utilisateur . Les autorisations
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d’acces des utilisateurs peuvent étre modifiées dans l'onglet Utilisateurs de la page Administration, comme
indiqué dans Ajouter et configurer des identités.

Autorisations d'acces utilisateur

Lorsqu’une vue est créée, I'identité Pl AF a laquelle I'utilisateur qui crée la vue est associé se voit attribuer
I'autorisation Propriétaire de la vue. Si l'utilisateur qui crée la vue est affecté a plusieurs identités Pl AF ayant
acces a Pl Integrator for Business Analytics, il peut sélectionner I'une de ces identités dans la liste déroulante
Propriétaire de la vue pour étre le propriétaire de la vue. Seules les identités Pl AF ayant accés a sont disponibles.
Si I'utilisateur qui crée la vue ne choisit pas d’identité AF en tant que propriétaire de la vue, une identité Pl AF est
affectée, par défaut, dans l'ordre suivant :

¢ Sil'utilisateur n'est associé qu'a une seule identité Pl AF, celle-ci est utilisée.

o Sil'utilisateur est associé a plusieurs identités, I'identité avec le moins de mappings est affectée. Les identités
a un seul utilisateur et les identités de groupe sont traitées de la méme maniéere. Si plusieurs identités
comportent le méme nombre de mappings, la premiére dans I'ordre alphabétique du nom d'identité est
affectée.

Lorsqu'une vue est créé, vous pouvez y affecter d'autres identités Pl AF. Pour plus d’informations, voir Sécuriser
VOS Vues.

Les utilisateurs peuvent se voir attribuer les autorisations suivantes sur une vue :

¢ L'autorisation Propriétaire autorise I'accés en écriture a la configuration de la vue, permet a l'identité de
modifier les autorisations sur la vue et autorise |'acces a la vue.

¢ Lautorisation Lecteur autorise I'accés en lecture a la configuration de la vue.
¢ Les lecteurs peuvent arréter et reprendre une vue

¢ Les lecteurs peuvent exécuter une mise a jour manuelle des données a I'aide du bouton Mettre a jour les
données

¢ Les lecteurs peuvent faire une copie d’une vue
e Les lecteurs ne peuvent pas supprimer une vue

¢ Les lecteurs ne peuvent pas modifier une vue

Remarque : Les autorisations de vue peuvent étre modifiées dans I'onglet Utilisateurs de la page
Administration, comme indiqué dans Ajouter et configurer des identités.

Gérer les autorisations

La page Identities (Identités) vous permet de gérer tous les utilisateurs et leurs accés aux vues et cibles de
publication. Vous devez étre un administrateur de pour accéder a cette page.
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User Access Permissions @ Users and Groups o
Idantity Deseription A BULTIN Adminisiraiorns

L world World security sccess

L Piintegrator Service Coeated by Pi integrator Setup K

& Cwrer Orwmee security sccese

Le tableau décrit les taches que vous pouvez effectuer. Les chiffres correspondent aux numéros dans la capture
d'écran et identifient ol la tache est effectuée sur la plage.

unNombre Tache de sécurité

1 Créer des identités Pl AF

2 Affecter des utilisateurs et groupes aux identités

3 Spécifier sur quelles cibles les identités Pl AF peuvent

publier des données

4 Spécifier a quelles vues les identités Pl AF peuvent
accéder et leur niveau d'acces

5 Accorder a 'administrateur d’identité sélectionné des
privileges dans I'interface utilisateur de Pl Integrator
for Business Analytics

Pour plus d’'informations sur I'exécution de ces taches, voir Ajouter et configurer des identités.

How to secure views

Il est essentiel de s'assurer que seuls les utilisateurs autorisés peuvent accéder aux vues, afin de garantir la
sécurité et la protection de vos données.

o S'il existe des identités AF sous Autorisations d’acces utilisateur auxquelles vous ne souhaitez pas donner

acces a l'interface utilisateur de Pl Integrator for Business Analytics, utilisez le bouton Supprimer pour
supprimer I'acces.

¢ Cochez la case Administrateur uniquement pour les identités AF auxquelles vous souhaitez accorder des
privileges d’administrateur Pl Integrator.

Deux options s'offrent a vous pour sécuriser vos données :

¢ Vous pouvez configurer I'accés a n’'importe quelle vue dont vous étes le propriétaire sur la page Mes Vues.
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¢ Sivous étes un administrateur Pl Integrator for Business Analytics, vous pouvez configurer I'accés aux vues
par identité ou par vues sur la page Administration :

¢ Sivous souhaitez configurer les vues auxquelles une identité a acces, voir Secure views for an identity.
¢ Sivous souhaitez configurer les identités pour une seule vue, voir Gérer |'acces a une seule vue.

¢ Sivous souhaitez configurer les identités pour plusieurs vues a la fois, voir Gérer |'acces a plusieurs vues.

Pour plus d’informations, voir Sécuriser vos vues.

Procéder a la migration vers une sécurité de données basée sur des
identités AF

La migration vers la sécurité de données basée sur des identités AF n’est nécessaire que si le paramétre de
sécurité d’usurpation d’identité de I'application est activé pour Pl Integrator for Business Analytics et que vous
vous préparez a passer a Pl Integrator for Business Analytics 2020 R2 SP2. Si vos utilisateurs et vos ressources,
tels que les serveurs Pl AF, se trouvent dans un domaine unique ou dans un environnement de trust
bidirectionnel entre foréts de domaines, la migration est incluse dans le processus de mise a niveau régulier dans
le programme d’installation de Pl Integrator for Business Analytics pour les mises a niveau interactives et
silencieuses. La plupart des mises a niveau ne nécessitent aucune étape a I'extérieur du programme
d’installation pour passer a la sécurité de données basée sur des identités AF.

Si Pl Integrator for Business Analytics est installé dans un environnement de trust unidirectionnel entre foréts de
domaines ou les utilisateurs créateurs de vues se trouvent dans un domaine d’utilisateurs, et le compte de
service Pl Integrator for Business Analytics et les ressources telles que Pl AF se trouvent dans un domaine de
ressources distinct, vous devez effectuer une étape supplémentaire avant d’exécuter le programme
d’installation. Exécutez l'outil de migration des identités séparément sur une machine de votre domaine
d’utilisateurs pour préparer vos vues existantes a utiliser le modeéle de sécurité de données basée sur des
identités AF.

L'outil de migration des identités prépare vos vues Pl Integrator for Business Analytics a 'utilisation du nouveau
modele de sécurité de données basée sur des identités AF.

¢ AVEVA recommande d’exécuter tout d’abord 'outil dans un mode d’apercu uniguement, qui génére un
rapport des résultats attendus mais ne modifie pas le gabarit d’élément de votre vue ou les éléments de vue.

¢ Ladate et I’heure sont ajoutées aux fichiers de sauvegarde, du journal et du rapport générés, afin que les
nouvelles exécutions ne remplacent pas les résultats des anciennes exécutions, par exemple,
Preview_ViewMigration_Report_2022-08-02_07-34-44-188.html.

En mode de non-prévisualisation, I'outil de migration des identités :

1. Effectuez une sauvegarde XML de vos éléments de vue existants spécifiés par InstancePath que vous
transmettez a l'outil.

2. Modifiez le gabarit d’élément PI_INTEGRATOR_VIEW.

3. Modifiez les attributs existants dans la base de données de configuration AF, inclus dans InstancePath que
vous spécifiez, pour les préparer a la mise a niveau afin d’utiliser le modele de sécurité basé sur I'identité AF.
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Comment executer I'outil de migration d'identités

Avant d’exécuter l'outil de migration d’identités

¢ Leclient Pl Asset Framework (AF), y compris Pl System Explorer, doit étre installé sur la machine ol vous
exécutez l'outil de migration des identités.

¢ Une entrée dans le tableau des serveurs connus doit étre ajoutée dans Pl System Explorer pour le serveur AF
hébergeant la configuration de Pl Integrator for Business Analytics. (Voir Ajouter un serveur Pl AF a la liste de
connexion.) De plus, il doit y avoir une entrée pour chaque serveur AF source que votre instance PI
Integrator for Business Analytics utilise pour publier des données pour les vues. Vous devez pouvoir vous
connecter a chacun de ces serveurs via Pl System Explorer en utilisant la méme machine que celle qui
exécutera l'outil de migration des identités.

e Créez une association vers l'identité AF Administrateurs sur le serveur AF hébergeant la configuration de PI
Integrator for Business Analytics.

e Lutilisateur qui exécute I'outil de migration des identités a besoin d’autorisations d’accés en lecture sur le
serveur AF pour les identités de sécurité, les associations de sécurité, les bases de données et les objets de
sécurité AF pour tous les serveurs AF source que votre instance de Pl Integrator for Business Analytics utilise
pour publier des données pour les vues. L'identité AF World (Monde) intégrée comprend I'accés requis.

o L'utilisateur qui exécute I'outil de migration des identités a besoin d’autorisations pour créer et écrire des
fichiers dans le dossier %PIHOME%\dat. Les privileges de I'administrateur local comprennent l'acces requis.

Loutil de migration des identités est zippé et incluse avec Pl Integrator for.

2. Copiez le fichier zip téléchargé sur une machine du méme domaine que vos utilisateurs PI Integrator for
Business Analytics.

Dézippez le fichier zip copié dans un répertoire local.

4. Exécutez I'outil de migration des identités en utilisant I'une des options suivantes : Exécuter l'outil de
migration des identités de maniéere interactive ou Exécuter l'outil de migration des identités en utilisant les
arguments de la ligne de commande.

Exécuter |'outil de migration des identités de maniere interactive

Exécuter l'outil de migration des identités maniére interactive pour effectuer des sélections pendant I'exécution
de l'outil. Si vous préférez, vous pouvez exécuter I'outil en utilisant des arguments de ligne de commande.

1. Sur l'ordinateur ol vous avez décompressé I'outil de migration des identités, ouvrez une invite de commande
et naviguez jusqu’au répertoire ou se trouvent les fichiers décompressés.

2. Pour exécuter l'outil, saisissez IdentityMigrationTool et appuyez sur Entrée.

3. Lorsque vousy étes invité, indiquez si vous souhaitez migrer vos vues, ce qui inclut la modification du
modeéle PI_INTEGRATOR_VIEW et des éléments de la vue.

¢ Non (N), saisissez N ou appuyez sur Entrée pour que l'outil s’exécute en mode apergu uniguement ;
aucune modification ne sera apportée au gabarit PI_INTEGRATOR_VIEW ni a aucun élément de la vue.
Passez a |'étape 5.

e Qui (Y), saisissez Y pour modifier votre élément de vue et votre gabarit selon vos besoins.

4. AVinvite « Voulez-vous que cet outil tente d’effectuer une sauvegarde XML de votre élément InstancePath »,
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indiquez I'option de sauvegarde :

* No, (N), saisissez N. Cette action n’aura aucun effet ; vous devez effectuer une sauvegarde
manuellement. Si vous ne disposez pas d’une sauvegarde et que 'outil modifie vos vues, vous ne pourrez
pas rétablir I'état antérieur de votre base de données AF. Vous effectuez une sauvegarde manuelle a
partir de Pl System Explorer en cochant les options Inclure tous les objets référencés et Inclure les
chaines de caractéres de sécurité. (Voir Options d’exportation XML.)

e Oui(Y), saisissez Y ou appuyez sur Entrée pour que 'outil tente d’effectuer une sauvegarde XML et
s’arréte si le fichier de sauvegarde n’est pas créé avec succes.

A l'invite « Si la valeur de la liste d’identité AF (attribut IDList) d’une vue n’est pas vide, voulez-vous que I'outil
écrase la valeur existante ? », spécifiez 'option d’écrasement :

¢ Non (N), saisissez N ou appuyez sur Entrée pour ignorer toute vue dont la valeur de I'attribut IDList n’est
pas vide.

e Oui (Y), saisissez Y pour écraser la valeur IDList existante.

Saisissez la valeur InstancePath de %PIHOME64%\Integrators\BA\CAST.Ul.WindowsService.exe.config. Par
exemple, \\MyAFServer\Configuration\OSIsoft\PI Integrator for Business Analytics\Instancel.

Les vues sont maintenant chargées. Sélectionnez la vue que vous souhaitez configurer. Loutil ne traitera que
les vues non supprimées (celles dont la valeur de I'attribut IsDeleted est false), quelle que soit I'option
choisie.

e (A), saisissez A ou appuyez sur Entrée pour migrer toutes les vues.
¢ (B), saisissez B pour spécifier le domaine des créateurs de vues dont vous souhaitez migrer les vues.

¢ (C), saisissez C pour entrer un chemin d’acces au fichier d’ID de vue d’entrée afin de migrer un ensemble
spécifique de vues.

Lorsque vous exécutez I'outil, ce dernier crée un fichier
SetupPlintegratorSetup_ldentityMigration_FailedViews_TimeStamp.txt qui contient les ID des vues qui ont
échoué.

A l'invite « Si des identités AF sur le serveur AF et la base de données source de la vue ne peuvent pas étre
trouvées pour le créateur de la vue, voulez-vous que l'outil utilise les identités AF du compte de service a la
place si elles sont valides ? », indiquez l'option a utiliser :

¢ Non (N), saisissez N ou appuyez sur la touche Entrée si vous souhaitez que I'outil ignore toute vue dont le
créateur ne peut pas étre mappé a des identités AF ayant un acces en lecture aux données sur la base de
données AF source de la vue.

e Oui (Y), saisissez Y pour utiliser a la place les identités AF du compte de service pour ces vues.
A l'invite, indiquez si vous souhaitez poursuivre la migration :

¢ Non (N), saisissez N.

e Qui(Y), saisissez Y pour exécuter I'outil.

Aprés avoir exécuté l'outil de migration des identités, les fichiers suivants seront présents dans le dossier
%,/PIHOME%\dat.

¢ SetupPlintegratorSetup_ldentityMigration_FailedViews_.txt : liste d’ID de vues auxquelles nous n’avons
pas pu ajouter d’identités AF. Ce fichier peut étre utilisé comme entrée de l'outil pour une exécution
ultérieure.

¢ SetupPlintegratorSetup_ldentityMigration_Report_.csv : résultats au format CSV.

¢ SetupPlintegratorSetup_ldentityMigration_Report_.html : résultats au format HTML, qui peuvent étre
affichés dans un navigateur Web.
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¢ SetupPlintegratorSetup_ldentityMigration_Logs.txt : journaux de migration des vues.

¢ *SetupPlintegratorSetup_ldentityMigration_InstancePathBackup_.xml : sauvegarde des éléments,
attributs et gabarits AF d’InstancePath ; ce fichier n’est pas présent si I'outil est exécuté en mode apercu.

Exécuter I'outil de migration des identités en utilisant les arguments
de la ligne de commande

1. Sur la machine ou vous avez décompressé l'outil de migration des identités, ouvrez une invite de commande
en tant qu’administrateur et naviguez jusqu’au répertoire local ol se trouvent les fichiers décompressés.

2. Pour afficher le texte d’aide des arguments de la ligne de commande de I'outil, saisissez :
IdentityMigrationTool /?

3. Pour exécuter I'outil de migration des identités, saisissez : IdentityMigrationTool /I:InstancePath
[/D:ServiceAccountSAM] [/M [/N]] [/O] [/S:SAMDomain /U:UPNDomain] [/V:pathTolnputViewlIDsFile].

Ou:
¢ /l:iInstancePath - La valeur InstancePath du fichier %PIHOME®64 \Integrators\BA\
CAST.UL.WindowsService.exe.config.

o /D:ServiceAccountSAM - (facultatif) Si ce paramétre est spécifié, I'outil utilisera par défaut les
identités AF de 'UPN du compte de service. Ignore les vues dont le créateur de la vue est introuvable ou
ne peut étre associé a des identités AF disposant d’un acces en lecture de données sur les Base de
données AF source de la vue. S'il n’est pas spécifié, 'outil ignorera ces vues. Spécifier
ServiceAccountSAM au format SAM (domaine\utilisateur.)

¢ /M - (facultatif) Si ce paramétre est spécifi¢, 'outil modifiera le gabarit d’élément PI_INTEGRATOR_VIEW
et/ou les éléments de vue. S’il n’est pas spécifié, I'outil s’exécutera en mode d’apercu uniguement et
n‘effectuera aucune modification.

e /N - (facultatif) Si ce parametre est spécifié avec ou sans /M, l'outil ne tentera pas d’effectuer une
sauvegarde XML de I'élément répertorié dans la valeur /I:InstancePath et de ses enfants. S’il n’est pas
spécifié, mais que /M est spécifié, I'outil tente d’effectuer cette sauvegarde et se termine s’il ne parvient
pas a confirmer que le fichier de sauvegarde a bien été créé.

¢ /O - (facultatif) Si ce paramétre est spécifi¢, I'outil traitera les vues méme si la valeur de leur attribut
IDList est vide. S'il n’est pas spécifié, 'outil ignorera les vues dont la valeur d’attribut IDList n’est pas vide.

e /S:SAMDomain /U:UPNDomain - (facultatif, ne peut étre spécifié si /V est spécifié) Si ce paramétre est
spécifié, l'outil traitera uniquement les vues dont le domaine du compte SAM du créateur correspond au
domaine SAM spécifié. Si 'option /U:UPNDomain est spécifiée, I'outil utilisera la valeur UPNDomain
comme domaine User Principal Name (UPN) lors de la création d’identités Windows pour ces créateurs
de vues ; par contre, si 'option /U:UPNDomain n’est pas spécifiée, I'outil définira la valeur UPNDomain a
I'identique de la valeur SAMDomain.

¢ /V:PathTolnputViewlIDsFile - (facultatif, ne peut étre spécifié si /S est spécifié) Si ce paramétre est
spécifié, 'outil lira les ID de vues d’entrée a partir du chemin d’acces spécifié et ne traitera que les vues
dont les ID figurent dans le fichier.

4. Apres avoir exécuté 'outil de migration des identités, les fichiers suivants seront présents dans le méme
dossier que celui ol vous avez exécuté l'outil :

¢ SetupPlintegratorSetup_ldentityMigration_FailedViews_.txt : liste d’ID de vues auxquelles nous n’avons
pas pu ajouter d’identités AF. Ce fichier peut étre utilisé comme entrée de l'outil pour une exécution
ultérieure.
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¢ SetupPlintegratorSetup_ldentityMigration_Report_.csv : résultats au format CSV.

¢ SetupPlintegratorSetup_ldentityMigration_Report_.html : résultats au format HTML, qui peuvent étre
affichés dans un navigateur Web.

¢ SetupPlintegratorSetup_ldentityMigration_Logs_.txt : journaux de migration des vues.

¢ SetupPlintegratorSetup_ldentityMigration_InstancePathBackup_.xml : sauvegarde des éléments,
attributs et gabarits AF d’InstancePath ; *non présent si I'outil est exécuté en mode apercgu.

Exemples de parametres d’entrée pour IdentityMigrationTool

Les exemples suivants illustrent comment utiliser des parametres d'entrée avec le script :

¢ La configuration de la vue PI Integrator est stockée sous I'élément suivant \\PIAF\Configuration\OSIsoft\PI
Integrator for Business Analytics\Instancel.

¢ Les services Pl Integrator sont exécutés sous le compte de service prod\piintegratorservice.

¢ Le domaine des créateurs de vues, par exemple prod\user01, est prod. Le suffixe de domaine que nous
souhaitons appliquer a ces créateurs de vues, par exemple user01@prod.opsmain.com est
prod.opsmain.com.

e Le fichier d'ID de vue d’entrée se trouve a 'emplacement C:\Users\user01\Downloads\
IdentityMigrationTool\SetupPlintegratorSetup_ldentityMigration__FailedViews.txt.

Compte de service par défaut, ne pas effectuer de sauvegarde et modifier
les vues

IdentityMigrationTool.exe /I:"\\PIAF\Configuration\OSlIsoft\PI Integrator for Business Analytics\Instancel"
/D:"prod\piintegratorservice" /M /N

Dans cet exemple, I'outil effectue les actions suivantes :

¢ (/M) Modifie le gabarit de PI_INTEGRATOR_VIEW et les éléments de vue si nécessaire.
¢ (/N) Ne tente pas d’effectuer une sauvegarde XML d’InstancePath spécifié.
¢ Ignore les vues dont I'attribut IDList n’est pas vide.

¢ (/D:ServiceAccountSAM) L'outil utilise par défaut les identités AF prod\piintegratorservice du compte de
service spécifié pour toutes les vues dont le créateur est introuvable ou ne peut étre mappé a aucune
identité AF ayant un acces en lecture aux données de la base de données AF source de la vue.

Filtrer par domaine de créateur de vue, modifier des vues et remplacer des
valeurs d'attribut IDList non vides

IdentityMigrationTool.exe /I:" \\PIAF\Configuration\OSIsoft\PI Integrator for Business Analytics\Instancel"
/M /0 /S:"prod" /U:"prod.opsmain.com"

Dans cet exemple, I'outil effectue les actions suivantes :

¢ (/M) Modifie le gabarit de PI_INTEGRATOR_VIEW et les éléments de vue si nécessaire.
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¢ Tente d’effectuer une sauvegarde XML du chemin d’instance spécifié.
e (/O) Ecrase tout attribut IDList, méme s’il n’est pas vide.

¢ Ignore les vues dont le créateur de la vue est introuvable ou ne peut étre associé a des identités AF disposant
d’un acces en lecture de données sur les Base de données AF source de la vue.

¢ (/S:SamDomain) Ignore les vues dont le créateur n‘appartient pas au domaine spécifié prod. Pour toute vue
dont le créateur de vue appartient bel et bien a ce domaine, il suppose que le suffixe UPN (User Principal
Name) du créateur de la vue est prod.opsmain.com.

Modifier des vues et filtrer par une liste de vues d’'entrée

Dans cet exemple, I'outil effectue les actions suivantes :

IdentityMigrationTool.exe /I:"\\PIAF\Configuration\OSIsoft\PI Integrator for Business Analytics\Instancel" /M
/V:"C:\Users\user01\Downloads\IdentityMigrationTool\
SetupPlintegratorSetup_ldentityMigration_FailedViews.txt"

¢ (/M) Modifie le gabarit de PI_INTEGRATOR_VIEW et les éléments de vue si nécessaire.
¢ Tente d’effectuer une sauvegarde XML du chemin d’instance spécifié.
¢ Ignore les vues dont I'attribut IDList n’est pas vide.

¢ Ignore les vues dont le créateur de la vue est introuvable ou ne peut étre associé a des identités AF disposant
d’un acces en lecture de données sur les Base de données AF source de la vue.

e (/V) Ignore les vues qui ne figurent pas dans la liste d’ID de vues d’entrée.

Secure views for an identity

Les administrateurs du service Pl Integrator Framework peuvent autoriser 'acces aux vues a toutes les identités a
partir de la page Administration.

Cliquez sur l'icbne du menu E, puis cliquez sur Administration.
2. Ala page Administration, cliquez sur I'onglet Utilisateurs.
La liste des Autorisations d’acces utilisateur affiche une liste des identités Pl AF.

3. Sélectionnez l'identité dont vous souhaitez configurer les autorisations. Voir Autorisations d’acces aux vues.

View Permissions

weeTes ——
EventFrameRowFilter
Test2
Iﬁeacler l—"“""I
Test NAMET
Add View Permissions Remaove View Permissions
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La liste View Permissions (Autorisations de vue) affiche les vues pour l'identité sélectionnée, ainsi que les
autorisations actuelles pour ces vues. Pour plus d’informations, voir la section Autorisations d’acces
utilisateur .

4. Sélectionnez la vue que vous souhaitez configurer.

Sélectionnez l'autorisation Propriétaire ou Lecteur dans la liste.
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Architecture d'échelle Pl Integrator for
Business Analytics

Le diagramme suivant présente l'architecture de PI Integrator for SAP HANA.

Pl Integrator for Business Analytics avec un nceud Travailleur Pl Integrator

Cluster Manager

[ Represents separate processes

Destination Targets . _
B Represents required services

Les processus Pl Integrator Framework, nceud Travailleur Pl Integrator et Sync Pl Integrator se trouvent tous sur
le méme ordinateur.

Chaque instance de PI Integrator for Business Analytics comprend au minimum un processus de nceud Travailleur
qui gére la publication des vues, notamment les taches planifiées, les taches de diffusion et les taches a exécuter
une seule fois. Vous pouvez ajouter des noeuds Travailleur supplémentaires pour améliorer les performances de
publication. Cela peut étre effectué lors de I'installation de PI Integrator for Business Analytics. Apres
I'installation, vous pouvez ajouter d'autres nceuds a l'aide de I'option Ajouter/Supprimer des programmes dans
le Panneau de configuration Microsoft Windows.

Notez que chaque noeud Travailleur supplémentaire inclut des exigences de RAM et de processeur
supplémentaires. Pour plus d’informations, voir Configuration systéme requise. Vous ne pourrez pas ajouter de
nceuds a partir de I'application Web Pl Integrator for Business Analytics.

Le nceud Travailleur PI Integrator publie des taches sur les cibles de destination. Le Gestionnaire de clusters
distribue automatiquement les taches entre les nceuds disponibles. Par exemple, supposons qu'il existe deux
nceuds Travailleur et cing taches. La premiere tache est associée au premier nceud Travailleur, la deuxieéme tache
est associée au deuxieme nceud Travailleur, la troisieme tache est associée au premier nceud Travailleur, et ainsi
de suite. Lorsqu’un nceud Travailleur est ajouté au cluster, tous les services Pl Integrator for Business Analytics
sont redémarrés et le Gestionnaire de clusters répartit les taches entre tous les nceuds disponibles, y compris
celui qui vient d’étre ajouté.
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Remarque : Les taches ne sont pas associées aux nceuds par ordre alphabétique. Si un nceud est hors service, le
Gestionnaire de clusters réaffecte toutes les taches qui lui étaient associées aux nceuds Travailleur restants. Le
nceud Travailleur hors ligne est automatiquement redémarré par le . Une fois redémarré, les taches existantes ne
sont pas rééquilibrées pour inclure le nceud Travailleur redémarré. Les nouvelles taches le sont toutefois entre
tous les nceuds opérationnels. Si cela entraine une distribution inégale des taches, vous pouvez les rééquilibrer
manuellement.

Optimisation des processus de nceud Travailleur

Suivez ces conseils pour optimiser les performances de vos nceuds Travailleur :

¢ Installez deux noeuds Travailleur Pl Integrator minimum, en vérifiant que vous disposez de la capacité de
RAM et de processeur nécessaire pour prendre en charge des noeuds Travailleur supplémentaires. Ainsi, si
I'un des noeuds échoue, l'autre sera en mesure de récupérer les taches sur le nceud en échec et les données
de vue seront toujours publiées.

¢ Consultez vos statistiques de vue et identifiez les vues dont la publication est si longue que I'analyse suivante
échoue. Divisez les vues posant probléme en plusieurs vues plus petites. Si le probléme persiste, envisagez
d'ajouter un autre nceud.

o \Vérifiez si la structure de vos vues est efficace. Dans la mesure du possible, utilisez des gabarits Pl AF, mais ne
créez pas de forme renvoyant des résultats gonflés. Le nombre de correspondances de forme a un impact
direct sur les performances. Si possible, concevez donc votre forme de recherche sur la page Sélectionner
des données de création d'une vue pour n'indiquer que les éléments dont vous avez besoin et exclure les
éléments inutiles. (Faites cela avant d'appliquer des filtres de ligne.)

¢ Planifiez vos vues de sorte qu'elles ne soient pas toutes publiées en méme temps. Décalez les taches entre
elles.

Aprés avoir optimisé vos vues, si vous devez encore améliorer les performances, ajoutez un nceud Travailleur au
cluster. Voir Configuration systeme requise pour la configuration requise en matiere de mémoire et de matériel.
Vous pouvez ajouter jusqu'a cing nceuds Travailleur Pl Integrator. Tous les nceuds Travailleur doivent se trouver
sur 'ordinateur ou Pl Integrator for Business Analytics est installé.

Pl Integrator for Business Analytics avec plusieurs nceuds Travailleur Pl Integrator

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 191



'AVEVA\TM Pl Integrator for Business Analytics

Architecture d’échelle PI Integrator for Business Analytics

Y

‘ @ Represents separate processes

‘ Destination Targets . .
I Represents required services

Gerer les nceuds Travailleur Pl Integrator

Pl Integrator for Business Analytics fournit un Gestionnaire de clusters que vous pouvez utiliser pour connaitre
I’état du cluster et pour gérer les nceuds Travailleur. Pour chaque nceud, il affiche les informations suivantes :

¢ Nom du service : nom du service de noeud Travailleur. Le nceud Travailleur par défaut est nommé Noeud
Travailleur Pl Integrator 1. Les nceuds Travailleur suivants sont identifiés par un nombre ; par exemple, Nceud
Travailleur Pl Integrator 2, Noeud Travailleur Pl Integrator 3, etc.

Remarque : Les services Noeud Travailleur Pl Integrator sont installés avec le type de démarrage réglé sur
Manuel. Le service Pl Integrator Framework redémarre automatiquement le service si nécessaire. Les
utilisateurs ne doivent donc pas redémarrer le service.

e FEtat:indique si le nceud est actif ou non. Le service Pl Integrator Framework redémarrera le service de
nceud Travailleur dans un délai d’'une minute.

e Adresse : identifiant unique utilisé en interne indiquant I'emplacement TCP du processus. Cet identifiant
change a chaque démarrage du service de nceud Travailleur.

Les taches exécutées sur chaque nceud, ainsi que les informations suivantes, sont affichées :

¢ ID de tache : identifiant unique GUID attribué a la tache
¢ Nom de la tache : nom de la vue
e Etat de la tache : affiche I'état de la tache, par exemple, Planifié, Publication, Diffusion

¢ Derniére heure d'exécution : horodatage de la derniere publication de la vue
Vous pouvez effectuer les taches de gestion suivantes :
¢ Sinécessaire, vous pouvez répartir plus uniformément les taches entre les noeuds Travailleur en cliquant sur

Rééquilibrer les nceuds.
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¢ Cliquez sur une tache pour accéder a la page Mes vues dans laquelle vous obtiendrez plus d'informations sur
la vue, notamment les messages de journaux et les statistiques d'exécution.
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Chaines de caracteres réservées

Cibles Oracle

Pl Integrator for Business Analytics réserve les chaines sensibles a la casse ID, PlintTSTicks et PlintShapelD. Si des
colonnes sont nommeées avec ces chaines réservées, un trait de soulignement (_) est ajouté a la chafne. Par
exemple:ID_orld .

La base de données Oracle réserve une liste de mots supplémentaires. Si ces mots apparaissent dans le nom de
colonne d'une vue, une barre de soulignement (_) leur est apposée. Par exemple, ACCESS apparaitra sous la
forme ACCESS_. Reportez-vous a la documentation d'Oracle pour en savoir plus sur les mots réservés par Oracle.

La liste des mots réservés par la base de données Oracle est la suivante :
ACCESS
ADD

ALL

ALTER
AND

ANY

AS

ASC
AUDIT
BETWEEN
BY

CHAR
CHECK
CLUSTER
COLUMN
COMMENT
COMPRESS
CONNECT
CREATE
CURRENT
DATE
DECIMAL
DEFAULT
DELETE
DESC
DISTINCT
DROP
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ELSE
EXCLUSIVE
EXISTS

FILE

FLOAT

FOR

FROM
GRANT
GROUP
HAVING
IDENTIFIED
IMMEDIATE
IN
INCREMENT
INDEX
INITIAL
INSERT
INTEGER
INTERSECT
INTO

IS

LEVEL

LIKE

LOCK

LONG
MAXEXTENTS
MINUS
MLSLABEL
MODE
MODIFY
NOAUDIT
NOCOMPRESS
NOT
NOWAIT
NULL
NUMBER
OF

OFFLINE
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ON
ONLINE
OPTION
OR

ORDER
PCTFREE
PRIOR
PRIVILEGES
PUBLIC
RAW
RENAME
RESOURCE
REVOKE
ROW
ROWID
ROWNUM
ROWS
SELECT
SESSION
SET
SHARE
SIZE
SMALLINT
START
SUCCESSFUL
SYNONYM
SYSDATE
TABLE
THEN

TO
TRIGGER
uiD
UNION
UNIQUE
UPDATE
USER
VALIDATE
VALUES
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VARCHAR
VARCHAR2
VIEW
WHENEVER
WHERE
WITH
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Support technique et autres ressources

Pour obtenir une aide technique, contactez I'assistance technique OSIsoft au +1 510-297-5828 ou a l'adresse
Page Contactez-nous du portail client OSlsoft. La page Contact Us offre des options de contact supplémentaires
pour les clients situés en dehors des Etats-Unis.

Lorsque vous contactez le support technique d'OSlsoft, gardez les informations suivantes a portée de main :

¢ Nom du produit, version et numéros de version

o Détails sur votre plateforme informatique (type de processeur, systéme d'exploitation et numéro de version)
¢ Heure a laquelle le probleme a été constaté

¢ Fichiers de journalisation de cette période

¢ Détails de toutes les modifications de I'environnement précédant le début du probleme

¢ Résumé du probleme, notamment tous les fichiers journaux correspondant a la période au cours de laquelle
le probleme s'est produit

Pour vous enquérir aupres d'autres utilisateurs de logiciels OSlsoft, rejoignez la communauté des utilisateurs,

Pl Square. Les membres de la communauté peuvent demander des conseils et partager des idées sur Pl System.
Le Club des développeurs Pl de Pl Square offre des ressources pour vous aider a programmer et intégrer des
produits OSlsoft.
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Présentation

Pl Integrator for Business Analytics 2020 R2 SP2 (version 2.7.0.112) est une version axée sur I'amélioration de la
flexibilité d’intégration, de la sécurité et des capacités de journalisation. Ses points forts sont les suivants :

¢ Prise en charge de comptes de services virtuels
¢ Interface utilisateur pour les étendues des journaux

e Améliorations supplémentaires des cibles, notamment la sélection dynamique des régions AWS et la
compatibilité mise a jour avec les derniéres versions d’Oracle Database et d’Oracle Data Access Components
(ODAC)

Cette version rend obsoléte les vues Pl et apporte de multiples améliorations en matieére de journalisation et de
performances.

Pour plus d’informations sur les caractéristiques et les fonctionnalités du produit, y compris la configuration
requise et les instructions de mise a niveau, voir Configuration systeme requise et Mettre a niveau Pl Integrator
for Business Analytics.

Améliorations

Les fonctionnalités suivantes ont été ajoutées :

Elément de travail Description

106816 Ajout de la prise en charge des comptes de service
virtuels, ce qui renforce la sécurité et la flexibilité de
déploiement.

95689 Introduction d’une nouvelle interface utilisateur pour
la gestion et la configuration des étendues des
journaux, améliorant ainsi la convivialité.

104079 Obsolescence de la fonctionnalité des vues Pl pour
corriger une faille de sécurité critique.

108693 La liste des régions AWS, qui était fixe pour la
configuration des cibles AWS, se charge désormais de
maniére dynamique a partir des points limites du
service au lieu d’utiliser une liste statique.

103656 Mise a jour de la compatibilité pour prendre en charge
les dernieres versions d’Oracle Database et d’Oracle
Data Access Components (ODAC).
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53833

Amélioration de la journalisation interne pour
optimiser le diagnostic et la surveillance.

Correctifs

Cette section énumere les éléments qui ont été résolus dans cette version :

Elément de travail

Description

107139

Application d’un correctif pour résoudre les problemes
liés a la gestion des ID de ligne Redshift.

73695

Correction d’un probleme ou AdIGen2Writer ne
fermait pas correctement les fichiers au vidage, ce qui
garantit I'intégrité des données.

54501

Amélioration des messages d’exception en incluant le
nom de table dans les erreurs GetlLastld pour faciliter
le dépannage.

113283

Implémentation d’AsyncTargetWrapper dans NLog
pour améliorer la vitesse de journalisation et les
performances globales.

112268

Désactivation de la possibilité de modifier le port lors
de la mise a niveau via le kit d’installation pour éviter
les problémes de configuration.

112329

Résolution d’un probleme ou, apres I'échec d’une
publication dans le dispositif d’écriture HDFS, la
publication réussie suivante pouvait entrainer la perte
des données précédemment mises en file d’attente.

117900

Résolution de la validation sur les noms de vue lors
des opérations de création, de modification ou
d’importation.

48813

Correction d’une erreur (« Impossible de trouver la
vue pour l'utilisateur ») qui se produisait si les
modifications étaient ignorées ou apres plusieurs
tentatives infructueuses de republication sur des vues
clonées.

108733

Correction d’un probléeme ol les vues ne pouvaient
pas étre chargées lorsque 'emprunt d’identité
d’utilisateur était activé.

48893

Correction d’un probléme ou le port par défaut n’était
pas libéré apres la désinstallation de I'Integrator si un
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port différent de celui par défaut (autre que 443) était
utilisé.

48906

Résolution d’un probléme ou les vues de diffusion a
valeur clé arrétaient d’envoyer des données a la suite
d’une exception de connexion AFListener.

48805

Correction d’un bogue qui empéchait les vues d’actif
et de diffusion de publier des données apres une
exception de connexion au serveur SQL Server
principal.

48850

Correction d’un probleme du programme
d’installation ou la vérification du serveur AF échouait
si le domaine du compte de service gMSA était
incorrect.

113281

Amélioration de la logique de traitement des
exceptions pour éviter les redémarrages inutiles des
nceuds Travailleur dans certains déploiements.

113475

Correction d’un probleme de duplication ou les vues
de diffusion a valeur clé arrétaient d’envoyer des
données aprés une exception de connexion
AFListener.

48626

Amélioration des messages d’erreur des jeux de
données pour apporter plus de précision si la mise a
jour des données échoue.

48731

Correction des stratégies de rétention, de sorte que
les limites filterMinimum/MaximumFrequency sont
désormais correctement incluses.

48880

Résolution d’un probleme ou les messages déclenchés
par un événement n’étaient pas envoyés
immédiatement a Azure Event Hub.

95089

Correction d’un bogue ou les fichiers de sortie Parquet
publiés sur S3 pouvaient manquer une ligne de
données.

69017

Correction d’un probléeme ou SqlWriter pouvait
déclarer des statistiques inexactes, en particulier au
démarrage de l'application.

107603

Mise a niveau de Pl Integrator for Business Analytics
de .NET Framework 4.6.2 a 4.8 afin de corriger les
vulnérabilités de sécurité connues et d’améliorer la
sécurité globale du systéeme.
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Les problémes existants et les demandes d’amélioration peuvent étre examinés dans le Customer Portal.
Consultez I'article de Base de connaissances 16600, How do | see Release Announcements, Alerts, Known Issues,
and Knowledge Articles relating to my products?, et suivez la Méthode 2 - Recherche générale pour apprendre

comment afficher une liste de problémes connus.

Informations et conseils sur la sécurité

Nous nous engageons a proposer des produits sécurisés. Cette section vise a fournir des informations
pertinentes sur la sécurité afin de guider votre décision d'installation ou de mise a niveau. Nous communiquons
de maniéere proactive des informations agrégées sur le nombre et la sévérité des vulnérabilités de sécurité
traitées dans chaque version. Les tableaux ci-dessous présentent un apercu des problemes de sécurité abordés

et de leur sévérité relative sur la base d'une évaluation standard.

Catégorie de sévérité Page de scores de base CVSS Nombre de vulnérabilités corrigées
Critique 9-10 1
Haut 7-89 4
Moyen 4-6,9 21
Bas 0-3,9 5

Fichiers du kit de distribution

Produit

Versions logicielles

AVEVA.PlintegratorBA_ADV_1000_2.7.0.112_.exe |2.7.0.112

AVEVA.PlintegratorBA_ADV_5000_2.7.0.112_.exe |2.7.0.112

AVEVA PlintegratorBA_ADV_20000 2.7.0.112 .ex |2.7.0.112
e

AVEVA PlintegratorBA_ADV_100000 2.7.0.112_.e | 2.7.0.112
xe

AVEVA PlintegratorBA STD 1000 2.7.0.112 .exe |2.7.0.112

AVEVA.PlintegratorBA_STD_5000_2.7.0.112_.exe |2.7.0.112

AVEVA.PlintegratorBA_STD_20000_2.7.0.112_.ex |2.7.0.112
e
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https://docs.aveva.com/bundle/security-commitment-and-disclosure-standards/page/1309709.html#_vulnerability_communication
https://docs.aveva.com/bundle/security-commitment-and-disclosure-standards/page/1309709.html#_vulnerability_communication
https://docs.aveva.com/bundle/security-commitment-and-disclosure-standards/page/1309709.html#_vulnerability_scoring
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AVEVA believes the information in this publication is correct as of its publication date. As part of continued product development, such information is subject to
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the trademarks of their respective holders.
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